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About this Manual

About this Manual
This manual is about Multiframe, a structural analysis and design
system.

Chapter 1 Learning Multiframe
Gets you started creating, editing, analysing and checking results for
a structure and its loading.  It is a series of exercises designed to help
you learn the basics of Multiframe and become confident in using it
to analyse structural behavior.

Chapter 2 Using Multiframe
Chapter 2 Using Multiframe includes step-by-step instructions in
using the program. This will explain most of the tasks you will carry
out in defining, analysing and designing a structure.

Chapter 3 Multiframe Reference
Gives an overview of the operations of Multiframe and a summary
of the commands used.

Chapter 4 Multiframe Analysis
Discusses the numerical methods used by Multiframe.  It is
important for you to understand these methods and their limitations
before using Multiframe for structural analysis and design.  The
chapter ends with a summary of the capabilities and limitations of
Multiframe.

This manual describes the three versions of Multiframe, 2D, 3D and
4D.  Where appropriate the manual will indicate features, which are
only available in the 3D and 4D versions.
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Chapter 1
Learning Multiframe
This chapter helps you get started installing and using Multiframe by
working through a sample tutorial problem.

Getting Started
If you are not familiar with the concepts of structural analysis using
the matrix stiffness method, it will be necessary for you to review the
structural analysis concepts outlined in Chapter Four. If you are
familiar with the analysis, you can proceed at your own pace.

Multiframe will run on any Macintosh computer with at least 8 Mb
of memory, or any Windows 95/98/NT computer with at least 16
Mb of memory.

Installing
Multiframe on
Windows

If you are installing from floppy disk, insert Disk 1 into your floppy
drive.  Select Run from the Start menu (Windows NTv3.51 users
choose Run from the File menu of the Program Manager).  A dialog
box will appear asking you to enter the name of the program to run.
Type 'A:\SETUP' in the space provided, then click on OK, and then
follow the instruction on screen.

If you are installing from CD, insert the CD into your CD drive and
follow the instructions on screen.

After installation, Multiframe should be accessible through the Start
Menu.  Simply select 'Multiframe' from the Start menu. Multiframe is
automatically installed in the Program Files directory unless you
specify otherwise.

Installing
Multiframe on
Macintosh

If you are installing from floppy disk, insert the Multiframe disk and
double click on the Installer program. This will prompt you to
specify a location on your hard disk where Multiframe will be
installed.

The Utilities disk which comes with Multiframe contains a number
of folders with libraries containing the structural shapes used in
different countries. You will need to copy the Section Library from
the appropriate folder on the floppy disk into the same folder as the
Multiframe program on your hard disk.

If you are installing from CD, insert the CD into your CD drive and
follow the instructions on screen.

You can start Multiframe by double clicking on the Multiframe icon
on your disk. If a dialog appears asking you to locate the Sections
Library when you try to start Multiframe, this means that you have
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not copied the Sections Library from the Utilities floppy disk into the
same folder as the Multiframe program. On the CD you should run
the Multiframe Utilities installation program.

Starting
Multiframe

After the copyright window has been displayed, a number of
windows will appear on the screen including three titled Frame,
Load and Plot.

Multiframe Tutorial
To introduce you to the concepts and techniques you will use in
Multiframe, this chapter will describe a simple frame analysis step by
step. The frame you will analyse is shown below. You will analyse it
for the two different loading conditions shown and for a
superposition of the loads.

25

10 10
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0

1.5

1.5

First, you will draw the frame to scale, a member at a time, inside the
Frame window. It is necessary to first set up the scale for drawing in
the Frame window.

• Choose Size… from the View menu

A dialog box will appear with fields in it specifying the maximum
dimensions of the frame.
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• Type 20 for the maximum x coordinate and then press the Tab
key to move to the second field

• Type in 0 for the minimum x coordinate and then use the Tab
key to move to the next two fields entering 10 and 0 for the
maximum y and 20 for the minimum z coordinates

• Click the OK button when you have finished entering the values

If you make a mistake entering the numbers, you can use the
backspace or delete key to delete the character just to the left of the
blinking cursor and you can use the Tab key to move from one field
to the next.
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2D Tutorial
If you are using Multiframe 2D, you will notice a number of
differences from the illustrations in this manual. In general, fields in
dialogs associated with 3D e.g. Max z and Min z in the dialog will
not be visible in the 2D version of the program. All of the commands
in 2D work the same as the commands in 3D, the only difference is
that items which relate only to dimensions, deflections or forces in
the z direction will be omitted from the 2D version.

To make it easier for you to draw the frame, you can use
Multiframe's Grid option to make drawing automatically align to a
grid with regular spacing.

• Choose Grid… from the View menu

A dialog box will appear with values for the x (horizontal), y
(vertical) and z spacing of the grid.

• Type 1 for the x spacing, use the Tab key to move to the other
fields and also enter 1 for the spacing there

• Click on the On radio button to make subsequent drawing align
with the grid

This will also turn on the Visible button to make the grid visible in
the Frame window.

• Click on the OK button to confirm your settings

Now move the pointer inside the Frame window and notice that as
you move the mouse, the coordinates of the pointer are shown at the
bottom left hand corner of the window.  The coordinates will
automatically align to the nearest point on the grid.

You can now begin to draw the structure to scale in the Frame
window.

Drawing the Frame
To draw the first member in the frame

• Select Add Member from the Frame menu

A cross hair will appear in the Frame window.

• Move the cross hair to the location of the first joint
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Move the cross hair towards the axes at the bottom left hand part of
the window until the coordinates read x=0.000, y=0.000.

• Press the mouse button and hold it down

• Drag the crosshair to the position of the second joint

Note that Windows users may choose to click on the first joint and
click on the second joint to draw a member instead of dragging the
mouse.

Move the crosshair up and to the right. Notice that as you move the
crosshair, the member is continually re-drawn to show its current
position. The coordinates, length and slope of the member are also
shown. Move the crosshair until the coordinates read x=10.000,
y=10.000.

• Release the mouse button (Windows users can click the mouse
button)

When you click or release the button the member is drawn in its final
position. Notice also that two small black squares are drawn
showing the position of the joints marking the ends of the member.

You can now draw the second member, which runs horizontally
across from the top right hand end of the first.

• Choose Add Member from the Frame menu

• Move the cross hair to the top right hand joint of the member
you have drawn

• Click on the joint and drag to draw the member

• Release the mouse button when the coordinates read x=20.000,
y=10.000

When you add a member by clicking on or very close to an existing
joint, Multiframe will create a connection between the existing joint
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and the new member. In this case, Multiframe has connected the two
members together at the common joint.

If you make a mistake with the position of any joints, you can drag
them to a new position using the mouse or double click on them to
enter a new location.

This completes the setup of the geometry of the frame. You can now
move on to applying the restraints and section types needed for the
structure.

Selecting a Joint
In order to set the restraints and section properties for the structure,
you first need to select the members and/or joints that you want to
work with.

You will find it helpful to turn off the grid now that you have
finished drawing the structure.

• Choose Grid… from the View menu

• Click on the Off radio button to turn off the grid

• Click OK

The grid display and alignment features in the Frame window are
now turned off. To select the first joint

• Point to the bottom left hand joint of the frame and click

Notice that a larger black square appears at the joint. This indicates
that this joint is selected.

Restraining a Joint
Joints, which cannot move freely in a structure, must be restrained in
some way in the Multiframe model. This restraint may be horizontal,
vertical, a restraint against rotation or a combination of these
restraints.

To apply the pinned restraint to the joint you have selected

• Choose Joint Restraint from the Frame menu

Note that Windows users have the option of clicking the right mouse
button to get a context sensitive menu.

A dialog box will appear with a number of icons in it.
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• Click on the pinned restraint icon

• Click OK

Notice that the pinned restraint icon is now displayed at the joint
which was selected. A pinned restraint prevents the joint from
moving horizontally or vertically but allows it to rotate freely.

Next select the top right hand joint of the frame by clicking on it.

• Click on the top right hand joint on the frame

• Choose Joint Restraint from the Frame menu or right mouse click

The joint restraint dialog will appear.

• Click on the fixed joint icon

• Click OK to apply this restraint to the selected joint

A fixed joint cannot rotate or move vertically or horizontally.

Section Properties
In order to compute deflections in the structure it is necessary to
know the material properties and dimensions of the sections used in
the structure. Multiframe has a built-in table of the most commonly
used structural sections from which you can select the desired
section type. Multiframe also allows you to add your own sections to
the library.

Selecting a
Member

In order to specify the section properties for the members in the
frame, it is necessary to select each of the members in turn.

To select the sloping member

• Point to the sloping member away from its ends and click
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The member will be drawn with a bold line indicating that it is
selected.

• Choose Section Type from the Frame menu

Note that Windows users have the option of clicking the right mouse
button to view a short cut menu.

A dialog box will appear with a list of groups and sections.

• Click on the name W in the list of section groups

This will display, in the list on the right, the list of sections stored in
this group.

• Use the scroll bar to scroll down the list of sections until the
W12x40 is visible

• Click on this name to select it

• Click on the OK button to confirm your choice

Since the horizontal member uses a custom section that is not stored
in the Sections Library, it is necessary to add the section to a custom
group in the library.

To add the custom section to the library

• Choose Add Section… from the Edit menu

A dialog box will appear which contains a list of groups and a table
of section properties.
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• Click on the group named Frame in the list of groups at the left

This indicates that this section will be stored in the same file as the
frame rather than in the standard section library database.

At the top of the dialog, a name for the section can be entered.

• Type in "Hbeam" as the name of this section

You can now enter the properties for the section.

• Click on the first value in the table to select it

• Type in the value for the mass of the section

You can now enter each of the values in turn using the Down Arrow
key to move from one value to the next (Do not use the enter key as
this will close the dialog box).

For the section in this structure the values will be

Mass 50 lb/ft Mass per unit length

A 10 sq in Cross sectional area of the section

Ix 250 in4 Moment of inertia about major axis of
section

Iy 45 in4 Moment of inertia about minor axis of
section

J 1 in4 Torsion constant

E 29000 ksi Young's Modulus

G 11153 ksi Shear Modulus

D 8.5 in Depth

B 8 in Width
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tf 0.8 in Flange thickness

tw 0.4 in Web thickness

• Click "I" under Shape at the bottom of the dialog box

Leave all other fields set to the default values.

• Click the OK button when you have finished entering the section
property values

Now select the horizontal member and set its section type.

• Click on the horizontal member to select it

• Choose Section Type… from the Frame menu or from the short
cut menu

• Scroll down the list of member groups and click on the group
named Frame

The section Hbeam that you stored in the library will be shown in the
list of sections for this group.

• Click on the section named Hbeam

• Click the OK button

You have now completed the physical description of the structure
including the geometry, restraints and section properties. You can
now move to the Load window to apply the loads to the frame.

Loads
The loads acting on the structure can be set or changed in the Load
window. Click anywhere in the visible part of the Load window to
bring it to the front or choose Load from the Window menu if the
Load window is not visible. Notice that the structure is shown in this
window exactly as you drew it in the Frame window.

To change the loads on all or part of the structure you first select the
members and/or joints that you want to work with. This is done
using the same techniques you used in the Frame window by
clicking on the joints or members to be selected.

Loading a Joint
First apply the point load at the middle joint of the frame.

• Click on the middle joint to select it
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• Choose Joint Load from the Load menu or from the short cut
menu

A dialog box will appear with a number of load icons in it.

• Click on the vertical load icon

• Type in a value of 25 for the load

• Click the OK button

Note that it is not necessary to enter a positive or negative sign to
indicate the direction of loads in Multiframe. Your choice of icon,
either upward or downward in this case, defines the direction of the
applied loading.

The load you have applied at the middle joint of the frame will now
be displayed in the Load window.

Loading a Member
The second loading condition for this frame includes two uniformly
distributed loads acting on members. Since we wish to also check the
combined effect of the two loading conditions, it will be useful to
apply the distributed loads as a separate load case.

• Choose Static from the Add Case  submenu under the Case menu

A dialog box will appear asking you to name the load case.  Leave
the name of the second load case set to Load Case 2.

• Click the OK button

One load case at a time may be displayed and edited in the Load
window. The name of the current load case is displayed in the lower
left corner of the Load window. Load Case 2 is now the current load
case.

Now apply the distributed load to the horizontal member.

• Click on the horizontal member to select it
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• Choose Global Dist'd Load from the Load menu or from the
short cut menu

A dialog box will appear with a number of icons in it.

Since a distributed load can act over all or part of a member and may
be uniform, triangular or trapezoidal in magnitude, it is defined by
specifying a start and finish magnitude and a distance of the start
and finish of the load from the ends of the member. So a uniformly
distributed load of 5 kip/ft over the whole member will have a Left
Magnitude of 5, a Right Magnitude of 5, a Left Distance of 0 and a
Right Distance of 0.

• Click on the uniform vertical load icon

• Type a value of 5 for the left magnitude of the load

• Use the Tab key to move to the next number in the dialog

Notice that the right magnitude is automatically set to the same
value as the left magnitude.

• Click OK to confirm the values you have entered



Chapter One Learning Multiframe

The load you have added will be drawn on the member in the Load
window. Notice that the pattern indicates the direction of action of
the load and the load is drawn on the side of the member on which it
acts.

Now add the load acting on the sloping member.

• Select the sloping member by clicking on it

• Choose Local Dist'd Load from the Load menu or from the short
cut menu

A dialog box will appear with a number of icons indicating different
directions for the loading and numbers to specify the magnitude and
position of the load on the member.

These loads act in a direction specified by the slope of the member.
The loading can be either normal (shear) or tangential (axial) to the
member.

• Click on the normal load icon

• Type in the magnitude of 1

• Press the Tab key to move to the right hand magnitude

This will automatically be set to the same value of 1.

• Click the OK button

The normal load will be displayed on the sloping member.

Combining Load
Cases

Multiframe allows you to automatically combine load cases together.
For our sample frame we wish to superimpose the two loading
conditions.
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• Choose Static Combined…  from the Add Case sub-menu under
the Case menu

A dialog box will appear with a name for the new case and a table of
load factors.

The factors in the table indicate the value each load case will be
multiplied by before being added to the new case. In this case the
factors for Load Case 1 and 2 will both be 1.0 since we are using a
simple superposition of the loads without any other factoring.

• Click on the first factor to select it

• Enter 1.0 then Down Arrow to the second factor

• Enter 1.0 for the second factor

• Click the OK button

The third load case will now be drawn in the Load window with the
three loads from the two load cases superimposed.

Analysis
Now that you have set up the structure and loading to your
satisfaction you can analyse the structure.

• Choose Analyse from the Case menu

If you are using Multiframe4D, a dialog will be displayed to specify
analysis options. Notice that 4D will automatically detect that the
structure is 2D and set the analysis type accordingly. This makes
analysis faster and minimizes memory requirements. Ensure that just
the Static check box is selected and then click OK to start the analysis.
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The analysis will commence.  A progress bar will show the progress
of the analysis. The progress bar will disappear and the cursor will
turn back into an arrow once the analysis is complete.

Viewing Results
A graphical display of the forces and deflections within the structure
is shown in the Plot window. Click anywhere in the visible part of
the Plot window to bring it to the front. If the Plot window is not
visible, choose Plot from the Window menu to bring it to the front.

The initial diagram displayed will be that of bending moments for
the current load case. As in the Load window, the name of the
current load case is displayed in the bottom left hand corner of the
window. The bending moment diagram is drawn so that the moment
diagram is drawn on the tension face of the member.

You can also display the magnitudes of the actions on the diagram.

• Choose Symbols from the Display menu

• Click the Plot Labels check box to turn it on

• Click the OK button
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The values on the diagrams will now be displayed at the ends of the
members and at any intermediate maximum or minimum points.

You can also view the shear forces in the frame.

• Choose Shear Vy from the Actions sub-menu under the Display
menu

• Or Click on the Shear icon in the toolbar at the top of the Plot
window

The shear force diagram for the whole structure will now be
displayed in the Plot window.

The deflected shape of the frame may also be displayed.

• Choose Deflection from the Display menu or click the Deflection
icon in the toolbar

A diagram of the structure drawn in gray will be displayed with an
exaggerated deflected shape drawn in blue over the top of it.
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The axial forces resulting from the combined load case can be viewed
also.

• Choose Axial Px from the Actions sub-menu under the Display
menu or click the Px icon in the toolbar

This will display the axial forces in the frame with compressive
forces being shown as positive.

To return to a display of the bending moment diagram for the
structure

• Choose Moment Mz from the Action sub menu under the
Display menu

Viewing Different
Load Cases

To view the diagrams for a different load case, you can choose the
name of the case you wish to view from the Case menu.

• Choose Load Case 2 from the Case menu

The bending moment diagram for this load case will be displayed in
the Plot window. The bending moment diagrams for each of the load
cases is drawn to the same scale. From this you can see that the
moments induced by Load Case 2 are slightly less than those of Load
Case 3 as would be expected.

• Choose Load Case 1 from the Case menu

You will see that the magnitude of the moments for this load case is
smaller still.

• Choose Load Case 3 from the Case menu

This will return to the display of the results for the combined loading
condition.

Viewing Member
Diagrams

The diagrams of the whole structure you have viewed so far are
useful for determining the overall behavior of the structure and as a
quick check that you have created the structure correctly. To
determine the exact magnitude of the forces and deflections
however, it may be necessary to look at the diagrams for each
member.

You can view the diagram for a member by clicking on it.

• Point at the original position of the horizontal member and click
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The original position of the member is shown in gray. The local
diagrams for this member will now be displayed in the window.

Notice that the values on the diagrams at the location of the crosshair
are shown below the diagram.  The number below this shows the
current distance of the crosshair along the member (it will initially be
halfway along the member).  The diagram in the lower right hand
corner of the window shows the member selected and its adjacent
members and joints in the structure.

You can view the value on the diagram by dragging the crosshair
with the mouse.

• Point to the gray crosshair and press the mouse button and hold
it down

• Drag the crosshair back and forth along the member

As you move the crosshair you can view the values at any position.

• Release the mouse button to fix the crosshair at a new position

Try moving the crosshair back and forth a few times to get used to
viewing member actions in this way.

To return to the diagram of the whole structure

• Click on the drawing in the lower right hand corner of the
window

Viewing Joint
Displacements
and Reactions

You can use a similar technique to view the joint displacements and
reactions in the structure.  First, turn back on the display of the
moment diagram.

• Choose Moment Mz' from the Actions sub-menu under the
Display menu

Now you can check the reactions at a joint by clicking on it.

• Point to the lower left hand joint of the frame and click
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The reactions for this joint will be shown graphically with the arrows
pointing in the direction of the reaction. The magnitudes of the
reactions will be shown in the bottom left corner of the window.

• Click on the diagram at the lower right of the window

This will return to the diagram of the whole structure.

You can view deflections at a joint in a similar way.

• Choose Deflection from the Display menu

To view the magnitude of the deflection at the middle joint

• Click on the middle joint of the frame

The deflections of this joint will be displayed with the magnitudes of
the deflection being shown on the left of the window.

• Click on the drawing at the bottom right to return to a diagram of
the whole structure.

Tables of Results
If you wish to view the results of the analysis in numerical form, the
Result window may be displayed which will show tables of results
from the analysis.

To make the Result window visible

• Choose Result from the Window menu

When the Results window appears you will see a table showing the
displacements of the joints in the structure and the joint reactions as
computed in the analysis.  If there are more joints than can be
displayed in the window at one time, the scroll bars may be used to
scroll through the table and view the results for any joint.  The
horizontal scroll bars can be used to view different columns in the
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table. On Windows you can also Right Click in the column headings
to sort and hide columns.

You may find the window layout options useful for examining the
results of the analysis.

• Choose Result Layout from the Window menu

The Plot, Load and Result windows will be laid out on the screen.

Notice that each joint in the results table is identified by a number.
You can display these numbers on the graphics of the structure.

• Make sure the Plot window is in front

• Choose Symbols from the Display menu

A dialog box will appear with a number of check boxes in it.

• Check the Joint Numbers and Member Numbers boxes

• Click the OK button
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Notice now that the numbers of the joints and members are
displayed in the Plot and Load windows.  You can refer to these
diagrams while examining the results numerically.

The computed member actions may also be viewed in the Result
window.

• Click in the Result window to bring it to the front

Remember that the front window at any time is the one that has its
title bar highlighted.

• Choose Member Actions from the Results sub-menu under the
Display menu (or on Windows, click the Member Actions tab at
the bottom of the window)

A table of computed member end forces will be displayed.

Each row in the table displays the end forces for a member in the
structure. You can refer to the member numbers displayed on the
graphics in the Plot window to determine which member is which.

Saving Your Work
If you are using the Multiframe demo, you will not be able to save.
Demo users may wish to skip to the Summary to continue reading.

Now that you have created and analysed a structure, it is probably a
good idea to save the work you have done.

• Choose Save As from the File menu

A dialog box will appear which allows you to type in a name for
your structure and to specify which disk or which folder it is to be
stored in.

• Type in "TestFrame.mfd" for the name of your frame



Chapter One Learning Multiframe

Macintosh users:  Including the .mfd suffix to your file names
ensures that your files can be read by Windows users.

• Click on the OK/Save button

The file will be saved to disk.  Later you can read this structure back
in and look at the data and the results or perhaps make some
changes to the structure and analyse it once more.

Printing
If you are using the Multiframe demo, you will not be able to print.
Demo users may wish to skip to the Summary to continue reading.

Now that you have some data describing the structure and its
behavior, you may wish to print a hard copy of the work you have
done.  Multiframe allows you to print a report, the contents of any
window or a list of member diagrams.

Setting up the
Printer

First, ensure that your printer is attached to your computer with an
appropriate cable, that it is switched on and has sufficient paper
loaded.  Refer to your printer manual if you have any problems.

• Choose Page Setup from the File menu

A dialog box will appear which allows you to choose the paper size
and orientation, set the size of margins for printing and type in text
to appear at the head and foot of each page of paper printed.

 

• Select the paper size you have installed in your printer

You can also choose to enlarge or reduce the printout and adjust the
output with a number of other options.  You will not usually require
these more sophisticated options with Multiframe.

•  Click the OK button

Multiframe allows you to enter values for header and footer titles to
be printed at the top and bottom of each page printed.  You can also
set up the size of the margins you would like around the printed
output. On Macintosh the two check boxes at the lower left of the
dialog allow you to switch on or off the printing of page numbers
and date and time information. On Windows these options appear
under the Titles button in the Print Preview window.
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Printing Data
To print out the data describing the structure you have created and
the results of the analysis

• Choose Print Report from the File menu

A dialog box will appear with a number of printing options.

If you do not change the settings of any of the check boxes, all the
data and results will be printed for all load cases.

• Click the OK button

A second dialog box will appear which lets you set the printing
details for the particular printer you are using.
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• Click OK to print

A dialog box will be displayed while printing is in progress.
Multiframe will print out the results on your printer.

Macintosh users:  If you want to cancel the printing while it is in
progress, hold down the  key and type a period ".".

Windows Users:  If you want to cancel the printing while it is in
progress, press the "Esc" key.

Printing Diagrams
(Macintosh Only)
Multiframe allows you to print the force or deflection diagrams for
some or all of the members in the structure.  First, make sure that the
Plot window is frontmost. Multiframe lets you print the diagrams of
the selected members in the Plot window. (Remember you can select
all the members in the Plot window by choosing Select All from the
Select sub-menu under the Edit menu.)

• Choose Print Report… from the File menu

The printing dialog box will appear.

• Click on the Diagram button at the top left of the dialog

This tells Multiframe that you want to print the diagrams for the
selected members rather than print all the data.

• Click the OK button

The usual print dialog will appear.
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• Click OK in the print dialog to start the printing

Multiframe will print out the moment and shear diagrams for each
member for the three load cases as shown below.

Summary
This completes our brief introduction to the capabilities of
Multiframe.  You should now be able to create and analyse 2D
structures using Multiframe.  Of course, you have only looked at the
most basic methods available to the user of Multiframe.  Multiframe
has many powerful features to allow you to create and analyse
structures quickly and effectively and with fewer errors.  This means
there is often more than one way to accomplish a given task.  Take
the time to investigate the techniques described in the next chapter
and determine which methods are most suitable for your style of
operation and your type of structures.

For 3D and 4D users, the following tutorial extends the above
example to a 3D problem.  2D users may wish to skip to the next
chapter to continue reading.
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3D Tutorial
To extend the concepts and techniques you have learned, this section
will describe how to extend your 2D structure into 3D.  The frame
you will analyse is shown below.

10

PLAN

FRONT RIGHT SIDE

10

10

3D

10 10

You will analyse it for the two different loading conditions shown
and for a superposition of the two loads.

25.0

UDL  5.0

Load Case 1 Load Case 2

UDL  5.0

So far you have been drawing in a front view of the Frame.  To
change your view of the frame you use the View button in the
bottom left hand corner of the window.  First, make sure the Frame
window is in front then

• Click on the View button

A dialog will appear with a number of icons showing the seven
different views possible in a Multiframe window.
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• Click on the 3D icon to change to a 3D view

Selecting
Members

Rather than draw the additional members in the Frame, you can
automatically create them by using the Duplicate and Extrude
commands from the Frame menu. Before duplicating a part of a
frame, it is necessary to select the members to be duplicated.

• Point to the sloping member, away from its ends, and click

Notice that the member is drawn with a bold line indicating that it is
selected. Next, select the other member to be duplicated.

• Hold down the shift key and click on the second member

When you hold down the shift key while clicking on a member the
member is added to the current selection if it not already selected or
removed from the current selection if it is already selected.  In this
case, both members will be drawn with a bold line to indicate that
they are selected.

Once you have selected the two members,

• Choose Duplicate from the Frame menu

A dialog box will appear with a number of fields, which allow you to
specify the spacing of the duplicated members in each of the axis
directions.  In this case the spacing of the duplicated members is 0, 0,
and 10.000 in the x, y and z directions respectively.
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• Type in 0, 0 and 10 for the spacing

Since we will only be duplicating the selected members once, you
can leave the Number of Times field set to 1.

• Click the OK button

The selected members will be duplicated to the new position.

Next, we will add the two right hand supports in the frame by using
the Extrude command.  Extrude allows you to construct a member
by projecting it in space from an existing joint parallel to one of the
coordinate axes.  This provides an easy way to create beams and
columns, which run horizontally or vertically.

First, select the two joints at the right hand side of the frame

• Click on the first joint

This will select the first joint and indicate it is selected by drawing a
bold box on top of it

• Hold down the shift key and click on the second joint

This will select the second joint and also draw a bold box on top of it.
In the same way that you selected more than one member by holding
down the shift key when clicking, you can now select more than one
joint.
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• Choose Extrude… from the Frame menu

A dialog box will appear which allows you to specify how far and in
which direction to extrude the members.

In this case we wish to project the members down by 10.

• Enter 0, -10 and 0 for the extrusion dimensions

• Click the OK button

The two members will be added and connected to the two existing
joints.

Next, we will add the two beams, which connect the two frames by
using the Extrude command.

First, select the two joints at the top of the first frame.

• Choose Extrude… from the Frame menu

A dialog box will appear which allows you to specify how far and in
which direction to extrude the members.
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In this case we wish to project the members in the z direction by 10

• Enter 0, 0 and 10 for the extrusion dimensions

• Click the OK button

The two members will be added and connected to the two existing
joints.

Next, we need to move the lower joint of the frontmost diagonal leg
so that it is inclined to both the x and z axes.

• Use the View button to change to a Top view

First, click away from any joints to turn off the currently selected
joints.  Next, turn the Grid on again to make it easier to drag the joint
to the desired location.

Now, point to the bottom left joint with the mouse, click and hold
down the mouse button, then drag the mouse to the new location of
the joint where the coordinates will read x=0.000, y=0.000, z=20.000.
Note that although the y coordinate shows the current depth (10.000
in this case) Multiframe does not change the depth of a joint when
you drag it in a two dimensional view.

Change back to the 3D view to check that your frame now looks
correct. If necessary, you can use the Size To Fit command from the
View menu to make the display of the frame fit into the Frame
window.
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Clipping
One problem when working with framed structures in three
dimensions is that it is difficult to tell which members are in front
and which are behind when working in two dimensional views.
Multiframe provides you with clipping controls which lets you
control how much of the structure can be worked with at one time.
Clipping involves defining a three dimensional box which encloses
the part of the frame which is of interest to you.

You will find it helpful to turn off the display of the grid while
working with the clipping controls.

• Choose Grid… from the View Menu

• Click on the Invisible radio button to turn off the display of the
grid

• Click OK

The grid is no longer displayed however the grid alignment features
in the Frame window will still be active.

To start working with clipping, first make the Top view the current
view by using the View button at the bottom left of the window.
Now you will turn on clipping by initially positioning the clipping
bars around the frame.

• Choose Clip To Frame from the Clipping sub-menu under the
View menu

This positions the walls of the clipping box so that they just surround
the frame in each direction.  You can change the location of the walls
of the clipping box by dragging its boundaries with the mouse.

• Point to the left hand clipping bar and press the mouse button

• Drag this bar until it is just to the left of the center joint of the
frame

• Release the mouse button
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Notice that members which are completely inside the clipping box
are drawn in black or colored as usual while members which are not
completely inside the box are drawn in gray.  A member drawn in
gray cannot be selected, moved or connected to.  Now change to the
Right Side view.

Click and drag the bottom left joint of the frame to a new location of
x=10.000, y=0.000, z=20.000.  With the clipping on there is no danger
of accidentally connecting the joint to a joint behind it in space.
Finally, use the View button to go back to a 3D isometric view of the
frame to check that you have created it correctly.  Use the Size To Fit
command from the View menu to position the whole frame in the
middle of the window.

This completes the setup of the geometry of the frame. You can now
turn off clipping by choosing No Clipping from the Clipping sub-
menu under the View menu.  You can now move on to applying the
restraints and section types needed for the structure.

Restraining the
Joints

You will now need to set the restraints for the 3D frame.  First,
remove the existing restraints from the structure.

To remove all the restraints from the frame

• Choose Select All from the Select sub menu under the Edit menu

• Choose Joint Restraint from the Frame menu or from the short
cut menu
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• Click on the No Restraint icon

• Click OK

You will find it helpful to turn off clipping and turn off the grid now
that you have finished drawing the structure.

Next, change to the front view before setting the restraints.  Now,
drag a selection rectangle enclosing the joints at the bottom of the
frame, using the mouse.

Now apply the pinned restraint to the joints you have selected.

• Choose Joint Restraint from the Frame menu or from the short
cut menu

The joint restraints dialog will appear.

• Click on the pinned joint icon

• Click OK

This will apply a pinned restraint to the selected joints.  A Pinned
Joint cannot move, but is free to rotate.  The check boxes at the
bottom of the dialog indicate which degrees of freedom will be
restrained by each icon.

Section Properties
It is now necessary to select the members that you have added to the
structure and specify their section types.
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• Select the 5 new members

• Choose Section Type from the Frame menu

• Click on the name W in the list of section groups

• Use the scroll bar to scroll down the list of sections until the
W12X40 is visible

• Click on this name to select it

• Click on the OK button to confirm your choice

Loads
Next, you can apply additional loads in the Load window.

The point load we applied to the 2D frame will still be there so no
further modification to Load Case 1 is required.  Load Case 2
however has three additional distributed loads which you must now
apply.

First, switch to Load Case 2.

• Choose Load Case 2 from the Case menu

You can now add the distributed loads to the horizontal members in
the frame.

• Select the horizontal members in the frame

• Choose Global Dist'd Load from the Load menu or from the
short cut menu

A dialog box will appear with a number of icons in it.
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• Type a value of 5.0 for the left magnitude of the load

• Use the Tab key to move to the next number in the dialog

• Click OK to confirm the values you have entered

The loads you have added will be drawn on the members in the
Load window.

Now, switch to Load Case 3.

• Choose Load Case 3 from the Case menu

Notice that the combined load case has been automatically updated
with the loads you added to load case 2.

Analysis
Now that you have set up the structure and loading to your
satisfaction, you can carry out the analysis of the frame.

• Choose Analyse from the Case menu

A progress bar will appear indicating how far along the analysis has
progressed.  The progress bar will disappear once the analysis is
finished.

Viewing Results
You can now review the results of the 3D analysis in the Plot
window. Click anywhere in the visible part of the Plot window to
bring it to front or choose Plot from the Window  menu if the Plot
window is not visible.

• Use the View button to change the 3D view

• Choose Moment Mz' from the Actions sub-menu under the
Display menu

The bending moment diagram is drawn so that the moment diagram
is drawn on the tension face of the member.  The bending forces
shown are those about an axis perpendicular to the web of the
member.
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• Choose Shear Vy' from the Diagram sub-menu under the
Display menu

The shear force diagram for the whole structure will now be
displayed in the Plot window.  These shear forces are the shearing
actions through the web or principal axis of each member.

Axes
The naming of member actions reflect the axis the actions apply to.
There are three sets of axes in Multiframe

Section
Axes

•  Global Axes
are used to refer to joint coordinates and joint displacements.

•  Member Axes
are used to specify the orientation of a member, the direction
of perpendicular or tangential loads, the actions (moment
shear and axial) acting on the member, stresses on the
member and the member's deflection.  Member axes always
have a ' suffix.  For example, Mz' indicates that the moment
is about the z' axis, Vy' indicates shear through the y' axis
and so on.

•  Section Axes
are used to specify section properties such as moment of
inertia, section modulus etc.
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Animation
You can also animate your results while in the Plot window.  Ensure
that you are in the 3D view by clicking on "View" in the lower left-
hand corner of the Plot window and ensure that Deflections are
displayed by choosing Deflection from the Display menu.

• Select Load Case 3 from the Case menu

• Choose Animate... from the Display menu

Make sure that "Diagram" is selected and click OK.  Multiframe will
animate the deflected shape of your structure.

Summary
This completes our brief introduction to the capabilities of
Multiframe.  You should now be able to create and analyse structures
using the range of commands and tools.

Of course, you have only looked at the most basic methods available
to the user of the software.  Multiframe has many powerful features
to allow you to create and analyse structures quickly and effectively
with fewer errors.  This means there is often more than one way to
accomplish a given task. Take the time to investigate the techniques
described in the next chapter and determine which methods are most
suitable for your style of operation and your type of structures.
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Chapter 2
Using Multiframe
This chapter provides a more detailed description of the commands
available in Multiframe.

Introduction
If you have read Chapter 1, you are now familiar with some of the
features of structural analysis and design using Multiframe.  This
chapter presents a series of step-by-step instructions to the tasks
covered in Chapter 1 as well as other procedures you will want to
know about.

The chapter begins with a summary of basic computer skills, and this
is followed by a description of the tasks involved in analysing and
designing a structure using Multiframe.  These tasks fall into three
general categories; Creating the structure, specifying the loads and
interpreting the results of analysis.  The first three sections of this
chapter reflect these categories.  This is followed by detailed
explanations of doing design calculations, printing and saving data
and transferring data to other programs.

Summary of
Mouse Techniques

You will use the following mouse techniques to do just about all of
the tasks in this chapter.

•  Click to select or activate something
•  Press to cause a continuous action
•  Drag to select, choose from a menu or move something
•  Shift-Click to select or to extend or reduce a selection
•  Ctrl-Click to select or to extend or reduce a selection

(Windows only)
•  Double-Click to get information about an object

To Click
Position the pointer on what you want to select or activate
Press and quickly release the mouse button

To Press
Position the pointer on something
Without moving the mouse, press and hold down the mouse button

The effects of pressing continue as long as the mouse button is held
down. Pressing on a scroll arrow results in continuous scrolling.
Pressing on a menu title pulls down the menu and keeps it down
until you release the mouse button.

To Drag
Position the pointer on something
Press and hold down the mouse button and move the mouse
Release the mouse button

To Shift-Click
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Shift-click is used to extend or reduce the selection of joints and
members
Hold down the shift key and click on the joints or members you wish
to add to the selection or which you wish to remove from the
selection

To Ctrl-Click (Windows only)
Ctrl-Click is used to extend or reduce the selection of joints and
members
Hold down the Ctrl key and click on the joints or members you wish
to add to the selection or which you wish to remove from the
selection

To Double-Click
Double click is used to get information about a joint or member in
the Frame window
Point to the item you wish to double click and then click twice
quickly in succession without moving the mouse.

Summary of
Keyboard
Techniques

Tab
You can use the Tab key to move horizontally within a table or to
move from one field in a dialog to the next.

Return (Macintosh Only)
The Return key can be used to move to the next entry down in a table
or the next line down in the CalcSheet and is the same as clicking on
the OK button in a dialog.

Enter
The Enter key can be used to confirm the entry of numbers into a
table and is the same as clicking OK in a dialog.

Arrow Keys
The ↑ ← → ↓ keys may be used to move the selection in their
respective directions in the Data or Result tables or in tables in dialog
boxes.

Delete  - Macintosh
Backspace  -Windows and earlier Macintosh models
The Delete or Backspace key may be used to delete the current
selection.  If nothing is selected and you are typing text or numbers,
it will delete the character to the left of the blinking cursor.

Command - Macintosh
Ctrl - Windows
The Command or Ctrl key may be held down while typing another
key to choose a command from a menu without using the mouse.
Menu items which have a key to the right of the name may be chosen
in this way.  For example, to choose Undo from the Edit Menu you
could hold down the Command/Ctrl key and type Z.

Shift - Macintosh
Shift or Ctrl - Windows
You can hold down the Shift or Ctrl keys while clicking on
something to add it to the current selection or remove it from the
selection if it is already selected.
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Holding down the shift or Ctrl while drawing a member, dragging a
member or dragging a joint will constrain the movement to be
horizontal, vertical or at a 45 degree angle.

Home
Takes you to the top of the table in the Data and Result windows.

Using Views
The View button in the bottom left hand corner of the Frame, Load
and Plot windows can be used to display a range of two and three
dimensional views of a structure.  Each window has its own view
and is controlled separately by its view button.

You can change the view by clicking on the View button and then
clicking on the icon of the view you require.

Rotating a 3D View
When you have a 3D view displayed in the Frame, Load or Plot
windows, you can control the angle of view by using the rotation
controls at the bottom and right sides of the window.  The axes
indicator indicates the current angle of view.

The control at the bottom controls the rotation about the y axis while
the control on the right hand side controls the rotation about the x
axis.  You can press in the arrows at the ends of the controls to
gradually rotate the structure to a new position or you can click in
the control to move the angle of rotation to the position of the mouse.
If you hold down the mouse button after clicking in the control, you
can rotate the structure back and forth until you have the desired
angle of rotation.  If your structure is too large to draw rapidly as
you rotate it, Multiframe will draw a partial outline of the frame.

Zoom, Pan, Shrink
and Size To Fit

The Zoom, Pan, Shrink and Size To Fit commands in the View Menu
may be used to control the scale of the graphics displayed in the
Frame, Load and Plot windows.  Each view within a window has its
own scale and center of interest. This means you can have a close-up
plan view and a far away 3D view in the same window and simply
switch from one to another using the View button.
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Zoom
Zoom allows you to increase the size of the drawing in the frontmost
window.

• Choose Zoom from the View Menu

• Move the pointer to the top left hand corner of the area you wish
to view in close detail

• Drag a rectangle down and to the right which encloses the area of
interest and release the mouse button

The window's contents will be re-drawn to display the part of the
structure contained in the rectangle you have drawn.

You can use the Ctrl-E keyboard shortcut to use the Pan command.

Pan
Pan allows you to shift the display of the structure within the
window upwards, downwards, to the left or right.

• Choose Pan from the View Menu
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The cursor will change to a hand on the Macintosh or a box on
Windows.

• Press inside the window and hold down the mouse button

• Drag the drawing to its new location

• Release the mouse button to re-draw the contents of the window.

If not enough memory is available to move the image, a rectangle the
size of the window will be moved around as you move the mouse.

Shrink
Shrink allows you to decrease the size of the drawing on the screen
by 50%.

• Choose Shrink from the View Menu

The drawing will shrink down to 50% of its current size and be re-
drawn.

   

Size To Fit
Size To Fit automatically resizes the drawing in the frontmost
window so that the structure just fits inside the window in the
current view.  This is most useful after you have been zooming,
panning or shrinking as it returns you to a viewing scale that just fits
the frame inside the window.

Size To Fit Frame fits the whole frame inside the window.
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Size To Fit Selection fits the selected members and joints inside the
window.

Size To Fit Clipping fits the range of clipping inside the window.

Clipping and
Masking

Multiframe allows you to control how much of the structure you
wish to view at one time by use of two techniques named clipping
and masking.  Clipping allows you to define a three dimensional box
which encloses the part of the structure you wish to work with while
masking allows you to selectively show or hide any member or
group of members in the structure.

For example, suppose you wish to view the bending moment
diagram for a given column line in a frame. Without clipping the
diagram is very difficult to decipher.  However, if you select the
column line and then choose Clip to Selection from the Clipping sub-
menu under the Edit menu, the diagram is made much clearer.
Masking may be used in a similar way.  When a member is gray or
hidden because of clipping or masking, it cannot be selected or
moved with the mouse.

Clipping
You can control the clipping of the structure in any of the two
dimensional views in a window.  The clipping affects the display of
graphics in the Frame, Load and Plot windows.  This means that you
can use the clipping controls in a view of one window to make it
easier to see the graphics in a different view of another window.
There are two types of clipping, clipping which draws the clipped
out part of the frame in gray, and clipping which makes the clipped
out members completely invisible.

When clipping is turned on, the clipping bars are displayed as dotted
lines in the two dimensional view.  These dotted lines represent the
boundaries of the clipping box.
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To change the boundaries of the clipping box, and therefore change
which members in the structure are visible, you can press and drag
on the bars with the mouse.
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If you want to move two bars simultaneously, you can press and
drag on the intersection between the two bars and drag them at the
same time.

Clip To Frame
Usually you will find it convenient to start by choosing Clip To
Frame from the Clipping menu.  This positions the clipping bars so
that they lie just outside the outer boundaries of the frame.  You will
then find it easy to move the appropriate bar to restrict your viewing
to the part of the frame which is of interest to you.

Clip To Selection
You will also find it convenient to use the Clip To Selection
command from the Clipping menu.  This will position the clipping
bars so that they lie just outside the farthest extents of the currently
selected joints.

If you try to move a clipping bar past the position of its opposing bar
(for example, move the bottom bar up past the top bar) the opposing
bar will be moved to maintain a small distance between the two.
This can be very useful when you want to move clipping from one
floor to another or from one column line to another.  You can clip on
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the bar farthest from the direction you wish to move and drag the
two bars together.

Masking
Masking allows you to control the visibility of the structure by
selecting members and then choosing to show or hide them.  If you
use the Mask To Selection command in the Masking menu, this will
hide all of the members in the structure except those, which are
selected. If you choose Mask Out Selection, the selected members
will be hidden and the remaining visible members will remain
visible.

Like clipping, masking affects the display of graphics in the Frame,
Load and Plot windows and can also be used in a view of one
window to make it easier to see the graphics in a different view of
another window.  Masking can also be gray or invisible however
Multiframe will always ensure that clipping and masking both use
the same display method. i.e. either both will display in gray or both
will make hidden members invisible.

Masking is useful for situations where the area you wish to view is
not rectangular in shape and therefore is not suitable for clipping.

Rendering
Multiframe3D and Multiframe4D allow you to render the display of
the frame in the Frame, Load and Plot windows as an aid to
visualising the relative sizes and orientation of the sections in the
structure.  Rendering involves drawing a representation of the frame,
complete with web and flange details, with hidden lines removed.
Rendering can only be done in the 3D view in a window and only on
the Deflection diagram in the Plot window.  The number of segments
drawn per member on the rendered, deflected shape is controlled by
the precision set using the Plot… command from the Display menu.

To turn on rendering in the frontmost window

• Choose Render from the Display menu

A dialog will appear with the rendering options.
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• Check the Hidden Lines check box to turn on the rendering

If you wish you can also choose whether to use shading on the
sections and whether to draw separate lines for the edges of the
sections.  The Exaggerate sizes field can be used to exaggerate the
sizes of the section shapes as they are drawn in the rendered view.
Because the size of sections is usually very small compared to the
size of the frame, this helps make the actual shapes more clearly
visible.

• Click the OK button

The structure will be drawn using rendering until you turn
rendering off. To turn off rendering, choose the Render command
and turn off the Hidden Lines check box.

If you have clipping or masking turned on, rendering will only
render the visible members.  If you have drawn custom sections
using Section Maker, rendering will display the actual shape of the
custom section.  Circular sections are displayed approximately as
octagonal shapes.
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Creating a Structure
Creating a structure with Multiframe involves defining the
geometry, restraints, section types and the connections of the
structure by drawing in the Frame window.  You can also use the
pre-defined generation aids to automatically construct portal frames
or geometrically regular structures.

This section begins with a description of the drawing techniques you
can use to create a structure.  This is followed by a summary of how
to select joints and members in the structure and how to use
Multiframe capabilities to assist in generating commonly used
structures.  A description of the commands, which can be used to
specify data defining restraints, section properties and members with
pins or moment releases, completes the section.

Drawing
Members of the structure may be drawn directly by using the mouse
to define the beginning and end points of a member.  The scale at
which this drawing is carried out may be specified by choosing the
Size… command from the View Menu.  The maximum and
minimum coordinates to be used in the x, y and z directions may be
entered and Multiframe will scale these coordinates to the current
size of the Frame window.  All movements in the window are
accompanied by a display of the current pointer coordinates in the
lower left hand corner of the window.  All coordinates are shown in
the current length units as set using the Units command from the
View menu.

Setting the Size
Before starting drawing, you will need to set up the drawing area for
the size of frame you intend working with. To do this

• Choose Size… from the View Menu

A dialog box will appear with the dimensions of the structure.

• Enter the maximum and minimum coordinates you wish to use
in each direction

• Click the OK button

Using the Grid
Multiframe has a built-in facility to allow you to have your drawing
automatically align with an evenly spaced grid.  You can control the
spacing, display and use of this grid with the Grid… command from
the View Menu.

• Choose Grid… from the View Menu
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• Enter values for the x, y and z spacing of the grid

• Click on the On button if you want drawing to align to the grid

This will switch on the Visible button to make the grid visible.

• Click the OK button

If you want to have the joints automatically align with the grid, but
do not want to see the grid, simply click on the Invisible button
before clicking OK.  Similarly you can click on the Visible button to
have the grid displayed as a visual guide, but click on the Off button
to disable the automatic alignment with the grid.

All drawing and dragging in the Frame window will align to the grid
while the grid is switched on.

Setting the Origin
Multiframe has an origin for its coordinate system indicated by a
symbol of x, y and z axes drawn in the Frame window.  You can
control the display of these axes by using the Axes command from
the View Menu.

You can also change the location of the origin, relative to a structure.

• Choose Move …from the Frame menu

A dialog box will appear allowing you to enter x, y and z coordinates
for the new position of the origin.

This command is useful for creating structures, which are made up
of larger sub-structures. You can shift the origin to a convenient
location prior to doing the drawing for each sub-structure.

Drawing Depth
When you draw in a two dimensional view it is necessary to specify
the depth at which you are drawing.  For example, when drawing in
the Top view, the y coordinate must be specified for any members
drawn.

To change the current drawing depth

• Choose Depth… from the View menu

A dialog box will appear with the current depth selected.
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Type in a new value for the depth and click OK to set the new depth.
If you have clipping turned on, you can set the depth by dragging
the depth indicators which are the small black triangles drawn on the
sides of the window between the clipping bars.  The depth must
always lie in between the clipping planes.  If you try to drag the
depth outside of this range, the clipping bars will be moved to allow
the indicators to be moved to the new position.  You can double click
on the depth indicators to bring up the Depth dialog if you wish.

Adding a Member
To add a member to the structure

• Choose Add Member from the Frame menu

• Move the pointer to the position of the first joint

• Press the mouse button and drag to the position of the second
joint (Windows users have the option of just clicking on the first
joint instead of dragging)

Existing member in the frame

• Release the mouse button  (Windows users have the option of
just clicking on the second joint to complete the new member)

New member is
drawn here

Members will be connected
at this joint

Holding down the shift key while drawing a member constrains the
new member to be either vertical or horizontal or at 45 degrees.
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When you draw the new member, the coordinates of the mouse will
be displayed in the bottom left corner of the window.  Also, the
distance and slope of the current position of the mouse from the last
point will be displayed.

When drawing in the 3D view, you can only draw a member
between two existing joints.

If the grid is turned on while you draw the member, the position of
the joints will snap to the grid.  The depth of the member will
depend on the setting of the depth for the current view.  See Depth
above for an explanation of how to set this depth.

Connections
Between Members

If the position of the first or second joint of the member you have
drawn coincides with the position of an existing joint, the new
member will be connected to the existing member at the existing
joint.  Note that this will happen even if the existing joint is at a
different depth from the current drawing depth.  For this reason, you
will probably find it necessary to use the clipping and masking
controls when drawing members which lie in front of or behind
other members in the two dimensional views.  When drawing in the
3D view, you can only draw a member between two existing joints.

Existing member in the frame

 

New member is
drawn here

Members will be connected
at this joint

The new member will not connect with an existing member unless
you start or finish drawing on an existing joint.

Existing member in the frame

 

A second member drawn here will not
be connected to the existing member

The connections between the members are set to be rigid.  You can
change this using the Member Type command if you require a
connection between members, which cannot support moments.

Selections
In order to specify the properties, restraints and loads associated
with joints and members, it is necessary to be able to identify which
parts of the structure the various properties will be associated with.

You do this by graphically selecting joints and members prior to
choosing menu commands.  When you choose a command from a
menu, to apply restraints at joints for example, the command will act
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on the joints that are currently selected.  Note that you cannot select a
joint or member, which has been hidden using the clipping or
masking commands.

Frame with no members or joints selected

Selecting Joints
To select a joint

• Click on the joint

A selected joint is indicated by a solid black box around the joint.

This joint is selected

To select a group of joints

• Drag a rectangle which encloses the joints to be selected

To select all the joints

• Choose Select All from the Select sub-menu under the Edit menu

• Click the OK button

To extend or reduce the selection

• Shift-click to add a joint to or remove a joint from the current
selection

• Shift-drag to add a group of joints to or remove a group of joints
from the current selection

If you know the number of the joint you wish to select, you can select
it using the Select Joint command from the Select sub-menu under
the Edit menu.

If more than one joint lies under the point where you click,
Multiframe will select the joint closest to you.

Selecting
Members

To select a member

• Click on the member away from its ends

A selected member is drawn with a heavy black line.  A selected
member always has the two joints at its ends selected.
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This member is selected.

To select a group of members

• Drag a rectangle which encloses the members to be selected

To select all the members

• Choose Select All from Select sub-menu under the Edit menu

To extend or reduce the selection

• Shift-click to add a member to or remove a member from the
current selection.

• Shift-drag to add a group of members to or remove a group of
members from the current selection

If you know the number of the member you wish to select, you can
select it using the Select Member command from the Select sub-menu
under the Edit menu.

If more than one member lies under the point where you click,
Multiframe will select the member closest to you.

Subdividing a
Member

To subdivide a member in the structure

• Select the member or members to be subdivided

• Choose Subdivide Member from the Frame menu

A dialog box will appear with a field for the number of members you
wish to subdivide the member into and a table listing the lengths of
the new members.

• Enter the number of subdivisions to be created

If you want the member to be subdivided evenly, leave the table of
lengths unchanged otherwise, use the Tab key to move to the table
and change the length or proportion of the new members.

• Click the OK button

A number of new members connected end to end will be generated
to replace each of the selected members.  This command is
particularly useful for generating continuous beams or for
subdividing beams for the insertion of angle bracing.



Chapter Two Using Multiframe

Generation of a continuous beam using the subdivide command.

The member to be subdivided is selected

 

A continuous beam is generated using the
subdivide command with six subdivisions

Insertion of bracing in a frame by subdividing floor beams.

Members to be
subdivided are
selected

 

After subdividing
into two and
drawing in
bracing members

Deleting a Member

• In the Frame window, select the member or members to be
deleted

• Choose Delete Member from the Frame menu or..

• Type Delete (or Backspace on Windows machines and earlier
Macintosh models)

Select members
to be deleted

 

After choosing
Delete Member
from the Frame
menu

Automatic
Generation

Multiframe includes capabilities for automatically generating frames,
which occur frequently.  The four facilities provided are for standard
bay and storied frames such as those found in multi-story buildings,
portal frames as used in many buildings with sloping roofs,
continuous beams and curved structures.

Generating a
Portal Frame

To generate a portal frame

• Choose Generate… from the Frame menu

A dialog box will appear with the various generation icons in it.
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• Click on the portal frame icon and click OK

A dialog box will appear allowing you to enter the dimensions of the
frame.

• Enter the values for the width, column height and the slope of
the rafters

• Click the OK button

The pitched portal frame you generate will be shown in the Frame
window.

Generating a Multi-
story Frame

• Choose Generate… from the Frame menu

A dialog box will appear with the various generation icons in it.

• Click on the multi-bay frame icon and click OK

A dialog box will appear with fields for the spacing in each direction.
Bays run in the x direction, stories in the y direction and frames in
the z direction.
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• Enter the values for the number of structural elements and the
dimensions in each direction.

• Click the OK button

The frame you generate will be shown in the Frame window.

You may also find this command useful for generating the initial
geometry for other structures such as trusses.  You can start by
generating the appropriate number of bays, 1 frame and 1 story.

You can then use the other drawing and duplication tools to create
the structure you require e.g.

Generating a
Continuous Beam

Multiframe allows you to quickly generate a continuous beam,
which is made up of a number of even or varying length spans.

To generate a continuous beam

• Choose Generate… from the Frame menu

A dialog box will appear with the various generation icons in it.
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• Click on the continuous beam icon and click OK

A dialog box will appear with a table in it.

• Type the number of spans in the beam

• Click on the first length value in the table to select it

• Enter the lengths for each of the spans using the Down Arrow
key to move down the table

• Click the OK button

Multiframe will automatically generate the beam with the
dimensions you have specified.

Generating a
Curved Member

Multiframe allows you to quickly generate an approximation to a
curved member by generating a number of short straight members.

To generate a curved member

• Choose Generate… from the Frame menu

A dialog box will appear with the various generation icons in it.
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• Click on the curved beam icon and click OK

A dialog box will appear allowing you to enter the angles and radius
of the beam.

• Type the coordinates of the center of the arc, radius and angle of
sweep using the Tab key to move from number to number

• Type in the number of members you would like to use to
approximate the curve

• Click the OK button

Multiframe will automatically generate the assembly of members
with the dimensions you have specified.  The direction of the arc will
depend on the current view in the Frame window.  The arc will
always be generated about the axis, which is perpendicular to the
screen or in the case of the 3D view, about the axis, which is most
perpendicular to the direction of view. This axis is not drawn in bold
on the axis indicator.

Normally, you will want the new members to connect with any
existing members in the structure.  If you do not want this to happen,
uncheck the check box at the bottom of the dialog.

It is probably a good idea for you to test the accuracy of this
approximation to a curve, by generating arcs with different numbers
of members and examining the effect this has on the results of
analysis.

Generating a
Regular Frame

Multiframe allows you to quickly generate a regular frame, which is
made up of a number of evenly spaced, similarly shaped sub-
structures.  Typical examples of this would be high-rise buildings,
trusses or multiple bay portal frames. Multiframe also allows you to
duplicate shapes in cylindrical and spherical coordinates.

Duplicate
To duplicate a structure
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• Draw or generate the sub-structure you wish to duplicate

• Select the sub-structure to be duplicated

• Choose Duplicate… from the Frame menu

A dialog box will appear allowing you to specify the type of
duplication, the spacing in each direction, the number of times the
selection is to be duplicated and whether the duplicated members
should be connected with the existing structure.

• Choose which type of duplication you require

• Enter the spacing for your sub-structure

• Enter the number of times you wish to repeat the sub-structure

• Click the OK Button

If you do not want connections to be generated between adjacent
members, then switch off the check box ‘connect to existing’.
Normally you will want this option left on.  A connection will be
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made between generated members and existing members if the end
joints are within 0.2 inches (5 mm) of each other.

An example of the use of the Duplicate command to generate a
multiple bay portal frame is shown below.

The portal frame is generated and the
sub-structure to be duplicated is
selected

 

The resulting multibay portal structure

Cylindrical
Coordinates

If you wish to generate a structure in cylindrical coordinates, you can
select the cylindrical option.  This then allows you to space the
duplication radially from the y axis, angularly about the y axis, or
linearly along the y axis.  As an example, to generate a circular
staircase you would first draw half of one step and then duplicate it
to form the other half.

 
This would form one step of the staircase.

 
Then you would select the whole step and duplicate it to form the
entire staircase.
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Spherical
Coordinates

If you wish to generate a structure in spherical coordinates, you can
select the spherical option.  This then allows you to space the
duplication radially from the origin, angularly about the z axis, and
angularly about the y axis.  As an example, to generate a cylindrical
vault you could first draw a continuous beam parallel to the z axis
and then duplicate it angularly about z to form the vault.

Moving a Joint
You can only move joints in the Frame window.  Before moving a
joint, be sure that there are no joints selected in the frame.

To move a joint

• Point to the joint, press the mouse button and hold it down

• Drag to the new position of the joint

• Release the mouse button to fix the new location
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Holding down the shift key while dragging will constrain movement
vertically, horizontally or to 45 degrees.  The coordinates of the joint
will be displayed in the bottom left hand corner of the window as
you drag.  If you have turned on the Grid option, the joint will align
with the grid as you move it.

If you drag a joint on top of an existing joint, Multiframe will create a
connection between the members, which meet at the common point.

You can only drag joints in two dimensional views.  When you drag
a joint, Multiframe will not change the depth of the joint.

Typing Joint
Coordinates

You can also move a joint by typing in new coordinates for its
position.

• Double click on the joint

A dialog box will appear with the joint's coordinates.

• Type in the new values for the coordinates

• Click the OK button

You can also change a joint's location by typing or pasting  new
values in the X, Y and Z columns of the Joint table in the Data
window.

Moving a Group of
Joints

Multiframe also allows you to move a group of joints together either
by dragging with the mouse or by typing in a distance to move.

To move a group of joints with the mouse

• Select the joints to be moved

• Point to any of the selected joints and press the mouse button

• Drag the joints to the new location

• Release the mouse button

Multiframe will connect together any members that share a common
end point after you have dragged the joints.  Holding down the shift
key while dragging will constrain movement vertically, horizontally
or to 45 degrees.  The coordinates of the pointer will be displayed in
the bottom left hand corner of the window as you drag.  If you have
turned on the Grid option, the joints will move in increments of the
grid spacing as you move.

To move a group of joints numerically

• Select the joints to be moved

• Choose Move… from the Frame menu
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A dialog box will appear with fields for the distance you wish to
move the joints in each direction.  The Selection radio button will be
selected indicating that you wish to move the selected joints rather
than the origin.

• Enter the distance the joints are to be moved in each direction

• Click on the OK button

Multiframe will create a connection between joints that you
superimpose on top of each other using this command.  You can also
move a single joint using this command.  Simply select one joint
before using the command.

Moving a Member
You can only move members in the Frame window.  Before moving a
member, make sure that there are no members selected in the frame.

To move a member

• Point to the member away from its ends and press the mouse
button

• Drag the member to its new position

• Release the mouse button to fix the new position of the member
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The slope and length of the member will remain constant as you
move the member.  You can only move members in the two
dimensional views.

Holding down the shift key while dragging will constrain movement
vertically, horizontally or to 45 degrees.  The coordinates of the
pointer will be displayed in the bottom left hand corner of the
window as you drag.  If you have turned on the Grid option, the
member will move in increments of the grid spacing as you move.

If you drag a joint on top of an existing joint, Multiframe will create a
connection between the members, which meet at the common point.

Resizing a Member
You can change the length or slope of a member in the Frame
window by typing in new values.

To change the length or slope of a member

• Double click on the member

A dialog box will appear with the members name, end joint
numbers, section type, length, slope and orientation.

• Type in new values for the properties you wish to change

• Click the OK button

Joint 1 will stay at its original location, joint 2 will be moved to match
the entered length and slope.

Rescaling the
Structure

You can use the Rescale…  command from the Frame menu to
rescale the selected joints in the Frame window.  This command is
useful for investigating structural alternatives where you may wish
to change the overall aspect ratio of a structure or part of a structure.

• Select the part of the structure to be rescaled

• Choose Rescale… from the Frame menu
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A dialog box will appear with the scaling factors in each of the axis
directions.

• Enter the scaling factors for the x, y and z directions

• Click the OK button

Rescaling is done relative to the origin of the axes, so you may wish
to use the Move… command to move the origin prior to rescaling, to
ensure that rescaling occurs from the correct point.  Coordinates are
rescaled by multiplying their value by the scaling factor.  For
example, a joint with coordinates x=2, y=2, z=2 and rescaled using
scale factors of 1.5, 2.0 and 3.0 for the x, y and z directions
respectively, would move to the new location of x=3, y=4, z=6.

Using a scaling factor of -1 will reflect the selected joints about the
appropriate axis.

Multiframe will not create a connection between joints that you
superimpose on top of each other using this command.

Rotating Members
You can use the Rotate… command from the Frame menu to rotate
the selected joints in the Frame window.

• Select the part of the structure to be rotated

• Choose Rotate… from the Frame menu

A dialog box will appear with the rotation centers and angles.

• Enter the coordinates of the axis you wish to rotate the selection
about

• Enter the magnitude of the rotation for the appropriate axis

• Click the OK button

Rotating is done relative to the axis you specify with the coordinates.
For example, suppose you wanted to rotate the whole frame by 30°
about a line parallel to the z axis passing through the point x=10,
y=20.  You would first select the whole frame, and then you would
enter x=10, y=20, z=0, Øx=0, Øy=0, Øz=30 in the Rotate dialog.

Multiframe will not create a connection between joints that you
superimpose on top of each other using this command.

When rotating the selected joints you should enter only one non-zero
angle.  That is, Multiframe can only do one rotation at a time.
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Extruding Beams
or Columns

When you wish to add beams or columns to an existing frame, you
may find it easier to use the Extrude command rather than drawing
the new members with the mouse.  The Extrude command allows
you to project a member or group of members in any of the global
axis directions from existing joints.  For example, you could draw a
floor plan and then extrude the columns up from it or you could
extrude the beams out from a wall frame you have drawn.

To extrude members from the frame

• Select the joints in the frame to be extruded

• Choose Extrude… from the Frame menu

A dialog box will appear with fields for the direction and dimension
of the extruded members.

• Enter the length of the extruded members in the appropriate
direction

• Click the OK button

If you leave the Connect to existing check box checked, Multiframe
will automatically create a connection between the selected joints
and the extruded members.  It will also connect the extruded
members to any existing members in the frame if they lie within a 0.2
in (5mm) tolerance of the ends of the existing members.

Editing
Coordinates
Numerically

Multiframe allows you to change the positions of joints in the
structure numerically rather than graphically.  You will find this
option useful for "fine tuning" the coordinates of your structure after
drawing it.

Each joint in the structure is identified by a unique number.  You can
display these numbers in the Frame, Load and Plot windows by
choosing Symbols… from the Display menu, checking the Joint
Numbers check box and clicking the OK button.

Coordinates are changed by typing values in the Data window or by
double clicking on the joint in the Frame window.  You will probably
find it helpful to use the Editing Layout from the Window menu
while you are typing in coordinates, as this will allow you to see the
changes to the structure as you make them.  The coordinates are
displayed in a table in the Data window.  You can resize the columns
in the table by dragging the lines, which separate the columns. You
can change the text font and size used in the table by using the
Font… command from the View Menu while the Data window is
frontmost on the screen. You can control the format of the numbers
displayed in the table by using the Numbers… command from the
Format window while the Data window is frontmost.
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To change a coordinate of a joint

• Make sure the Data window is frontmost

• Click on the coordinate to be changed

• Type in the new value for the coordinate

• Press the Enter key on a Macintosh, or click inside the Frame or
Load window on Windows



Chapter Two Using Multiframe

The structure will be re-drawn in the Frame and Load windows to
reflect the changes you have made.  You can repeat this process for
any of the other joints in the structure.  You can use the Tab Return
keys or the arrow keys to move from number to number in the table
or you may simply click on the number you wish to change.

Note that changing the coordinates of a joint so that it is the same as
another joint in the structure will not create a connection between the
members at that joint. A connection can only be made by dragging
one joint onto the other in the Frame window.

If you double click on a joint in the Frame window, Multiframe will
display a dialog, which allows you to change the coordinates of the
joint.

Changing the position of a joint will change the length and/or slope
of any members, which are connected, to it.  The length and slope of
the members in the structure may also be changed directly.  The
Member lengths and slopes may be displayed by choosing the
Members command in the Data sub-menu under the Display menu.

Simply click on the numbers to be changed and type in the new
values. The drawing in the Frame and Load windows will be
updated to reflect your changes.  Remember that the slope of a
member is measured in degrees with positive angles being measured
from a zero angle on the horizontal plane passing through the lower
joint.  Joint 1 will be the leftmost joint in the case of a horizontal or
sloping member as viewed in the front or right side views or the
bottom-most joint in the case of a vertical member.

You can also change the length and slope of a member by double
clicking on it in the Frame window and typing in the new values in
the dialog which appears.

If you change the length of a member, Joint 1 will be held fixed and
Joint 2 will be moved to give the member the required length.  The
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slope will not be changed.  Similarly, changing the slope of a member
will move Joint 2 and will leave Joint 1 in the same position while
leaving the length of the member unchanged.

Joint and Member
Numbers

As you add members and joints to a structure, Multiframe will
automatically assign numbers to them. If you wish to renumber the
joints and or members, you can do so using the Renumber item from
the Frame menu.

To renumber the structure

• Choose Renumber from the Frame menu

You have three options for the directions, in which the renumbering
will be done,

by bays left to right,
by stories bottom to top,
or by frames front to back.

Note that you can renumber after analysis and your results will be
preserved but displayed using the new joint and member numbers.

You can display the joint and member numbers on the members in
the drawing windows by using the Symbol command from the
Display menu and turning on Joint Numbers and/or Member
Numbers.

Restraints
A structure must be sufficiently restrained for analysis to be carried
out.  A minimum requirement is that the structure be restrained
against movement in each of the x, y and z directions and that it
should not have any mechanisms caused by collapsible pinned
structures.

The restraints on the structure are specified by first selecting the joint
or joints to be restrained and then selecting the appropriate type of
restraint.  The restraint may take the form of a zero displacement
restraint, a spring or a prescribed displacement.  A joint may have
either a restraint, or a prescribed displacement or a spring for each
degree of freedom but not combinations of these restraints for any
degree of freedom.  Thus a joint could have a vertical prescribed
displacement and a horizontal spring but not a horizontal prescribed
displacement and a horizontal spring or a vertical prescribed
displacement and a vertical restraint.

Zero Displacement
Restraint

To prescribe a restraint at a joint

• Select the joint or joints to be restrained

• Choose Joint Restraint from the Frame menu
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A dialog box will appear with a range of icons for the various types
of restraint

• Click on the appropriate restraint icon

• Click on the OK button

Selecting the "no restraint" icon (the first icon in the list) will remove
all joint restraints from the selected joints.  Selecting any other icon
will remove any prescribed displacements or springs from the
selected joints and replace them with the selected restraint.

Each of the possible restraints is indicated by an icon.  As you click
on the icons, the check boxes at the bottom of the dialog will display
the degrees of freedom, which will be restrained if you select that
icon.

You can also click on the check boxes directly to choose which
degrees of freedom you wish to restrain.  If the combination of
restraints you select is not one of the standard icons, Multiframe will
display the special restraint icon (the last icon in the list).

Prescribed
Displacement

To prescribe a displacement at a joint

• Select the joint or joints to undergo the prescribed displacement

• Choose Joint Displacement  from the Frame menu

A dialog box will appear with icons for the various prescribed
displacements.

• Click on the icon which shows the direction the displacement is
to be applied

• Type in a value for the displacement

• Click on the OK button
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Selecting the "No prescribed displacement" icon (the first icon in the
list) will remove all prescribed displacements from the selected
joints.  Since a prescribed displacement is equivalent to a restraint
with a non-zero value, selecting any other icon will remove any
restraints or springs which share the same degree of freedom from
the selected joints and replace them with the prescribed
displacement.

Prescribed displacements act in the global coordinate system of the
structure.  Each of the icons represents a direction for the
displacement relative to one of the reference axes.  As you click on
the icons, which indicate the various displacements, the directions of
each displacement will be indicated by the radio buttons at the
bottom of the dialog.  You can also click on the radio buttons to
choose which direction you wish the displacement to act in.

Note that a prescribed joint displacement affects the geometry of the
structure and therefore applies to all load cases.

Springs
To attach a spring support to a joint

• Select the joint or joints supported by springs

• Choose Joint Spring  from the Frame menu

A dialog box will appear with icons for the spring directions.

• Click on the icon which shows the direction in which the spring
is to act

• Type in a value for the spring constant

• Click on the OK button

Selecting the "No spring" icon (the first icon in the list) will remove
all springs from the selected joints.  Selecting any other icon will
remove any restraints or prescribed displacements with the same
degree of freedom (if any) from the selected joints and replace them
with springs.  The rotational spring icons each have an axis drawn
through them in the 3D view, which indicates the axis about which
they provide rotational stiffness.

Editing Restraints
Numerically

You can display and edit tables of springs and restraints in the Data
window.  You can use the commands from the Data sub-menu under
the Display menu to control which table is on display at any time.

Restraints such as pinned or fixed joints will have restraint values of
zero while prescribed displacements such as a settlement condition
will have non-zero displacement values.

To change the value of a prescribed displacement
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• Click on the number you wish to change

• Type in the new value

• Press the enter key

You can edit spring supports in exactly the same way as prescribed
displacements.  You can edit the stiffness coefficients of the springs
by clicking and typing in new values.

While editing numbers in the Data window you can use the scroll
bars to scroll through the list of data, horizontally or vertically, to
find the number you want to alter.  If you wish, you can use the
Return or Enter, Tab or arrow keys to move to another number
rather than pressing enter.  You can resize the columns in the table
by dragging the lines, which separate the column titles.  You can
change the text font and size used in the table by using the Font…
command from the View Menu while the Data window is in front on
the screen.  The format of the numbers displayed in the table can be
controlled by using the Numbers… command from the Format
window while the Data window is in front.

Linking Joints Or
Master-Slave

Multiframe allows you to link groups of joints together so that they
move together in response to either static or dynamic loads.  This has
a twofold benefit.  Firstly, it allows you to simulate rigid structural
elements such as a floor slab, and secondly it significantly reduces
the size of the stiffness matrix resulting in lower memory
requirements and faster analysis times.

Joints can be linked together on a degree-of-freedom basis.  This
means some degrees-of-freedom can be linked together and others
left independent.  In the case of a rigid floor slab for example, all the
joints on that level could have their x, z and Øy deflections linked
together to simulate the rigid translation and rotation of the slab
while still allowing bending of the floor.

• Select the joints to be linked in the Frame window

• Choose Joints Links from the frame menu

• Type in a name for the group and select the degrees of freedom
to be linked

The linked group of joints is displayed as a shaded area in the Frame
window.
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The linked joints are also displayed in tabular form in the Data
window.  Choose Linked Joints from the Data sub-menu to display
this table.

The linking is defined for the global XYZ directions.  If you link two
or more nodes together in the X direction then they will be locked
together for any movement in the global X direction.  Referring to the
diagram below the two loads in the X direction will cancel each other
out without inducing a moment about the Y axis.  This is because the
nodes at which the loads are applied are linked in the X direction
prohibiting any rotation about the Y axis which would result in
differential X axis movement.

Joint Mass
If you are performing a dynamic analysis using Multiframe4D, you
may wish to add additional masses to the structure to simulate the
effects of equipment or construction loading which will affect the
inertia of the frame.   The Joint Mass command from the Frame menu
allows you to add these additional masses at joints in the structure.

To add a mass at a joint or joints

• Select the joint or joints

• Choose Joint Mass from the Frame menu
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• Enter the mass values to be associated with each global direction
of movement

If you have already added masses that you wish to remove, you can
click the Delete Joint Masses radio button to remove Joint Masses
from the selected joints.

Member Masses
If you are performing a dynamic analysis using Multiframe4D, you
may wish to include or ignore the masses of the members in the
frame and the effect they will have on the inertia of the frame.  The
Member Mass command from the Frame menu allows you to ignore
or include the effect of member mass in dynamic analysis.

To specify whether member mass is to be included

• Select the member or members

• Choose Member Masses from the Frame menu

• Click Ignore or Include as appropriate

Section
Orientation

When analysing a three dimensional frame it is necessary to know
the orientation of the structural section used for each member
relative to the global coordinate system.  Initially, Multiframe
assumes that the web or direction of principal strength of the section
is aligned so that the principal direction lies in a vertical plane
passing through the member.  In the case of a vertical column, it is
assumed that the principal direction passes through the global x axis.
If you wish to have the section oriented at another angle (referred to
by some engineers as the beta angle) you can use the Orientation…
command from the Frame menu.

To change the orientation of a member or members

• Select the member or members to be specified

• Choose Orientation from the Frame menu
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A dialog box will appear which displays the section's shape.  The
view of the section shape in the dialog is the view you would see if
your eye was at joint 2 and you were looking down the member
towards joint 1.

• Click and drag on the shape to rotate it to a new orientation or
type in a new orientation angle

• Click OK to set the new orientation

When you set the orientation you are effectively defining the
direction of the local y' axis of the member.  The angle you type in is
the angle between the y' axis and a vertical plane passing through
both ends of the member.  As the angle increases the y' axis will
rotate towards the z' axis.

X’

Y’

Z’

x

y

z

Local Axes

Joint 1

Joint 2

Global Axes

You can display the section axes on the members in the Frame
window by using the Symbol command from the Display menu.
You can also show the member axes in this way.

Section Properties
To compute the deflections in the structure it is necessary to know
the geometric and material properties of the members, which make
up the structure.  Multiframe has a library of pre-defined section
properties for the most commonly used steel sections.  If you wish to
use structural sections other than those pre-defined in the Sections
Library, see "Adding a custom section" below.

Note that Multiframe uses the word "Member" to describe a
geometric component of a structure such as a beam, column or strut
and the word "Section" to describe a particular structural shape or
section with its own material and geometric properties.  Each
member of the structure is constructed using a particular section.

To specify the section for a member
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• Select the member or members to be specified

• Choose Section Type from the Frame menu

A dialog box will appear with a list of the groups and sections
available in the Sections Library.

• Click on the name of the group you wish to choose from

• Click on the name of the section you wish to choose

• Click the OK button

You must specify the section type for every member in the structure
before carrying out the analysis.

You can display the sectional shapes on the members in the Frame
window by using the Symbol command form the Display menu and
turning on Section Shapes.

Adding a Custom
Section

If the structural section you require is not contained in the Sections
Library, you can define your own section and store it in the library or
store it with the structure.  You may find it easier to use the Section
Maker application to create and install your section however this
section describes how you can add a section by simply typing in the
key sectional properties.

The sections are arranged in the library in groups. Each of the groups
usually consists of a range of sections of a similar type.  This
corresponds to the various tables of sections found in engineering
handbooks.  At the end of the list of groups are a number of groups
labeled Custom1, Custom2, Custom3 and Frame. These groups are
designed to be used to store special sections in.

To add a custom section

• Choose Add Section from the Edit menu

A dialog box will appear with a list of group names, a table of section
properties, a field for the section's name and a list of icons to indicate
the sections shape.
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• Click on the name of the group you wish to store the member in

• Type in a name for the section and press the Tab key

• Fill in the fields in the table with appropriate values using the
Tab key to move from field to field

• Click on the icon which indicates the shape of the custom section

If your section does not have one of the shapes shown in the list,
leave the question mark icon selected.

• Click on the OK button

Note that it is not necessary to fill in all the fields if you do not wish
to use the variables later in the CalcSheet.  However, the following
fields must be filled in:

A Cross sectional area
Ix moment of inertia about the major(x-x) axis
Iy moment of inertia about the minor (y-y) axis
J Torsion constant
E Young's Modulus
G Shear Modulus

Use the units indicated for each field.

Only the groups in the library, which are not locked, will be shown
in the list of groups.  If you wish to store the section in the library
and have it available for use in other structures, store the section in
one of the groups other than the group named Frame.  Sections
stored in the Frame group will be stored with the structure and will
not appear in the list unless you are using this structure.  You will
probably find it convenient to store most of your sections in the
Custom group to avoid cluttering up your library with sections,
which are only used in one or two structures.

Removing a
Custom Section

To remove a custom section from the library

• Choose Delete Section from the Edit menu

A dialog box will appear with a list of groups and sections.
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• Click on the group and section to be deleted

• Click on the Delete button

Editing a Custom
Section

To change the section properties of a custom section

• Choose Edit Section from the Edit menu

A dialog box will appear with a list of groups and sections.

• Click on the group and section to be edited

• Click on the Edit button

A dialog box will appear with the data for the section shown in a
table.

• Enter the information you wish to change using the Tab key to
move from field to field

• Click on the OK button

You can also use this procedure to look at the actual values stored in
the library for any section without changing them.  Simply click the
Cancel button after viewing the properties of interest to you.

If the OK button is drawn in gray this indicates that the group this
section is stored in is locked and the section properties cannot be
changed.
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Section Types
You can review the sections used in a structure by displaying the
Sections Table in the Data window. Choose Sections from the Data
sub-menu under the Display menu to display this table. The table of
sections displays details all of the sections used in the frame.  It
contains information about the sectional properties as well as the
dimensional information about the sections.  This is particularly
useful when copying information to a spreadsheet for further
processing (see Appendix F for more information).

Joint Types
Multiframe allows you to use two basic types of joints.  Either joints,
which are completely "rigid", i.e. they can transmit moments, or
joints, which are "pinned" i.e. they cannot transmit any moment.

To set the joint type

• Select the joint or joints to be pinned

• Choose Joint Type from the Frame menu

A dialog box will appear with icons indicating the two types of
joints.

• Click on the icon which represents the type of joint you require

• Click on the OK button

The joints in the Frame window which are now pinned will be
drawn with a circle on top of the joint to indicate that it is pinned.

Pinned Joints are most useful in situations where all or most of the
joints in a structure cannot support moment transfer.  If you wish to
model a situation where some of the members connected at a joint
can transmit moment and some cannot, then you should use the
Member Type command explained below.

Member Types
Multiframe allows you to use four basic types of members.  These are
members, which are pinned or rigid at one or both ends.  If "rigid",
they can transmit moments at the end, or if  "pinned" they cannot
transmit moments (sometimes referred to as member releases).

To set the member type

• Select the member or members to be pinned

• Choose Member Type from the Frame menu
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A dialog box will appear with icons indicating the four types of
members.

• Click on the icon, which represents the type of member, you
require

• Click on the OK button

When you specify the type of a member you have control over which
degrees of freedom are released at the pinned ends of a member.
You can release any of the three rotations at each end of a member.
This helps prevent the problem of torsional mechanisms being
created when a group of connected members all have the Øx'
rotation released.  To help prevent this, the default settings for a
pinned end only release the major and minor rotations (Øy' and Øz')

The members in the Frame window with pinned ends will be drawn
with a circle near the ends, which are pinned. Although the pins are
shown to be a small distance from the end of the member in the
Frame window, for the purposes of analysis they are in fact infinitely
close to the ends of the member.  A pinned end releases all the
bending and torsional moments about each of the local member axes.

Note that the assumed member type is initially a rigid/rigid member
and it is not necessary to explicitly define any member to be of this
type, unless you have previously set the member type to
rigid/pinned, pinned/rigid or pinned/pinned.

Shear Area
Multiframe allows shear area to be input and used in analysis.  Using
shear area can be switched on or off on a member by member basis.

To use shear area in a Multiframe analysis, a member must have a
section type that has the shear area fields defined.  Asx and Asy are
the two fields in the Sections Library group that define the shear area
for the sections local x and y axes, where x is the major axis.  For all
other sectional values, y is equivalent to local member axis y' and x is
equivalent to local member axis z' in the negative direction.
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The shear area values must be greater than zero, and the member
must have the appropriate shear area flag set.

• Choose Member Shear Area...  from the Frame menu

 

• Select the local member axes for which shear area is to be used in
analysis

Remember Asx corresponds to the z' axis and Asy to the y' axis.

The members that use shear area in analysis are indicated in the last
column in the Member Data sheet.
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Applying Loads
Changes to the loads, which are applied to the structure, may be
made in the Load window.  Loads may be added to the structure or
removed from it and can be applied as a number of different load
cases.  These load cases may be factored together to produce
combined load cases if desired.

Loads are entered in the current load units as controlled by the
Units… command from the View Menu.

All of the commands under the Load menu operate on the current
load case.  The name of the current load case is displayed in the
bottom left hand corner of the Load window. Also, the name of the
current load case has a check mark beside it in the Case menu.  You
can set the current load case by choosing the appropriate name from
the list of load case names under the Case menu.

Joint Load
A joint load is a load, which acts at a joint in the structure and acts in
a direction parallel to one of the reference x, y or z axes.

To apply a load to a joint

• Select the joint or joints to be loaded

• Choose Joint Load from the Load menu or the short cut menu

A dialog box will appear with icons to indicate the direction of
loading.

In a two dimensional view, there will be four icons indicating the
four possible load directions.  In the 3D view, all six possible icons
will be displayed with the icons pointing in the direction of the
global axes in the current view.

• Click on the icon which shows the direction in which the load is
to act

• Type in a value for the magnitude of the load

• Click on the OK button

There is no need to enter '+' or '-' signs for your load magnitudes.
The directions are determined from the icon, which you select.

If you wish to remove the joint loads from a joint, select the joint and
choose Unload Joint from the Load menu.

You can superimpose loads in the same direction on a single joint.
Each time you use the Joint Load command, the new loads will be
superimposed on any other joint loads you may have previously
applied.
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Joint Moment
A joint moment is a bending moment, which acts at a joint in the
structure, and acts about one of the reference x, y or z axes.

To apply a moment to a joint

• Select the joint or joints to be loaded

• Choose Joint Moment from the Load menu or the short cut menu

A dialog box will appear with icons to indicate the direction of
loading.

In a two dimensional view, there will be four icons indicating the
four possible moment directions.  In the 3D view, all six possible
icons will be displayed with the icons showing the direction of the
action of the moments about the global axes in the current view.  The
line through the center of each icon indicates the direction of the axis
the moment is acting about.

• Click on the icon which shows the direction in which the
moment is to act

• Type in a value for the magnitude of the moment

• Click on the OK button

There is no need to enter '+' or '-' signs for your moment magnitudes.
The directions are determined from the icon, which you select.

If you wish to remove the moments from a joint, select the joint and
choose Unload Joint from the Load menu.

Global Distributed
Load

Multiframe allows loading on members to be applied relative to the
direction of the global coordinate system or relative to the direction
of the local member coordinate system.  Loads, which are applied at
an angle to either of these systems, can be modeled by using vector
components of the loads.

A global distributed load is a load which is distributed along all or
part of a member, and acts in a direction parallel to one of the
reference x, y or z axes.

To apply a global distributed load to a member

• Select the member or members to be loaded

• Choose Global Dist'd Load from the Load menu or short cut
menu

A dialog box will appear with icons to indicate the direction of
loading.



Chapter Two Using Multiframe

In a two dimensional view, there will be four icons indicating the
four possible loading directions.  In the 3D view, all six possible
icons will be displayed with the patterns in the icons showing the
direction of the action of the loads.  Each icon has a pattern with lines
running parallel to the direction of action.

• Click on the icon which shows the direction in which the load is
to act

• Type in values for the magnitude of the load at each end

The magnitude of a global distributed load refers to its load per
length where the length is measured perpendicular to the direction
of action of the load.  This means a distributed load applied to an
inclined member will apply a total load equivalent to the magnitude
of the load times the horizontal projected length of the member.

• Click on the OK button

Note that when working in dialog boxes, you can use the Tab key to
move from one editing box to the next.  If you do this in this case, the
right hand end magnitude will automatically be set to the same value
as the left hand end magnitude.  You may type over this second
value if you wish to have a non-uniform load.

There is no need to enter '+' or '-' signs for your load magnitudes.
The directions are determined from the icon, which you select.

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to start at one third span
you can enter L/3 for its start position.  If you enter this in a load
dialog, this expression will be calculated for all the selected
members.  This means you can apply this load to a number of
members of different lengths simultaneously.  You can also enter
more complicated expressions such as 2*L/3 or 1.35+(L-4)/2.  The
variable L is always available and contains the length of the member,
the syntax of the expressions is the same as that used in the
CalcSheet.

Local Distributed
Load

A local distributed load is a load which is distributed along all or
part of the member and acts in a direction either normal (shear) or
tangential (axial) to the member.

To apply a local distributed load to a member

• Select the member or members to be loaded

• Choose Local Dist'd Load from the Load menu or short cut menu
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A dialog box will appear with icons to indicate the direction of
loading relative to the member.

• Click on the icon which shows the direction in which the load is
to act

• Type in values for the magnitude of the load at each end

• Click on the OK button

There is no need to enter '+' or '-' signs for your load magnitudes.
The directions are determined from the icon, which you select.

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to start at one third span
you can enter L/3 for its start position.  If you enter this in a load
dialog, this expression will be calculated for all the selected
members.  This means you can apply this load to a number of
members of different lengths simultaneously.  You can also enter
more complicated expressions such as 2*L/3 or 1.35+(L-4)/2.  The
variable L is always available and contains the length of the member,
the syntax of the expressions is the same as that used in the
CalcSheet.

Global Point Load
A global point load is a concentrated load, which acts at a position
part way along a member and acts in a direction parallel to one of the
reference x, y or z axes.

To apply a global point load to a member

• Select the member or members to be loaded

• Choose Global Point Load from the Load menu or the short cut
menu

A dialog box will appear with icons to indicate the direction of
loading.
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In a two dimensional view, there will be four icons indicating the
four possible loading directions.  In the 3D view, all six possible
icons will be displayed with the direction of the arrows in the icons
showing the direction of the action of the loads as they will be
displayed in the current view.

• Click on the icon which shows the direction in which the load is
to act

• Type in the value for the magnitude of the load

• Press Tab and type in the position of the load measured from
joint 1

• Click on the OK button

There is no need to enter '+' or '-' signs for your load magnitudes.
The directions are determined from the icon, which you select.

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to be at mid span you can
enter L/2 for its position.  If you enter this in a load dialog, this
expression will be calculated for all the selected members.  This
means you can apply this load to a number of members of different
lengths simultaneously.  You can also enter more complicated
expressions such as 2*L/3 or 1.35+(L-4)/2.  The variable L is always
available and contains the length of the member, the syntax of the
expressions is the same as that used in the CalcSheet.

Local Point Load
A local point load is a concentrated load, which acts part way along a
member and acts in a direction normal (shear) or parallel (axial) to
the member.

To apply a local point load to a member

• Select the member or members to be loaded

• Choose Local Point Load from the Load menu or the short cut
menu

A dialog box will appear with icons to indicate the direction of
loading relative to the member.

• Click on the icon which shows the direction in which the load is
to act

• Type in the value for the magnitude of the load
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• Press Tab and type in the position of the load measured from
joint 1

• Click on the OK button

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to be at mid span you can
enter L/2 for its position.  If you enter this in a load dialog, this
expression will be calculated for all the selected members.  This
means you can apply this load to a number of members of different
lengths simultaneously.  You can also enter more complicated
expressions such as 2*L/3 or 1.35+(L-4)/2.  The variable L is always
available and contains the length of the member, the syntax of the
expressions is the same as that used in the CalcSheet.

Global Moment
A global moment is a bending moment, which acts part way along a
member and acts about one of the reference x, y or z axes.

To apply a global moment to a member

• Select the member or members to be loaded

• Choose Global Moment from the Load menu or the short cut
menu

A dialog box will appear with icons to indicate the direction of the
moment.

In a two dimensional view, there will be two icons indicating the two
possible moments which can be applied.  In the 3D view, all six
possible icons will be displayed with the direction of the arrows in
the icons showing the direction of the action of the loads, as they will
be displayed in the current view.

• Click on the icon which shows the direction in which the
moment is to act

• Type in the value for the magnitude of the moment

• Press Tab and type in the position of the load measured from
joint 1

• Click on the OK button

There is no need to enter '+' or '-' signs for your moment magnitudes.
The directions are determined from the icon, which you select.

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to be at mid span you can
enter L/2 for its position.  If you enter this in a load dialog, this
expression will be calculated for all the selected members.  This
means you can apply this load to a number of members of different
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lengths simultaneously.  You can also enter more complicated
expressions such as 2*L/3 or 1.35+(L-4)/2.  The variable L is always
available and contains the length of the member, the syntax of the
expressions is the same as that used in the CalcSheet.

Local Moment
A local moment is a bending moment, which acts part way along a
member and acts about one of the local axes.

To apply a local moment to a member

• Select the member or members to be loaded

• Choose Local Moment from the Load menu or the short cut menu

A dialog box will appear with icons to indicate the direction of the
moments relative to the member.

• Click on the icon which shows the direction in which the
moment is to act

• Type in the value for the magnitude of the moment

• Press Tab and type in the position of the moment measured from
joint 1

• Click on the OK button

When you enter positions of loads in the member loading dialogs or
the Data window, you can enter calculation expressions for the
position.  For example, if you want a load to be at mid span you can
enter L/2 for its position.  If you enter this in a load dialog, this
expression will be calculated for all the selected members.  This
means you can apply this load to a number of members of different
lengths simultaneously.  You can also enter more complicated
expressions such as 2*L/3 or 1.35+(L-4)/2.  The variable L is always
available and contains the length of the member, the syntax of the
expressions is the same as that used in the CalcSheet.

Thermal Load
A thermal load is a load resulting from a temperature differential in
the structure between a member and the ambient temperature.  A
thermal load may also result from a temperature gradient through
the depth of a member.

To apply a thermal load to a member

• Select the member or members to be loaded

• Choose Thermal Load from the Load menu or the short cut menu
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A dialog box will appear with fields for the magnitude and depth of
the thermal load.

• Choose whether the temperature varies through the depth (web
or y' axis direction) or the breadth (flange or z' axis direction) of
the member

• Type in the temperatures at the top and bottom of the member

These two temperatures will be the same if the member is at a
constant temperature.  If the load is applied in the z' direction top
refers to the positive z' side while bottom refers to the negative z'
side.

• Type in a value for the thermal coefficient for the member
material

The thermal coefficient is entered in units of microstrain per degree.

• Type in a value for the depth of the thermal load

• Click on the OK button

All the temperature values are variations in degrees from the
ambient temperature.  For example, a bridge deck with the top of the
beams at 45° and the bottom of the beams at an ambient of 20° would
have top and bottom temperatures of 25° and 0° respectively.

The thermal gradient is assumed to be symmetric about the neutral
axis of the member.  That is, the top temperature occurs at half the
depth above the neutral axis and varies linearly down to a point half
the depth below the neutral axis.

Top Temperature

Bottom Temperature

Neutral Axis
Depth

Editing Loads
Numerically

You can edit the values and positions of loads numerically in tables
of data, which may be displayed in the Data window.  These tables
display Joint Loads, Member Loads and Thermal Loads.  You can
choose which table to display by choosing the appropriate item from
the Data sub-menu under the Display menu.

To change the value or position of a load

• Click on the number to be changed
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• Type in the new value for the load

• Press the enter key

If you change the position or direction of a load, the drawing in the
Load window will be updated to reflect the change.

Note that the loads for the current load case only will be displayed in
the Data window.  You cannot change loads for a combined load
case, a dynamic load case or a self weight load case.

Self Weight
Multiframe allows you to automatically include the self weight of the
structure as a separate load case.

• Choose Self Weight… from the Load menu or the short cut menu

A new load case named Self Weight will be created.  Only one self
weight load case is allowed.  You should make sure that you have set
all of the section types for the structure before you use the self
weight command.  If any of the sections used in the structure have
zero mass, Multiframe will prompt you with a dialog to go ahead
with or cancel the use of self weight.  If you wish to use self weight
with custom sections, make sure you enter an appropriate value for
the mass when adding the section to the library.

Member Self Weight
If you add a self weight case, you can specify whether or not a
member's weight is to be included in the Self Weight by using the
Member Self Weight command from the Load menu.

To specify whether a member's weight should be included in self
weight

• Select the member(s) to be changed in the Load window

• Choose Member Self Weight from the Load menu

• Click the Ignore or Include radio button as appropriate

• Click OK

The Member Self Weight command only affects the self weight for
static analysis.  If you are doing a dynamic analysis in 4D, the
member's weight will always be included in the mass matrix of the
dynamic analysis.

A self weight load case can be combined with other load cases in the
usual way.  The numerical values of the self weight loads are not
displayed in the Data window.  These values will be updated just
prior to analysis to ensure that the weight for any members you have
changed are included correctly.

Self Weight Loads
The loads for self weight are included in two ways.  Members which
are vertical are loaded with an axially distributed load, Wz', acting in
the vertical direction, from joint 2 to joint 1.  You will see values for
this load in printouts or in factored load cases, which are made up
from a self weight load case.  Members, which are not vertical, are
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loaded with a vertical distributed load scaled to take into account the
horizontal projected length of the member (see Global Distributed
Load above).  Because global distributed loads are applied in units of
force/horizontal length, the magnitude of the distributed load must
be scaled to take into account.

For example, a 10ft long member weighing 100 pounds with a
horizontal projected length of 1 foot would require a distributed load
of 100lb/ft to apply the correct self weight.  The same 10 foot long
member with projected length of 5 feet would only require a
distributed load of 20lb/ft to correctly apply the self weight.  For this
reason, if you have members, which are very nearly vertical and
therefore have a very small projected length, you will see very high
values for the distributed load applied due to self weight.

Multiple Load
Cases

You can apply up to fifty load cases to a structure at a time.  You
may define some of these load cases to be factored combinations of
existing load cases.  If you make a change to a load case, which is
used by other load cases, the factored load cases will automatically
be updated to reflect the change.  You can automatically construct a
load case, which includes the self weight of the structure as outlined
in the previous section.

Initially, one load case is defined titled 'Load Case 1'.  You can edit
one load case at one time. The current load case is indicated by a
check mark on the appropriate item in the lower part of the Case
menu and is shown in the lower left hand corner of the Load
window and the Plot windows when two dimensional views are
displayed.  If the load case is a factored combination of other cases, it
will have (Combined) displayed after the name of the case in the
Load window.  You cannot edit or remove loads from a factored load
case.  If you change loads in a load case, which is used by a
combined load case, the combined case will be automatically
updated.

Factored load cases are identified in the Case menu by being
underlined.

Note that a factored load case can be a factored combination of a
factored load case, but cannot include a factored combination of a
load case higher in the load case list.  For example, load case 3 can
include combinations of load cases 1 and 2 but could not include
load case 4.
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Adding a Load
Case

To add a new load case

• Choose Add Case from the Case menu

• Select what type of load case you wish to add from the Add Case
sub-menu

• Type in a name for the load case (or leave the default name if you
wish)

• If you wish to create a factored load case (Combined Load Case)
select Static Combined from the Add Surface sub-menu

• Enter the load factors for the existing load cases

• Click on the OK button

The name you give to the load case must not contain any of the
following characters; ^ ! < / (

If you turn on the "Duplicate current load case" check box, the new
load case will initially contain the loads in the current load case. This
is useful if you have two load cases, which are very similar, and one
can be made from a small variation on the other.

Editing a Load
Case

To change the name or load factors of a load case

• Choose Edit Case from the Case menu

If the current load case is a factored load case, the following dialog
box will appear.

If the current load case is not a factored load case, the following
dialog box will appear.

• Type in a new name for the load case if required
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• If the current load case is a factored case then type in the new
load factors if desired

• Click on the OK button

The name you give to the load case must not contain any of the
following characters ; ^ ! < / (.

If you use the Edit Case command to change the name of a load case
after analysis, your results will not be lost if you only change the
name and not any load factors.

Editing Load
Cases Numerically

You can edit the names and factors of load cases numerically in the
Load Case table, which may be displayed in the Data window. This
table displays load case names and load case factors.

To change a load case name or factor

• Click on the value to be changed

• Type in the new value

• Press the enter key

Deleting a Load
Case

You can remove a load case from the structure.  This will remove the
case and all its loads.  To delete a load case

• Choose Delete Case from the Case menu

A dialog box will appear with the current load cases in a list

• Select the load case you wish to remove

• Click the Delete button

You select a load case in the list by clicking on its name.  If you wish
to remove more than one load case, hold down the shift key while
clicking on the names.  Holding down the shift key while clicking in
the list adds the name to the selection or removes it if it is already
selected.

Load Library
Multiframe4D includes a Load Library, which contains commonly
used dynamic loads. These loads may be spectra from earthquake
measurements (several common earthquakes are provided) and may
also be dynamically varying forces or accelerations which can be
applied at joints in the structure.
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When Multiframe4D starts up it will now look for a file called "Load
Library" or "Load Library.llb" in the same way that Multiframe looks
for "Sections Library", first looking in the same directory as
Multiframe4D, then looking on the current volume.  Then if the Load
Library is not found, Multiframe4D will prompt you for the current
load library.

The Load Library shipping with Multiframe4D contains 9
earthquake spectra taken from 3 well known earthquakes. This
includes accelerations in 3 orthogonal directions for each earthquake.
The earthquakes are El Centro, Kobe and Osaka.

Editing the Load
Library

All dynamic loads are stored in the Load Library as either a force
series or acceleration series. You can add, edit or delete loads in the
Load Library.

• Choose Edit Load Library... from the Edit menu

The Load Library dialog will appear which displays the load and
acceleration series currently stored in the library.

The list at the top left of the dialog lists all of the series stored in the
Load Library. The name of the currently selected series is displayed
below the list and may be edited there.

Each series has a number of attributes including start velocity and
displacement, number of points and type of series (either force or
acceleration).

To add a new series to the library

 • Click the Add button

 • Type in a new name for the series

Enter the attributes of the series and type the values for the series
data in the table at the right hand side of the dialog. You can also
copy and paste data into the table by selecting the cells to be pasted
and using Paste in the Edit menu.
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Remember that the final time value must be greater than any analysis
time.  Otherwise, the loading would be undefined.  For a set load, the
time could be any large number, as the load value does not vary.

Importing Load
Data

You can import load data from a text file to the load library in
addition to entering it by hand. To import load data

 • Choose Import... from the File menu

A dialog will appear allowing you to choose the format of the data in
the text file.

If you select Variable Time, the data should be in tab delimited
format with two values per data point, the first value being the time
in seconds and the second value being the load value (force or
acceleration as appropriate).

If you select Fixed Time Interval, the data should be in tab delimited
format with one force or acceleration value per data point.

Adding Dynamic
Load Cases

There are a number of different load cases, which can be added in
Multiframe. These include a self weight static load case, a normal
static load case, a factored combination of static load cases, a
dynamic load case which can contain dynamically varying forces at
one or more joints, and a seismic case which applies up to three
orthogonal ground accelerations to any restrained joints.

To create a Dynamic Load Case

 • Select Dynamic... from the Add Load Case sub-menu

A dialog will appear allowing you to enter the name, number and
duration of the time steps for this load case along with other relevant
information.
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Applying Dynamic
Loads

To add a dynamic load to the current dynamic load case

• Go to the Load window

• Select the joints to which you want to add the load

• Choose Dynamic Load from the Load menu

A dialog will appear allowing you to specify the direction of the
load, a factor which will be multiplied by the values in the load
series, and a pop-up to select the load series from the library.

Note that only force series may be applied to joints in a dynamic load
case.

• Enter a load factor, if any

• Select the series you want to add and the global direction in
which it is to act

Viewing Applied
Time History
Loads

To view the loads applied above while still in the current Time
History load case

• Choose Step Loads from the Data sub-menu under Display
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Adding Seismic
Load Cases

In addition to creating dynamic load cases, which allow you to apply
dynamically-varying forces to the structure, Multiframe4D allows
you to create load cases, which apply dynamically changing ground
accelerations.  The most common use for this is applying an
earthquake spectrum to a frame, but it may also be used for any
other ground-based acceleration.  Analysis is carried out by applying
the specified acceleration to all of the restrained joints in the
structure. The assumption is that all restrained joints move with the
ground acceleration. The results of the analysis are displayed relative
to the ground position at each point in time.  This means that the
restrained joints all show zero deflection and the deflections of the
frame are relative to the global axes as usual.

To create a Seismic Load Case

• Select Seismic from the Add Load Case sub-menu under the Case
menu

A dialog will appear allowing you to enter the name and number
and duration of time steps, acceleration series to be applied, and the
direction of the acceleration.

• Enter the name of the load case

• Enter the number of time steps to perform

• Enter the duration of each time step

Multiframe will display the total duration of the analysis below these
values.

• Select the orientation of the axes along which the ground
acceleration will be applied



Chapter Two Using Multiframe

The normal convention for these axes is to label them North, East
and Up for the three directions. You can specify the orientation of the
North axis relative to the global x axis by entering an angle (counter-
clockwise about the y axis) in degrees from the x axis. You can also
reverse the direction of any of the load axes by choosing the
appropriate radio button beside the axis name.  The drawing in the
bottom right hand corner of the dialog will display your selection.

Finally, you can choose which acceleration series from the Load
Library will be applied to which axes by choosing the appropriate
names from the pop-up menus.

Choosing the Time
Step

The time step you choose for a time history analysis (∆t) has the
effect of including or excluding the effects of natural frequencies
modes in response of the structure.  As ∆t increases more modes are
effectively excluded from the response behavior as the time step. As
a general rule if T is the period of the highest numbered mode that is
to be included in the response calculation you should choose ∆t such
that

  
∆t

T
< 0.1

Rayleigh Damping
Factors

When adding either a dynamic or seismic case the user can specify if
proportional damping is to be used in the analysis.  To do so you
need to specify non-zero values for the Rayleigh damping

coefficients1 Alpha and Beta.

Proportional damping assumes that the damping matrix is
proportional to the mass and stiffness matrices M and K respectively.

C = αM +βK
To calculate these values you need to look at the first two modes and
the corresponding critical damping values required at those modes.
Then using the equations

α + βω1
2

= 2ω1ξ1

α + βω 2
2

= 2ω 2ξ2

where ω1 and ω 2 are the approximate first and second natural frequencies of the frame

and ξ1 and ξ2 are the critical damping values corresponding to these frequencies.

Combing the equations gives

                                                     
1 If the user is uncertain as to how to find the appropriate value for Alpha and Beta please
refer to texts on the subject.
Finite Element Procedures in Engineering Analysis  Bathe, Klaus-Jürgen ©  1982 by Prentice
Hall Inc.  ( pages 528-531)  is a good reference.
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α =
2(ω 2

2ω1ξ1 − ω1
2ω2ξ2 )

ω 2
2 −ω1

2

β =
2(ω 2ξ2 − ω1ξ1)

ω 2
2 − ω1

2
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Performing Analysis
When you have finished setting up your structure and its restraints
and loading, you use the Analyse command from the Case menu to
carry out the analysis of the structure. While analysis is in progress, a
progress bar will also be displayed.

Multiframe will check the structure prior to analysis and alert you if
there are any problems.  You must have specified the section type for
all of the members.  If you have missed any members, Multiframe
will alert you with a dialog and will select all of the undefined
members in the Frame window.  You will also be alerted if there are
any mechanisms or there are unrestrained degrees of freedom.  In
each case the offending part of the structure will be selected in the
Frame window.

In Multiframe4D you can carry out a modal analysis of a structure
and calculate up to the first 20 natural frequencies and mode shapes.
The method used is 'sub-space iteration' and mode shapes are
generated from the lowest natural frequency upwards.

•  Choose Analyse from the Case menu

You are given the choice of performing a static analysis, a dynamic
analysis, a time history analysis, or a combination of these three.  If
dynamic or time history analysis is chosen, then the user is able to
modify three values required by the analysis.  The three user input
values are

1. No of Modes  which is the number of natural frequencies and
mode shapes required.  This number must be between 1 and 20.

2. Convergence , which is the minimum value, required for the
'Convergence Error'. When the convergence error falls below the
‘Convergence’ the solution has completed successfully.  The
convergence error is calculated at the end of each iteration.  The
convergence error is defined as

Convergence Error =
ω

i, k + 1

2 −ω
i, k

2

ω
i,k

2

 

 

 
 

 

 

 
 

2

i = 1

Max Modes

∑

where  ω
i,k

= Natural Frequency i after iteration k.
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Typically values for the convergence error from 1.0e-3 to 1.0e-6 will
give adequate results.

3. Max Iterationsis the number of iterations carried out before the
analysis fails.  The number must be greater than 0.

Note that if you are unsure of what values to choose, leave the
current default values, which are suitable for most analyses.

Mass Matrix Type
The buttons Lumped and Distributed allow the user to decide on
whether to use a distributed or lumped mass matrix when doing the
modal analysis.  Both matrices are valid so the choice is left up to the
user.  If you are short of memory the lumped mass matrix uses far
less memory for storage.  This is because the matrix is de-coupled
and thus only the diagonal needs to be stored.  In general, a lumped
mass matrix will give slightly lower natural frequency values than an
analysis using the distributed mass matrix.

2D/3D Analysis
Two more buttons appear at the bottom right of the dialog.  These
are 2D Analysis and 3D Analysis.

For most structures, the 2D Analysis button will be inactive and thus
grayed out.  The user will only be able to choose a 2D Analysis if
either the structure and all loads including joint displacements are
entirely in the x-y plane, or the structure is entirely in the x-y plane
and only Dynamic or Seismic analysis is chosen.

The advantages of analysing in 2D include decreased analysis time
combined with decreased memory requirements, and the ability to
study only the in plane natural modes when using dynamic analysis.

Dynamic Analysis
Once you have defined your dynamic loads or accelerations, you can
perform a Time History analysis to compute the response of the
structure at each of the time steps you have specified.

To perform a Time History Analysis

•  Choose Analyse from the Case menu

The Analyse dialog contains three options for the type of analysis
you wish to perform.  You can choose any of static, modal or time
history analysis. If performing a modal analysis, you should enter
the number of modes.  The choice of mass matrix applies to both
modal and time history analysis.

Precision and Memory
Requirements

The solver will automatically switch from double precision to single
precision arithmetic if there is not enough memory.  Single precision
arithmetic is less precise than double (it has about 7 digits of
precision as opposed to 15 digits for double), but has the advantage
of requiring less storage space for the stiffness matrix.  This allows
you to solve larger problems or have more load cases for the same
amount of memory.  The only problem, which can arise from the use
of single precision arithmetic, is that if the stiffness matrix is badly
conditioned, round-off errors may accumulate during analysis and
may make results less accurate.  Multiframe will warn you if it
switches to single precision and give you the option of analysing
using single precision or canceling the analysis.
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Macintosh users: If you are using Multiframe under System 7.0 or
later and you have virtual memory turned on, Multiframe will use
the virtual memory if necessary to store the stiffness matrix used for
analysis.

The solver also includes some additional error checking routines to
detect problems with the structure.  If you have drawn any members,
which are not connected, to the rest of the structure, Multiframe will
alert you to this fact.  The section properties of all the sections will
also be checked to ensure that they are non-zero where appropriate.

Canceling
A progress indicator is displayed while analysis is in progress.  To
cancel analysis

•  Hit the escape key on Windows

•  Type command-period on Macintosh

The cursor will change to a watch and analysis will be terminated.

You can switch from Multiframe to another program while analysis
is in progress.
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Viewing Results
Multiframe carries out a stiffness matrix analysis to determine the
forces and displacements in the structure.  The forces computed are
Bending Moment, Shear Force, Torque and Axial Force. The
displacements computed are the displacements and rotations of the
joints and the displacement along the members as they deflect.
These results can be viewed in numerical form in the Result window
or in graphical form in the Plot window.

Result Window
Tables of numerical results may be viewed in the Result window.
Click in the Result window to bring it to the front or choose Result
from the Window menu if the window is not visible.  If the structure
has not been analysed since you made changes to it, no numbers will
be displayed in the window.

There are five tables of results, which can be displayed in the Result
window. These are a table of joint displacements, a table of joint
reactions, a table of member actions or end forces, a table of member
details and a table of dynamic results.  Only one of these tables can
be displayed at a time.  The results can be viewed from the Results
sub-menu under the Display menu to control which table is on
display at any time.  The current table is indicated with a check mark
beside the appropriate menu item. On Windows you can also use the
tabs at the bottom of the window.

The results for one load case at time can be viewed in the Result
window.  You can control which load case is currently on display by
using the load case items at the bottom of the Case menu.  The
current load case is indicated with a check mark to the left of its
name in the menu.

You may find the Result Layout command from the Window menu
useful when viewing your results.  This command arranges the Plot,
Load and Result windows on the screen so that you can easily view
graphical and numerical information at the same time.  Remember
that the Symbol… command under the View Menu will allow you to
display the joint and/or member numbers on the graphics in the Plot
and Load windows.  This will allow you to refer to the text and
graphics more conveniently.

In all of the tables drawn in the Result window, you can resize the
columns by dragging the lines which separate the column titles. You
can also change the text font and size used in the table by using the
Font… command from the View Menu.  Using the Numbers…
command from the Format window can control the format of the
numbers displayed in the table.

On Windows you can Right-Click on any column heading to sort or
hide that column. Select and range of headings and use Right-Click
to show hidden columns.

You can copy data from the Result window to the clipboard for use
with other applications.  To copy a single number from the table,

•  Click on the number to be copied

•  Choose Copy from the Edit menu

To copy a column from the table



Chapter Two Using Multiframe

•  Click on the title of the column to select it

•  Choose Copy from the Edit menu

In a similar way you can select a row by clicking on the row number
at the left hand end of the row or you can select the whole table by
clicking in the box at the top left corner of the table.

Joint
Displacements

To display the joint displacements

• Choose Joint Displacements from the Results sub-menu under
the Display menu

The table of joint displacements displays the number of each joint at
the left of each row and the deflections and rotations in the direction
of each global axis appear in the six columns.  The units for each
variable are shown underneath the title of the column in the table.

Joint Reactions
To display the joint reactions

• Choose Joint Reactions from the Results sub-menu under the
Display menu

The table of joint reactions displays the number of each joint at the
left of each row and the reactions in the direction of each global axis
appear in the six columns.  The units for each variable are shown
underneath the title of the column in the table.

Member Actions
To display the member actions

• Choose Member Actions from the Results sub-menu under the
Display menu
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The table of member actions displays the number of each member
and the joints in the first two columns and the six end forces in each
of the six remaining columns.

The member actions displayed in the Result window are shown in
the diagram below.  The actions at joint 2 follow the same sign
convention as the actions at joint 1.  Moments follow the right hand
rule i.e. if the thumb on your right hand points in the direction of the
positive axis, the direction of curl of your fingers will indicate the
direction of positive moment.

Member Details
To display a detailed table of member actions for the member
currently selected in the Plot Window

• Click on a member in the Plot window to display its local
diagrams

• Choose Member Details from the Result sub-menu under the
Display menu

This table gives member actions at a number of points along a
member.  The table is displayed for the current member you have
clicked on in the Plot window.  The signs of the values displayed
correspond with the diagram of the member and is controlled using
the Preferences item (see Plot Window, Sign Convention below).

The member actions and deflections are initially displayed at a
number of evenly spaced locations.  You can vary both the number
of points and the position of each point.
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To specify how many points the details will be displayed at

• Choose Preferences from the Edit menu

• Type in the number of points you want to display detailed
information

• Click the OK button

The number of locations must be between 2 and 64.

You can also change the location of any intermediate point by
clicking in the first or second column and typing in a new distance or
a proportional distance respectively.  The first column in the table
displays the distance of the point from joint 1 of the member as a
proportion of the length of the member.  For example, a value of
0.333 indicates the point is approximately one third of the distance
along the member.  The second column in the table shows the actual
distance of the point from joint 1.

To change the position of a point as a proportion of the member's
length

• Click on the number in the first column of the point's row

• Type in a new proportion of the distance

• Press the Enter key

The row's values will be re-calculated and re-displayed to show the
values at the new location.

To change the distance of a point from the left hand end of the
member

• Click on the number in the second column of the point's row

• Type in a new distance of the point from the left hand joint

• Press the Enter key

The row's values will be re-calculated and re-displayed to show the
values at the new location.

Dynamic Results
In Multiframe4D, you can display a table showing the results of a
dynamic analysis.
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• Choose Dynamic Results from the Result sub-menu under the
Display menu

Each row shows the frequency and period for that mode shape. The
units for each variable are shown underneath the title of the column
in the table.

Time History
Results

The time history results are stored on disk in a file called
“<FileName>. Dynamics” on Macintosh or “<Filename>.mth” on
Windows.

Do not delete this file while Multiframe4D is running and the
associated frame is loaded.

To view the results for each time step in a dynamic or seismic load
case

•  Choose the step from the Time... menu

To best see the results

•  Choose Animate... from the Display menu

•  Select Steps

 
This will show you an animation including all the time steps.

When an increment in a Dynamic or Seismic load case is active you
are able to view all results exactly as for a Static load case.  In
addition, if you select a node in the Plot window you get a graph of
the behavior of the x y z degrees of freedom over the entire analysis.
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Viewing Envelope
Cases

Envelope cases are created for the Time History analysis if Calculate
Envelope Cases check box is selected in the Dynamic or Seismic case
edit dialogs.  The range of cases to envelope can also be input.

The envelope cases store the absolute maximum displacement values
in all cases along with the maximum, minimum and absolute values
for the end forces.  You can use the envelope cases to view the range
of values encompassed by a dynamic or seismic analysis.

When viewing the results in the Results data window, the title bar
will identify the current joint degree of freedom and the step
increment that the value is associated with.

Plot Window
Four different types of diagrams of forces and deflections can be
viewed in the Plot window.  These are diagrams of the whole
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structure, diagrams for an individual member, reactions at a joint
and deflections at a joint.

The results for one load case at time can be viewed in the Plot
window.  You can control which load case is currently on display by
using the load case items at the bottom of the Case menu.  The
current load case is indicated with a check mark to the left of its
name in the menu.  The name of the current load case is also
displayed at the bottom left hand corner of the Plot window except
when viewing the 3D view of the structure.

When displaying diagrams of the whole structure or an individual
member, you can use the items from the Diagram sub-menu under
the Display menu to control which variable is to be displayed at any
time.  The variable currently being displayed will be indicated with a
check mark to the left of the item in the menu and will also be shown
at the bottom of the Plot window.

You can also use the Symbols command form the Display menu to
control which symbols are displayed on the diagrams.

To turn on and off the display of symbols

• Choose Symbols from the Display menu

If you turn on the display of Plot values, the labels on the Plot
diagrams for axial force and stress diagrams will have a T & C
marked on the axes to indicate which is Tension and which is
Compression.

Structure
Diagrams

The diagrams of the whole structure can display bending moments,
shear forces, axial forces, torque or deflection.  When you have a
diagram of the whole structure drawn in the Plot window and forces
on display, the force diagram for each member will be superimposed
on the member.  With deflections on display, a diagram of the
exaggerated deflection of the whole structure will be drawn.  If you
have performed a dynamic analysis and you are currently viewing a
dynamic case, the deflected shape will represent the mode shape for
that case.  For all diagrams, Multiframe will choose a scale which
best suits the size of your structure and the magnitude of the forces
and displacements.  All load cases are drawn to the same scale.

You can exaggerate the scale of a diagram

•  Choose Plot… from the Display menu
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The Zoom, Shrink, Pan and Size To Fit commands can be used in the
Plot window to change your view of the structure.  The rotation bars
can also be used to change the view point in the 3D view.

The six force diagrams, which can be displayed in the Plot window,
are

Mz' bending moments about the local z' axis of the members (in
plane bending)

x'

y'

z' Mz'

My' bending moments about the local y' axis of the members (out
of plane bending)

x'

y'

z'

My'

Vy' shear force through the local y' axis of the members (in plane
shear)

x'

y'

z'

Vy'

Vz' shear force through the local z' axis of the members (out of
plane shear)

x'

y'

z'

Vz'

Px' axial force along the local x' axis of the members (tension or
compression)
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x'

y'

z'

Px'

Tx' twist or torque about the local x' axis of the members

x'

y'

z'

Tx'

To choose which diagrams are displayed in the Plot window

• Choose Customise Plot…  from the Display menu

A dialog will appear listing the menu items controlling the plot
display and the actions, stresses and deflections which can be
displayed.

• Click on the name of the menu item you wish to change

• Click on the Member button

• Set the check boxes of the actions you wish to display in the local
member diagrams

• Click on the Structure button

• Set the check boxes of the actions you wish to display on the
diagram of the whole structure

• Click the OK button

You can control the values associated with the colors used when
overlaying an action onto the structure deflection diagram.  These
colors and values are controlled using the Plot command under the
Display menu.

To change the value associated with the overlaid colors
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• Choose Plot… from the Display menu

• Type Tab to move to the field containing the maximum threshold
value

• Type in a new maximum threshold value to be used with red to
indicate the highest actions or stresses

• Click the OK button

Every part of the structure with an action value greater than or equal
to the value you specified will be colored red.  Other parts of the
structure will be colored in an even gradient down to blue for those
parts of the frame with an action of zero.

Stresses
You can display stresses as well as forces and deflections in the Plot
window.  Which data to display is controlled by two hierarchical
menus and the deflection item under the Display menu.

To display a force diagram

• Choose the desired item from Actions sub-menu under the
Display menu

To display a stress diagram

• Choose the desired item from Stress sub-menu under the
Display menu

To display deflections

• Choose the Deflection item from the Display menu

You can choose to display a number of diagrams simultaneously in
the Plot window.  This applies to both structure and member
diagrams.

Member Diagrams
The diagrams of individual members can also display bending
moments, shear forces, axial forces, torque or deflections.  To obtain
a diagram for an individual member

• Click on the member you wish to view in detail
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The local diagram for that member will then be drawn in the Plot
window.

The maximum and minimum values on the diagram are displayed
below the graph, and below these two numbers indicate the value of
the diagram at the position of the gray crosshair and the distance of
that crosshair from the left hand end of the member.

You can drag the crosshair up and down the length of the member to
determine the value of the diagram at any position.  The crosshair
will remain in the position where you release the mouse button after
dragging.

Click on the drawing at the bottom right of the window to return to a
diagram of the whole structure.

Joint Reactions
The diagram of a joint's reactions shows the direction and
magnitudes of the reactions at the joint.  Joint reactions are displayed
relative to the global coordinate system.

To display the reactions for a joint

• Ensure the moments, shear, torque or axial forces are on display

• Click on the original position of the joint in the structure
diagram

The original position is marked by the point where the gray lines of
the members connecting at the joint meet.  The diagram of the
structure will be replaced by a diagram of the joint reactions.

Click on the drawing at the bottom right of the window to return to a
diagram of the whole structure.

Joint
Displacements

The diagram of a joint's displacements indicates the vertical,
horizontal and rotational displacements of the joint.

To display the displacements for a joint

• Choose Deflection from the Display menu

• Click on the original position of the joint in the structure
diagram
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Click on the drawing at the bottom right of the window to return to a
diagram of the whole structure.

Dynamic Results
After a dynamic analysis has completed successfully each mode is
stored as a separate load case.  The mode shapes are normalised and
stored in the same way as displacements in a static analysis.

To view the natural frequencies and mode shapes

• Choose the mode shape from the Case menu

The frequency and period are printed in the bottom left corner of the
Plot window.

To view the mode shape

• Select the Plot window

• Choose Deflection from the Display menu

There are no moments, shears or other forces associated with the
dynamic results.
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Calculations
As well as carrying out an analysis of your structure, Multiframe
allows you to prepare your own design calculations by making use
of the CalcSheet facility.  Design calculations can be prepared and
evaluated in the CalcSheet window.  The calculations may be entered
line by line, terminating each line by pressing return or enter.  The
calculations should follow the same general syntax as the Basic
programming language, however, only simple calculations are
supported. There is no support for looping or IF statements or
comparison (< ,≠ , >) operators.

If the member diagram for a member is currently displayed in the
Plot window, the section properties and results of analysis for the
member will be automatically included as variables in the CalcSheet.
These variables are listed below.

The calculations can be saved to and read from disk or printed by
choosing the appropriate items from the File menu while the
CalcSheet window is frontmost.

Calculation Sheet
The CalcSheet facility in Multiframe allows you to prepare your own
design calculations and evaluate them without leaving Multiframe.
The calculations can use any number of variables defined by you and
can also access a number of variables from within Multiframe, which
contain the results of analysis and section properties for a member.

Calculations are prepared and evaluated in the CalcSheet window.
To make the CalcSheet window visible

• Choose CalcSheet from the Window menu

Type your equations here
Result of
calculation

Comments can be
typed here

The window is divided into three columns titled Equation, Value
and Comment.  Calculations may be entered into the equation
column and when the expressions are evaluated the results will be
displayed in the Value column.  The Comment column may be used
by you for entering any information, which is relevant to the line on
which it is entered.  The Comment column is especially useful for
entering the units for the results of calculations you carry out.

Calculations are evaluated by choosing the Calculate command from
the Case menu.  The results of the calculations are displayed in the
Value column.  The value shown is the value of the expression
evaluated at each line.

You can the change the equations in the CalcSheet at any time and
then re-evaluate the expressions using the Calculate command.

Pre-defined
CalcSheet
Variables

Multiframe provides you with a number of pre-defined variables for
use within the CalcSheet.  These variables relate to a single member
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in the structure at a time. You specify which member in the structure
to use by clicking on that member in the Plot window and displaying
its member diagram.  Multiframe will automatically extract the
appropriate data from that member and store it in the variables in
the CalcSheet.

The pre-defined variables include the length, slope, moments, forces,
displacements and section properties.  Remember that these
variables are only available if there is a member diagram on display
in the Plot window.

A complete list of the variables is

Name Description
dx1 x displacement of joint 1
dy1 y displacement of joint 1
dz1 z displacement of joint 1
Øx1 rotation of joint 1 about the x axis
Øy1 rotation of joint 1 about the y axis
Øz1 rotation of joint 1 about the z axis
dx2 x displacement of joint 2
dy2 y displacement of joint 2
dz2 z displacement of joint 2
dx x' deflection at the crosshair
dy y' deflection at the crosshair
dz z' deflection at the crosshair
Øx2 rotation of joint 2 about the x axis
Øy2 rotation of joint 2 about the y axis
Øz2 rotation of joint 2 about the z axis
Mz bending moment about z' at crosshair
My bending moment about y' at crosshair
Vy shear force through y' at crosshair
Vz shear force through z' at crosshair
Px axial force at crosshair
Tx torque at crosshair
Length Length of member
Slope Slope of member
Dist distance to the crosshair
MaxMz Absolute value of the max Mz'
MaxMy Absolute value of the max My'
MaxVy Absolute value of the max Vy'
MaxVz Absolute value of the max Vz'
MaxAT Absolute value of the max axial tension
MaxAC Absolute value of the max axial compression
MaxTx Absolute value of the max torque
Maxdx Absolute value of the max x' deflection
Maxdy Absolute value of the max y' deflection
Maxdz Absolute value of the max z' deflection
Pi 3.14159

The pre-defined variables in the CalcSheet will be in the units
currently specified using the Units item from the View menu (See
Units below).

Section Properties
Variables

Multiframe will automatically extract all the section properties for
the section used for the member from the Sections Library.  These
properties will be stored in variables with the same names as the
properties in the sections library.
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To view the names of these properties

• Choose Edit Section… from the Edit menu

When you view the table of properties for a section, the name of each
property will be shown in the left hand column of the table.

For example, if you wished to compute the shear stress in the web of
a member you could enter a calculation such as

ShearStress=Vy/(D*tw)

Where Vy is the shear force variable and D and tw are the section
depth and web thickness taken from the properties for the section.

The constant Pi is also provided as a variable in the CalcSheet.

Saving
Calculations

To save the calculations you have created

• Ensure the CalcSheet window is frontmost

• Choose Save As from the File menu

You can then save the calculations file on disk.  The calculations in
Multiframe are stored independently from the structure you are
working on, so you can use the same calculations on a number of
different structures.
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Printing
Multiframe offers a number of options for controlling the output of
data or results to a printer.  Multiframe can print text, numbers and
graphics.

Page Setup
When printing data or diagrams from Multiframe, it is first necessary
to set up the page size and the print quality.  The Page Setup
command from the File menu can be used to set up the page size you
will be using in the printer.  This set up need only be done once and
all subsequent printing will use this format.

Setting up the
Printer

First, ensure that your printer is attached to your computer with an
appropriate cable and that it is switched on and has sufficient paper
loaded.  Refer to your computer's owner guide or your printer
manual if you have any problems.

• Choose Page Setup… from the File menu

A dialog box will appear which allows you to choose the paper size
and orientation, set the size of margins for printing and type in text
to appear at the head and foot of each page of paper printed.

Select the paper size you have installed in your printer.  You can also
choose to enlarge or reduce the printout and adjust the output with a
number of other options.

No matter what type of printer you have, Multiframe allows you to
enter values for header and footer titles to be printed at the top and
bottom of each page printed.  You can also set up the size of the
margins you would like around the printed output.  The two check
boxes at the lower left of the dialog allow you to switch on or off the
printing of page numbers and date and time information.  The
Autoset margins check box can be used if you want to use the
maximum amount of printable area (i.e. the minimum margin size)
that your printer will allow.

Color printing  is supported on Postscript printers, which provide
color output.

Printing Results
When printing a report summary of Multiframe data, you can restrict
the output of results to just the members selected in the frontmost
window.

To print results for a range of members

• Select the members in the frontmost window

• Choose Print from the File menu
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• Turn on the "Print selected members only" check box

• Click the OK button

Only the results for the selected members will be printed.

Page Layout
(Macintosh Only)
 The Page Layout command under the File menu allows you to
control the layout of member diagrams when printing.

To adjust the layout of diagrams on the page

• Choose Page Layout… from the File menu

A window will appear titled Page Layout

• Drag and resize the diagrams to the desired positions on the page

• Click the OK button

Drag the position of a diagram by pressing inside it and dragging to
a new location.  Resize a diagram by pressing in the bottom right
hand corner of the diagram and dragging it to its new shape.  You
should keep the diagrams inside the dotted printable area of the
page if you want them to be printed.  The printable area will vary
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depending upon the mechanical limitations of the printer you are
using. You can drag a diagram off the page to prevent it being
printed.

The layout will be stored and used by Multiframe for laying out your
force and deflection diagrams on the page when using the print
selection option.  Multiframe will repeat the layout as many times as
will fit down and across each page.

Print Command
To print a report on the structure

• Choose Print from the File menu

A printing options dialog will appear.

• Choose the data you want to print and which load cases to print

• Click the OK button

The standard print dialog will appear

• Select the print quality, number of copies and any enlargement
or reduction of the printing

• Click OK to start the printing

The printing options dialog allows you to control what data will be
printed.  If you wish to turn off the printing of some data, click on
the appropriate check boxes.  If you only wish to print some load
cases, hold down the shift key and click on the cases you don't wish
to print.

The standard printing dialog allows you to set the print quality, page
range to print, number of copies to print and the type of paper feed.
The page range, number of copies and paper feed may be set to any
appropriate setting.  To cancel printing while it is in progress, hit the
Escape key on Windows or hold down the comand key and type
period (.)  on Macintosh, or click on Cancel.

Printing Diagrams
You can print the force and deflection diagrams for any or all of the
members in a structure by using the Print Selection option available
by using the Print… command from the File menu.  First, ensure that
the Plot window is frontmost on the screen.  Then select the members
to be printed, by clicking or dragging a rectangle, in the usual way.

To print the diagrams for the selected members
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• Choose Print… from the File menu

The printing options dialog will appear.

• Click on the Selection radio button

• Select which diagrams and load cases you wish to print

• Click the OK button

The standard print dialog will appear.

• Select the print quality, number of copies and any enlargement
or reduction of the printing

• Click OK to start the printing

The printing options dialog allows you to control what data will be
printed.  If you wish to turn off the printing of some data, click on
the appropriate check boxes.  If you only wish to print some load
cases, hold down the shift key and click on the cases you do not wish
to print.  If you want to turn the printing of a load case back on, shift-
click on the load case once more.

The standard printing dialog allows you to set the print quality, page
range to print, number of copies to print and the type of paper feed.
The page range, number of copies and paper feed may be set to any
appropriate setting.  To cancel printing while it is in progress, hit the
Escape key on Windows or hold down the command key and type
period (.)  on Macintosh, or click on Cancel.
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Chapter 3
Multiframe Reference
This chapter summarises the overall structure, windows, toolbars
and menu commands of Multiframe. (The Toolbars are only
available in the Windows version of Multiframe.)



Chapter Three Multiframe Reference

Windows
Multiframe uses a range of graphical, tabular, graph and report
windows.

Frame Window
This window is used for preparing a physical description of the
structure.  This includes geometry, connections, section types, section
orientation and restraints.  You can also modify joint and member
masses for dynamic analysis.

Data Window
This window is used for viewing and editing the data describing the
structure and its loading. It allows you to edit data numerically
rather than graphically.  A number of different tables of data can be
displayed describing joints, members, joint loads, member loads,
restraints and prescribed displacements, springs, sections and load
cases.

Load Window
This window is used for setting up the loading conditions you wish
to apply to the structure.  You can also add a self weight load case
and control whether member's self weight is included in static or
dynamic analysis.

Result Window
This window is used for viewing the results of the analysis in
numerical form.  It can display tables of joint displacements and
reactions and member actions or end forces.  Results of any dynamic
analysis are also displayed here in the form of a table of frequencies
and periods of vibration.

Plot Window
This window is used for viewing diagrams of the forces and
deflections in the structure.  It allows you to view diagrams of the
whole structure, individual members, joint reactions and joint
displacements.  You also view the mode shapes for dynamic analysis
in this window.

CalcSheet Window
This window is used for preparing and evaluating design
calculations, which use the results of the analysis as a basis for
design checks.
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Toolbars
Users of the Windows version of Multiframe can use the icons on the
toolbars to speed up access to some commonly used functions. You
can hold your mouse over an icon to reveal a pop-up tip of what the
icon does.

Generate Toolbar

The Generate Toolbar is found in the Frame Window and performs
the same functions as the Generate command in the Frame menu.
From left to right, the buttons generate the following geometry:

Continuous Beam
Curved Member
Portal Frame
Multi-story Frame

Member Toolbar

The Member Toolbar is found in the Frame Window and performs
some of the functions found in the Frame menu.  From left to right,
the buttons perform the following functions:

Add Member
Delete Member
Sub-divide Member
Section Type
Pinned/Pinned Member Release
Rigid/Rigid Member Release
Member Orientation

Joint Toolbar

The Joint Toolbar is found in the Frame Window and performs some
of the functions found in the Frame menu.  From left to right, the
buttons perform the following functions:

Fixed Joint Restraint
Pinned Joint Restraint
Free Joint Restraint
Rigid Joint Type
Pinned Joint Type

View Toolbar
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The View Toolbar is found in the Frame, Load, and Plot Windows
and performs some of the functions found in the View menu.  From
left to right, the buttons perform the following functions:

Zoom
Shrink
Pan
Size To Fit
Toggle Clipping
Toggle Masking
Toggle Grid
Toggle Axes

Actions Toolbar

The Actions Toolbar is found in the Plot Window and performs some
of the functions found in the Display menu.  From left to right, the
buttons perform the following functions:

Bending Moment about the local z' axis
Shear forces in the local y' axis
Axial forces for the current load case
Display Deflection
Bending Moment about the local y' axis
Shear forces in the local z' axis
Torque about the local x' axis

Load Case Toolbar

The Load Case toolbar can be used as a shortcut for changing the
current load case. You can select a load case from the drop down list
or click the right and left arrows to go to the next or previous load
case.
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Menus
Multiframe uses the standard set of Macintosh or Windows menu
commands for File, Edit and Windows operations. It also has a range
of menus for:

File Menu
The file menu contains commands for opening and saving files,
importing and exporting data, and printing.

New
(Windows: Ctrl N / Macintosh: command N)
Erases the structure and all loads. Use this to start work on a new
structure.  If you have any work unsaved, Multiframe will prompt
you to save any changes to the structure or calculations before
starting the new work.

Open
(Windows: Ctrl O / Macintosh: command O)
Open a file, which has previously been saved on disk.  If the
CalcSheet window is frontmost, it will read in a new calculations file.
Otherwise, it will read in a frame you have previously saved to disk.

If you have any work unsaved, Multiframe will prompt you to save
any changes to the structure or calculations before opening the new
file.  Multiframe can read Multiframe, Multiframe text and DXF files.

Close
Select Close when you wish to finish with the current design. Before
closing, a dialog box will appear asking whether you wish to save
the current design. If you select Yes the current design will be saved
to the disk.

Save
(Windows: Ctrl S / Macintosh: command S)
Save work so far with the same name you saved with last time.

Save As
Save work so far in a file with a new name.  If the CalcSheet window
is frontmost, this will save the current calculations in a file.
Otherwise, it will save the structure.  You can also choose to save the
geometry of the frame in a number of different file formats.

Import
See “Import Submenu”

Export
See “Export Submenu”

Open Library
The Open Library command opens a Sections Library or Load
Library.

Page Setup
Set up the printer for printing.  Allows you to set margins, header
and footer titles and options on printing the date, time and page
numbers.
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Print Report
(Windows: Ctrl P / Macintosh: command P)
Windows users: Print out the data and results of the analysis or print
out member diagrams for the selected members in the Plot window.

Print Window
Print the contents of the frontmost window on the screen

Page Layout
(Macintosh Only)
Define your preferred layout for printing of member diagrams.  You
can drag the diagrams and resize them to get the layout you desire.

Print
(Macintosh Only)
Print out the data and results of the analysis or print out member
diagrams for the selected members in the Plot window.

Quit / Exit
(Macintosh: command Q)
(Macintosh Only: Quit)
Leave Multiframe and go back to the Finder.  If you have any work
unsaved, Multiframe will prompt you to save any changes to the
structure or calculations before quitting.

(Windows Only: Exit)
Leave Multiframe and go back to the Desktop.  If you have any work
unsaved, Multiframe will prompt you to save any changes to the
structure or calculations before quitting.

Import Submenu
(Windows Only)
Import data from another program into Multiframe.

DXF
Files can be saved in either 2D or 3D format.  This is to allow
compatibility with older CAD programs, which only accept 2D DXF.
The members in the frame are saved as LINE entities.

Multiframe will allow DXF file input from any CAD program. We
have tested with AutoCAD, MiniCAD, Microstation and Claris CAD,
and we expect input from all other systems to work also.

When reading in DXF files, Multiframe will interpret each line or
segment of a polyline as a member. Any members, which have ends
within 0.2 in (5mm) of each other, will be connected together.
Multiframe can read 2D or 3D DXF files compatible with AutoCAD
release 10 and higher.

Fortran Text
See “Appendix E”

Export Submenu
(Windows Only)
Data can be exported from Multiframe in file formats compatible
with other programs.
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2D DXF
This is to allow compatibility with older CAD programs, which only
accept 2D DXF.  The members in the frame are saved as LINE
entities.

3D DXF
You can export 3DFACE entities into a 3D DXF file.  This is useful for
input to rendering or 3D presentation or modeling programs.

To export 3DFACE entities in the DXF file:

• Ensure rendering is turned on in the frontmost window on the
screen

• Choose Save As from the File menu

• Choose 3D DXF from the File Format pop-up menu

• Type in a name for your file

• Click the Save button

If you do not have rendering turned on in the frontmost window
when you save in 3D DXF format, the lines representing the frame
will be saved as 3DLINE entities.

Spreadsheet Text
There are now two types of text output. FORTRAN style text is the
same text output as in version 1.0 and is best for input to a post-
processing program.  The new Spreadsheet text output is a summary
of maximum actions for each member in the frame and is in a format
suitable for input to a spreadsheet such as Excel or Lotus.

Day Star Text
Multiframe outputs a tabular summary of member actions in a
format suitable for input to the Day Star Text AISC steel code
checking program available from DayStar  Software Inc.,
http://www.daystarsoftware.com

The American steel library included with Multiframe uses a section
naming convention consistent with that used by DS Steel.

Edit Menu
The Edit menu contains commands for copying and pasting data and
working in tables.

Undo
(Windows: Ctrl Z / Macintosh: command Z)
Undo the last action you carried out.  The name of this item will
change to reflect the command that can be undone.
Windows users: If your frame as less than 500 members you can
undo up to 10 steps.

Redo
(Windows: Ctrl Y)
(Windows Only)
Return to the last action you carried out before selecting Undo from
the Edit menu.

Cut
(Windows: Ctrl X / Macintosh: command X)
Remove the current selection and place it on the clipboard.
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Copy
(Windows: Ctrl C / Macintosh: command C)
In the Data, Result or Graphics window, this command copies the
current selection to the Clipboard

If you hold down the Shift key on Windows, or the Option Key on
Macintosh in the Data or Result window while choosing the Copy
command from the Edit menu, the column titles will be included in
the text placed on the clipboard.

If you hold down the Shift key on Windows, or the Option Key on
Macintosh in a graphics window while choosing the Copy command
from the Edit menu, you will be presented with a dialog offering
options to copy to a Pict, DXF, Renderman, or Postscript File.

Paste
(Windows: Ctrl V / Macintosh: command V)
Paste the contents of the clipboard into the current selection.

Clear
Remove the current selection without placing it on the clipboard.

Show/Hide Clipboard
(Macintosh Only)
Make the clipboard visible/invisible.

Select
See “Select Submenu”

Find
(Windows Only)
Allows you to search through the structure to find members with
actions, deflections or stresses in excess of limits you may enter. For
example, you could find and select all of the members with a tensile
stress greater than 21ksi.

Add Section
Store the data for a custom section type in the member properties
file.

Edit Section
Edit the data for a custom section type in the member properties file.

Delete Section
Delete the data for a custom section type from the member
properties file.

Section Colors
Allows you to set the colors to be used for display of section types in
the Frame window.

Change Section
Library

(Macintosh Only)
Open a new Section Library.

Edit Load Library
Allows you to view, edit and add data in the load library.
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Preferences
Allows you to set how moment diagrams are drawn and what type
of moment symbols to use.  There is also an option to use perspective
when displaying graphics in the 3D views.  You may find this useful
for presentation purposes.  However, you will usually find it more
convenient to work with the standard orthographic projection.  If
you do turn on the perspective option, it uses a perspective angle of
30° corresponding to the natural perspective of the human eye.

You can control the font and size of text used when printing by using
the pop-up menu options in the Preferences dialog.

The sign convention for axial forces and stresses can be controlled
using the Preferences item.  You can choose to either display tension
or compression as positive when drawing member diagrams.

Stresses are also displayed according to the sign convention you
choose. This ensures that the signs of stresses caused by bending
correspond with the signs of stresses caused by axial actions.

Properties
(Windows Only)
Shows details about the joint or element selected.

Select Submenu
The Select menu has commands for automatically selecting parts of
the structure.

All
Automatically selects all the members in the frame.

Horizontal
Automatically selects all the horizontal members (beams) in the
frame.

Vertical
Automatically selects all the vertical members (columns) in the
frame.

Sloping
Automatically selects all the members in the frame, which are neither
vertical nor horizontal.

Section
Allows you to select all the members in the Frame window which
have a given section type.  You can choose the section type to be
selected from a list of sections in the Sections Library.

Member
Allows you to select a member by number.

Joint
Allows you to select a joint by number.

Member Label
(Windows Only)
Selecting a member using the member label.
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View Menu
The View menu contains commands for controlling the appearance
of the display in the graphical window.

Zoom
(Windows: Ctrl W / Macintosh: command W)
Zoom in on part of the current display.  A cross-hair will appear and
the view to be viewed in close-up may be selected by pressing the
mouse button and dragging a rectangle surrounding the area of
interest.  Release the button to draw the zoomed view.

Pan
(Windows: Ctrl E / Macintosh: command R)
Pan across the structure displayed in the frontmost window.  Press
and drag in the window to move the frame.

Shrink
(Windows: Ctrl R / Macintosh: command E)
Reduce the size of the drawing in the frontmost window to half its
current size.

Size To Fit
(Windows: Ctrl T / Macintosh: command T)
Scale the drawing in the frontmost window so that it just fits inside
the window. The Size To Fit menu is a sub menu of the View menu,
and is described in detail following this section on the View menu.

Clipping
See “ Clipping Submenu”

Masking
See “Masking Submenu”

Depth
Set the depth that drawing will occur in the two dimensional views
(not available in 2D).

Size
Set the maximum and minimum coordinates available in the Frame
window.  Use this to set up the overall coordinates before you begin
creating a structure.

Grid
Switch on or off the use of the grid in the Frame window and set the
spacing of the grid.

Axes
Turn on or off the display of axes in the frontmost window.

Font
Set the font size and style for the text in the frontmost window.

Numbers
Set the type of numeric format you would like to use to display
numbers in the frontmost window. You can choose to use decimal or
scientific notation and specify how many digits of precision you wish
to display.
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Units
Multiframe allows you to work in a range of units.  Related sets of
units are conveniently grouped together under a country name.  You
can switch from one country setting to another and/or change the
units used for any particular item.

To change the units used for display

• Choose Units… from the View menu

• Click on the name of the set of units you wish to use or change

• Use the pop-up menus beside each type of unit to set its units
type

• Click the OK button

The units you choose will be saved with the Multiframe application
for subsequent use.

Color
Specify which colors to use for the various diagrams, for the
background of the window, for the clipped or masked members and
for the rendering of the structure.

Status Bar
(Windows Only)
Makes the Status Bar visible or invisible.

Toolbar
(Windows Only)
See “Toolbar Submenu”

Size To Fit
Submenu

 The Size To Fit submenu commands allow you to change the view
factor to fit the frame to the current window.

Frame
Fits the entire frame to the window.

Selection
Fit the selection to the window.
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Clipping
Fit the active clipping region to the window.

Clipping Submenu
The Clipping submenu commands allow you to control the display
and positioning of the clipping bars.  Clipping allows you to define
how much of the structure is visible at one time.

No Clipping
Turns off clipping if it is on. This hides the clipping bars and makes
all members in the frame visible.

Clip Gray
Turns on clipping and makes the clipping mode gray.  This means all
members, which do not lie completely within the boundaries of the
clipping bars, will be drawn in gray.

Clip Invisible
Turns on clipping and makes the clipping mode invisible.  This
means all members, which do not lie completely within the
boundaries of the clipping bars, will be made invisible.

Clip To Frame
Turns on clipping if it wasn't already on and positions the clipping
bars just outside the outermost limits of the frame in each direction.
This means all members will be visible.

Clip To Window
Turns on clipping if it wasn't already on and positions the four
clipping bars which are visible in the current view so that they lie
just inside the boundaries of the window.

Clip To Selection
Turns on clipping if it wasn't already on and positions the clipping
bars so that they lie just outside the maximum extents of the selected
members in the window.

Masking Submenu
The Masking submenu commands are used to control the display of
member in the frame. Masking allows you to define, which members
are visible and which are invisible.

No Masking
Turns off masking if it is on. This makes all members in the frame
visible.

Mask Gray
Turns on masking and makes the masking mode gray. This means all
members, which have been masked out, will be drawn in gray.

Mask Invisible
Turns on masking and makes the masking mode invisible. This
means all members, which have been masked out, will be made
invisible.

Mask To Frame
Turns on masking if it wasn't already on and makes all of the
members in the frame visible.
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Mask To Window
Turns on masking if it wasn't already on and makes all the members,
which lie completely inside the boundaries of the window visible.

Mask To Selection
Turns on masking and masks out all the members in the frame,
which are not selected.  This means the only members in the frame
which will be visible are those which were selected.

Mask Out Selection
Turns on masking and masks out all the members in the frame,
which are selected.  This has the effect of hiding the selected
members and leaving all remaining visible members visible.

Toolbar Submenu
(Windows Only)
The Toolbar submenu commands allow you to make selected
toolbars visible or invisible.

File Toolbar
Makes the File toolbar visible or invisible. The File toolbar contains
common file functions.

View Toolbar
Makes the View toolbar visible or invisible. The View Toolbar
provides common view functions such as Zoom and Pan.

Generate Toolbar
Makes the Generate toolbar visible or invisible in the Frame
Window.  The Generate Toolbar allows you generate frames.

Joint Toolbar
Makes the Joint toolbar visible or invisible in the Frame Window.
The Joint Toolbar allows you restrain joints.

Member Toolbar
Makes the Member toolbar visible or invisible in the Frame Window.
The Member Toolbar allows you perform functions such as Add
Member, Delete Member, and Sub-divide Member.

Actions Toolbar
Makes the Actions toolbar visible or invisible in the Plot Window.
The Actions Toolbar allows you to view results of an analysis such as
the Mz' and Deflection.

Load Case Toolbar
Makes the Load Case toolbar visible or invisible. The Loadcase
toolbar provides a simple way to transverse the different loadcases.

Load Toolbar
Makes the Load Toolbar toolbar visible or invisible. The Load
Toolbar provides common loading options.

Frame Menu
The Frame menu provides functions for creating and editing the
frame.

Add Member
(Windows: Ctrl A / Macintosh: command A)
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Add a member to the structure in the Frame window.  Press the
mouse button to position the first joint of the member and drag to the
position of the second joint and release the button.  Windows users
have the option of just clicking on the first joint, then clicking on the
second joint position to draw a member.

Delete Member
(Windows: Ctrl B)
Delete the selected members in the Frame window from the
structure.

Subdivide Member
(Macintosh: command B)
Divide all selected members in the Frame window into a number of
equally sized smaller members.

Joint Restraint
Restrain all the joints selected in the Frame window.  A dialog box
will appear allowing you to specify which type of restraint to apply.

Joint Mass
Additional mass added to a structure to add inertia for dynamic
analysis.

Joint Spring
Prescribe a spring at all the joints selected in the Frame window.  A
dialog box will appear which allows you to specify the direction and
stiffness of the spring.

Joint Displacement
Prescribe a displacement at all the joints selected in the Frame
window.  A dialog box will appear which allows you to specify the
direction and magnitude of the displacement.

Joint Type
Set the selected joint type as rigid or pinned.  Rigid joints transmit
moment and pinned joints do not.

Joint Linking
Links a group of joints together so that they move together in
response to static or dynamic loads.

Section Type
Set the section type for all the members selected in the Frame
window.  A dialog box will appear which allows you to choose the
section to use for the members selected.

Member Type
Allows you to choose whether a member is standard, tension only or
compression only.

Member Releases
(Windows Only)
Set the type of the selected members in the Frame window -
members can be fixed or pinned at either or both ends.

Member Shear Area
Allows you to turn on or off the use of the optional calculation of
deflection due to shear deformation.
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Member Orientation
Set the orientation of the section for all the members selected in the
Frame window.  A dialog box will appear which allows you to rotate
the section to the desired orientation.

Member Masses
Specify whether the mass of the selected members should be
included when a dynamic analysis is performed.  This does not affect
the inclusion of a member's weight when a static analysis is carried
out using self weight.  That is controlled by the Member Self Weight
item from the Load menu.

Member Labels
(Windows Only)
Allows you to edit the user defined label associated with each
member.

Duplicate
(Windows: Ctrl D / Macintosh: command D)
Duplicates all the selected members in the frame a given number of
times in a specified direction.  A dialog allows you to enter the
spacing in each direction and whether the duplicated members
should be connected to the existing frame.

Rotate
Rotates all the selected joints in the frame a specified number of
degrees about a specified axis.  A dialog allows you to enter the
number of degrees and the center of rotation.

Rescale
Multiplies the coordinates of all the selected joints in the frame by a
specified scaling factor.  This has the effect of rescaling the structure
by the specified amount.

Extrude
Creates new members from all the selected joints in the frame in a
specified direction.  Usually used to generate columns from a drawn
floor plan or to generate beams out from an existing column line.

Move
(Windows: Ctrl M / Macintosh: command M)
Allows you to either move the selected joints in the frame a specified
distance or to move the origin to a new location.

Generate
Allows you to automatically generate a continuous beam, portal
frame, bay and story frame or curved beam.

Renumber
Allows you to automatically renumber the joints and/or members in
the structure.  This is convenient for sorting joint and member
numbers by direction after you have been making modifications to
the frame's geometry.

Load Menu
All commands available in the Load menu act on the current load
case.

Unload Joint
Remove all loads from the selected joints in the Load window.
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Joint Load
Add a point load to each of the selected joints in the Load window.
A dialog box will appear allowing you to specify a direction and
magnitude for the load.

Joint Moment
Add a point moment to each of the selected joints in the Load
window.  A dialog box will appear allowing you to specify a
direction and magnitude for the moment.

Unload Member
Remove all loads from the selected members in the Load window.

Global Dist'd Load
Add a distributed load to each of the selected members in the Load
window.  A dialog box will appear which allows you to specify the
magnitude, direction and position of the load.  A global distributed
load acts parallel to one of the global x, y or z axes.

Global Point Load
Add a point loads to each of the selected members in the Load
window.  A dialog box will appear which allows you to specify the
magnitude, direction and position of the load.  A global point load
acts parallel to one of the global x, y or z axes.

Global Moment
Add a point moment to each of the selected members in the Load
window. A dialog box will appear which allows you to specify the
magnitude, direction and position of the load for the members
selected.  A global moment acts about one of the global x, y or z axes.

Local Dist'd Load
Add a local distributed load to each of the selected members in the
Load window.  A dialog box will appear which allows you to specify
the magnitude, direction and position of the load.  A local
distributed load acts parallel to one of the local x', y' or z' member
axes.

Local Point Load
Add a local point load to each of the selected members in the Load
window.  A dialog box will appear which allows you to specify the
magnitude, direction and position of the load.  A local point load acts
parallel to one of the local x', y' or z' member axes.

Local Moment
Add a local point moment to each of the selected members in the
Load window.  A dialog box will appear which allows you to specify
the magnitude, direction and position of the load. A local moment
acts about one of the local x', y' or z' member axes.

Thermal Load
Add a thermal load to each of the selected members in the Load
window.  A dialog box will appear which allows you to specify the
temperature, thermal coefficient, depth and direction of the load.  A
thermal load may either be uniform or a linear variation of
temperature through the depth of the member.
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Member Self Weight
Specify whether the self weight of the selected members should be
included or ignored during a static analysis, which includes a self
weight load case.  Note that this does not affect the inclusion of
member masses in a dynamic analysis, which is controlled by the
Member Mass command from the Frame menu.

Dynamic Load
(Macintosh Only)
Allows you to apply a dynamic time varying load to selected joints
in the Load window.

Display Menu
The Display menu contains commands for controlling the data,
which is displayed in the graphics window.

Symbols
This command brings up a dialog box, which allows you to specify
which symbols will be displayed in the Frame, Load and Plot
windows.  You can turn on or off the display of joint and member
numbers, loads, restraints, member axes, masses and names of
sections.

Data
See the “Data Submenu”

Results
See the “Results Submenu”

Actions
See the “Actions Submenu”

Stresses
See the “Stresses Submenu”

Deflection
Display the deflection for the current load case in the Plot window.
If the current load case is a dynamic case, the deflection will
represent a mode shape of the structure.

Animate
Animate the diagram in the frontmost window.  In the Frame and
Load windows, this command only operates in the 3D view and will
display views of the structure at a range of viewing angles.  Once the
diagrams have been displayed you can animate the range of views
by moving the mouse back and forth.  In the Plot window this
command will compute a series of diagrams showing the change as
loading increases from zero to its prescribed level.

Macintosh users:  If you turn on the QuickTime check box in the
Animate dialog, the animation will be saved into a QuickTime movie
file.  The movie is displayed in the window with the standard
QuickTime controller and you can play it if you wish.  The movie
will also be placed on the clipboard and may then be pasted into the
scrapbook or any QuickTime compatible application program.  You
will need to have the QuickTime extension installed in your System
Folder for these options to be available.  Contact your Apple dealer
for further details on QuickTime.
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Windows users:  Saving a QuickTime movie file will be implemented
once QuickTime is implemented into the Windows operating system
in late 1997.

Render
Display the frame complete with web and flange details.  This
display will help you visualize the orientation and section types for
the frame.  The rendering is not an exact display of the actual shape
of the members in the structure but more a visual guide to the
relative size and orientation of the sections in the frame.

You can interrupt the drawing of a rendered view of the structure by
typing Command-Period ( .) on the Macintosh, or pressing the
escape key on Windows.

Plot
Specify the precision to be used in the display of deflection diagrams
in the Plot window, which action, if any, is to be overlaid onto the
deflection diagram and what scaling factor should be applied to the
current diagram.

The overlaid action will be displayed as a color on the deflected
shape.  Red indicates a high value of the action relative to the rest of
the structure while blue indicates a relatively low value.

Customise Plot
You can customise the display of diagrams in the Plot window to
allow the display of one or more diagrams simultaneously.  This
applies to both global and local diagrams.

To choose which diagrams are displayed in the Plot window

• Choose Customise Plot… from the Display menu

A dialog will appear listing the menu items controlling the plot
display and the actions, stresses and deflections which can be
displayed.

• Click on the name of the menu item you wish to change

• Click on the Member button

• Set the check boxes of the actions you wish to display in the local
member diagrams

• Click on the Structure button
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• Set the check boxes of the actions you wish to display on the
diagram of the whole structure

• Click the OK button

Data Submenu
The Data submenu controls, which table of data, will be displayed in
the Data window.  One table can be displayed and edited at a time.

Joints
Display a table of joint coordinates.

Members
Display a table of member data including joint numbers at the ends,
section type, member type, length, slope and orientation.

Joint Loads
Display a table of joint load positions and magnitudes.

Member Loads
Display a table of member load positions and magnitudes.

Thermal Loads
Display a table of thermal load magnitudes.

Restraints
Display a table of joint restraints and prescribed displacements.

Linked Joints
Links a group of joints so that they move together in response to
static or dynamic loads.

Springs
Display a table of joint spring stiffnesses.

Joint Masses
Display a table of joint masses.

Sections
Display a table of sections summarizing the use of sections in the
frame.  The table includes the number, length and mass of each type
of section used.

Step Loads
Display a table of dynamic joint load positions and associated tine
series.

Results Submenu
The items in the Results sub-menu allow you to specify which table
of results should be displayed in the Results window.

Displacements
Display the computed joint displacements for the current load case in
the Result window.

Reactions
Display the computed joint reactions for the current load case in the
Result window.
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Member Actions
Display the computed member actions for the current load case in
the Result window.

Member Details
Display the member actions at the number of points along a selected
member.

Dynamics
Display the computed frequencies and periods of vibration from a
dynamic analysis.

Actions Submenu
The items in the Actions submenu may be used to control which type
of force or moment is displayed in the Plot window.

Moment Mz'
Display the computed bending moments about the local z' axis for
the current load case in the Plot window.

Moment My'
Display the computed bending moments about the local y' axis for
the current load case in the Plot window.

Shear Vy'
Display the computed shear forces in the local y' direction for the
current load case in the Plot window.

Shear Vz'
Display the computed shear forces in the local z' direction for the
current load case in the Plot window.

Axial Px'
Display the computed axial forces for the current load case in the
Plot window.

Torque Tx'
Display the computed torque about the local x' axis for the current
load case in the Plot window.

Stresses Submenu
The items in the Stresses submenu may be used to control which
type of stress is displayed in the Plot window.

Bending Sbz' top
Display the computed bending stress about the local z' axis at the top
of each member for the current load case in the Plot window.

Bending Sbz' bottom
Display the computed bending stress about the local z' axis at the
bottom of each member for the current load case in the Plot window.

Bending Sby' left
Display the computed bending stress about the local y' axis at the left
of each member for the current load case in the Plot window.

Bending Sby' right
Display the computed bending stress about the local y' axis at the
right of each member for the current load case in the Plot window.
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Shear Sy'
Display the computed shear stress in the local y' direction for the
current load case in the Plot window.

Shear Sz'
Display the computed shear stress in the local z' direction for the
current load case in the Plot window.

Axial Sx'
Display the computed axial stress for the current load case in the Plot
window.

Comb Sx' + Sbz' top
Display the combined axial stress and bending stress about the local
z' axis at the top of each member.

Comb Sx' + Sbz'
bottom

Display the combined axial stress and bending stress about the local
z' axis at the bottom of each member.

Comb Sx' + Sby' left
Display the combined axial stress and bending stress about the local
y' axis at the left of each member.

Comb Sx' + Sby' right
Display the combined axial stress and bending stress about the local
y' axis at the right of each member.

Case Menu
The items in the Case menu control analysis and working with load
cases.

Analyse
Carry out the analysis to compute all the deflections, moments and
forces for the structure for all load cases. In Multiframe4D, a dialog
will be displayed allowing you to specify the settings for the
analysis.

Calculate
(Windows: Alt + = / Macintosh: command =)
Calculate the value of the expressions in the CalcSheet.

Add Case
Add a new load case - enter load factors if desired. The Add Case
menu is a sub menu of the Case menu, and is described in detail
following this section on the Case menu.

Edit Case
The Edit Case command allows you to modify the attributes of the
current load case.

Delete Case
The Delete Case command allows you to delete one or more
loadcases.
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Load Case 1 (or
equivalent)

Display and allow editing of loads associated with load case 1 in the
Load and Data windows.  Display results for load case 1 in the Plot
and Result windows.

Similarly for subsequent load cases.

Mode Shape 1
Display results associated with mode shape 1 from a dynamic
analysis in Multiframe4D. Affects the display of deflections in the
Plot and Result windows.

Load Case
(Windows: Ctrl L)
Dialog box, which allows you to choose a load case. Similarly for
subsequent mode shapes.

Add Case
Submenu

The Add Case submenu allows you to enter load factors if desired.

Self Weight
Adds a Self Weight Load Case

Static
Adds a Static Load Case

Static Combined
Combines and factors several load cases

Dynamic
Adds a Dynamic Load Case

Seismic
Adds a Seismic Load Case

Time Menu
The items in the Time menu control, which increment is selected in a
time history analysis.

Maximum Envelope
Display’s a Maximum Envelope of all increments in the current time
history analysis case.

Minimum Envelope
Display’s a Minimum Envelope of all increments in the current time
history analysis case.

Absolute Envelope
Display’s an Absolute Envelope of all increments in the current time
history analysis case.

Time History
(Windows: Ctrl H)
(Windows Only)
Set the currently displayed time history increment.
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Window Menu
The Windows menu provides window specific functionality.

Cascade
(Windows Only)
Displays all the Windows behind the active Windows.

Tile Horizontal
(Windows Only)
Layout all visible windows across the screen.

Tile Vertical
(Windows Only)
Layout all visible windows down the screen.

Arrange Icons
(Windows Only)
Rearranges the icons of any iconised window so that they are
collected together at the bottom of the Multiframe program window.

Editing Layout
Makes the Frame, Data and Load windows all visible at once. This is
useful when you are defining the structure and its loads and
restraints.

Result Layout
Makes the Plot, Result and Load windows all visible. This is useful
when you are examining the results of the analysis.

Calcs Layout
Makes the Plot, Load and CalcSheet windows visible. This is useful
when you are doing calculations for a given member.

Frame
Makes the Frame window visible and brings it to the front.

Data
Makes the Data window visible and brings it to the front.

Load
Makes the Load window visible and brings it to the front.

Result
Makes the Result window visible and brings it to the front.

Plot
Makes the Plot window visible and brings it to the front.

CalcSheet
Makes the CalcSheet window visible and brings it to the front.

Tile
(Macintosh Only)
Lays out all of Multiframe's windows across the screen so that all of
each window is visible at once.

Stack
(Macintosh Only)
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Stacks up all of Multiframe's windows down the screen from top left
to bottom right so that each window is visible and close to its
maximum size.

Show All
(Macintosh Only)
Makes all of Multiframe's windows visible.

Hide All
(Macintosh Only)
Hides all of Multiframe's windows.

Help Menu
(Windows Only)
Provides access to an on-line help system.

Table of Contents
This command allows you to launch the table of contents of the
Multiframe help file.

About Multiframe
Tells which version of Multiframe you are using and how many
joints, members and forces etc. there are in the structure.
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Chapter 4
Multiframe Analysis
This chapter describes the analysis methods used in Multiframe

Method of
Analysis

Multiframe uses the matrix stiffness method of solution for solving a
system of simultaneous equations to determine the forces and
deflections in a structure.  Multiframe carries out a first order, linear
elastic analysis to determine these forces and deflections.  You
should be familiar with the concepts and application of the matrix
stiffness method before using this software.

The matrix stiffness method forms a stiffness matrix for each member
of the structure and given a list of applied loading, solves a system of
linear simultaneous equations to compute the deflections in the
structure.  The internal forces and reactions are then computed from
these deflections.  Multiframe does not take into account
deformations due to shear action in deep beams or warping
deformation due to torsion.

Axes and Sign
Convention

Multiframe uses two coordinate systems for defining geometry and
loading.  The global coordinate system is a right handed x, y, z
system with y always running vertically and x and z running
horizontally.  Gravity loads due to self weight are always applied in
the negative y direction.  To distinguish between local and global
axes, Multiframe uses the ' suffix to indicate a local axis.

X’

Y’

Z’

x

y

z Global Axes

Local Axes

Joint 1

Joint 2

Each member in the structure is defined by the two joints at its ends.
The local coordinate system is a right handed x, y, z system with the
x axis running along the member from joint 1 to joint 2.  The
direction of the y' axis is specified by your setting of the section
orientation.  The orientation is the angle between the y' axis and a
vertical plane passing through the ends of the member measured
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from the vertical plane towards the y' axis as viewed from joint 2
looking towards joint 1.

Multiframe uses six degrees of freedom at each joint when
performing its calculations (see the matrix on the next page). These
comprise three displacements along the axes and three rotations
about the axes at each joint.

The local element stiffness matrix K used by Multiframe is as follows:

AE
L

0 0 0 0 0 -AE
L

0 0 0 0 0

0 12EIz'
L3

0 0 0 6EIz'
L2

0 -
12EIz'

L3

0 0 0 6EIz'
L2

0 0 12EIy'
L3

0 -6EIy'
L2

0 0 0 -
12EIy'

L3

0 -
6EIy'
L2

0

0 0 0 GJ
L

0 0 0 0 0 -GJ
L

0 0

0 0 -6EIy'
L2

0 4EIy'
L

0 0 0 6EIy'
L2

0 2EIy'
L

0

0 6EIz'
L2

0 0 0 4EIz'
L

0 -6EIz'
L2

0 0 0 2EIz'
L

-AE
L

0 0 0 0 0 AE
L

0 0 0 0 0

0 -
12EIz'

L3

0 0 0 -6EIz'
L2

0 12EIz'
L3

0 0 0 -
6EIz'
L2

0 0 -
12EIy'

L3

0 6EIy'
L2

0 0 0 12EIy'
L3

0 6EIy'
L2

0

0 0 0 -GJ
L

0 0 0 0 0 GJ
L

0 0

0 0 -6EIy'
L2

0 2EIy'
L

0 0 0 6EIy'
L2

0 4EIy'
L

0

0 6EIz'
L2

0 0 0 2EIz'
L

0 -6EIz'
L2

0 0 0 4EIz'
L

A = Area, E = Young's Modulus, G= Shear Modulus, L = Length, J = Torsion Constant,
I = Moment of Inertia

Where each element behaves according to the equation

F=Kx
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Where F is the vector of applied loads, K is the stiffness matrix above
and x is a vector of calculated displacements

F={Px1, Py1, Pz1, Mx1, My1, Mz1, Px2, Py2, Pz2, Mx2, My2, Mz2}
x={dx1, dy1, dz1, Øx1, Øy1, Øz1, dx2, dy2, dz2, Øx2, Øy2, Øz2}

All relative to the local member coordinate system.

Note that the Iz' and Iy' above refer to the moment of inertia with
respect to the local coordinate system.  Since common engineering
convention is to use Ix and Iy for the major and minor moments of
inertia of a section, for a member with a section orientation of zero,
Iz' corresponds to the conventional Ix while Iy' corresponds to the
conventional Iy.  The Multiframe Sections Library uses the
conventional Ix, Iy notation for the two moments of inertia of the
sections stored in the library.

Member Actions
Multiframe computes member actions relative to the local member
coordinate system. When calculating an action at an intermediate
point along a member, Multiframe checks the free body diagram of
the member to the left of the point of interest and uses the balance of
forces at this point for the sign of the computed action.  As an
example, consider the shear force at a point on a simple beam subject
to a central point load.

Following the above approach at the left hand portion of a beam, the
sum of the shear forces is therefore positive as shown in the diagram
above.

For the common case of a beam with joint 1 at the left hand end and
joint 2 at the right hand end, a load acting downwards will be
negative in magnitude and the forces will be as shown below.
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When you specify the loads applied to a structure it will not be
necessary to enter the signs of the load magnitudes since Multiframe
will offer you a number of icons to choose from to specify a direction.

Dynamic Analysis
Multiframe4D allows you to perform a dynamic analysis of a frame.
This analysis will determine the natural frequencies and mode
shapes of the frame.  These frequencies and mode shapes will reflect
the interaction between the stiffness of the frame and the inertial
effects of its mass and any joint masses you have applied to it.

Multiframe4D determines the natural dynamic response of the frame
by using the subspace iteration method. This method solves the
equation

[m]{ü} + [k] {u} = {0}
Where [m] is the mass matrix, {ü} is the vector of joint accelerations,
[k] is the stiffness matrix and {u} is the vector of joint displacements.
The solutions of this equation of undamped free vibration, of which
there are a number, represent the natural responses of the frame.
Multiframe will calculate the solutions corresponding to the highest
periods of vibration (i.e. the lowest frequencies).

The local member mass matrix used by Multiframe4D varies
according to whether a lumped or distributed mass model is chosen
in the Analysis dialog.

The mass matrix for a lumped model is as follows

mL
2

0 0 0 0 0 0 0 0 0 0 0

0 mL
2

0 0 0 0 0 0 0 0 0 0

0 0 mL
2

0 0 0 0 0 0 0 0 0

0 0 0 mLIo
2A

0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 mL
2

0 0 0 0 0

0 0 0 0 0 0 0 mL
2

0 0 0 0

0 0 0 0 0 0 0 0 mL
2

0 0 0

0 0 0 0 0 0 0 0 0 mLIo
2A

0 0

0 0 0 0 0 0 0 0 0 0 0 0
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0 0 0 0 0 0 0 0 0 0 0 0

A = Area, m = Mass per unit length, Io= polar moment of inertia=Ix + Iy, L = Length

The mass matrix for a distributed mass model (also known as the
consistent mass matrix in some texts) is as follows

140mL
420

0 0 0 0 0 70mL
420

0 0 0 0 0

0 156mL
420

0 0 0 22mL2

420
0 54mL

420
0 0 0 -
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420
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420
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420
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420
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420
0
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o

420A
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420
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420
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420
0
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0 0 0 4mL3

420
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420
0 0 0 -3mL3

420

70mL
420

0 0 0 0 0 140mL
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420
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420
0 0 0 -
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420
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420A
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0
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A = Area, m = Mass per unit length, Io= polar moment of inertia=Ix + Iy, L = Length

In general, a distributed mass matrix will give a more accurate result.
However, in some circumstances the distributed mass approach may
not converge.  In this case use the lumped mass approach.  If in
doubt, use both methods and compare the results between the two.

Capacity
The absolute maximum capacities for Multiframe are as follows
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Number of joints No limit

Number of members No limit

Number of restraints and prescribed
displacements

No limit

Number of springs No limit

Number of load cases 300

Number of joint loads No limit

Number of member loads No limit

Number of thermal loads No limit

Number of members connected at one joint 18

In practice, most of the above limits will be reduced by the amount of
memory available at the time the program is running.

The amount of memory required is independent of the order in
which the joints are numbered.  Multiframe will automatically
optimize the internal numbering of the joints to best use the memory
available.

The actual size of the structure you will be able to solve will depend
on the number of load cases and the geometric configuration of the
structure.  The more load cases you use the smaller structure you
will be able to analyse.  If you do not have enough memory to
analyse a structure, try setting up the different load cases as separate
files and analysing each load file separately.
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Appendix A
Troubleshooting
This appendix describes some solutions to commonly encountered
problems, which may occur with Multiframe.

Troubleshooting
Most Multiframe users, at some stage, experience an error message
after analysis saying, "The solution does not make sense, please
check the structure, restraints and section properties." Why does this
happen and what should you do if it does?

During analysis, Multiframe checks to see if there is a zero on the
diagonal of the stiffness matrix. If so, it will display a error message
saying either "The structure has unrestrained degrees of freedom" or
"Suspected unrestrained degrees of freedom". The program will
select the suspect joints in the Frame window after displaying this
message. Sections 2 and 3 below describe how to deal with this
problem.

After carrying out the analysis Multiframe checks the results of
analysis to verify that the solution makes sense. It does this by
examining the deflections and seeing if any of them are infinite. If
any deflections are bad it will display the "Solution doesn't make
sense" message. There are four main causes for this condition and
you should check each of them if you receive the above warning
message.

1. Check for bad section's properties

When Multiframe computes the stiffness matrix, it uses the
properties in the Sections Library to determine the resistance of the
sections to bending, axial and torsional deformation. If any of the key
properties are zero, this will result in a zero in the matrix and
consequently a bad solution. For a successful analysis, the following
properties must be greater than zero:

Area Cross-sectional area of the section
Ix Moment of inertia of the section about its strong

axis
Iy Moment of inertia of the section about its weak

axis
J St Venant torsion constant
E Elastic or Youngs Modulus
G Shear Modulus

2. Check for mechanisms

If you use member releases (or pinned members) or pinned joints in
your structure, there is a possibility that you can create a mechanism,
which allows the structure to deflect using a rigid-body mode of
deformation.  The simplest example is a portal frame with pinned
restraint at the base of the columns under a lateral load.  If all the
members are rigid (no member release) analysis can proceed with no
problems and the frame deforms by flexure of the columns.
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However, if we put member releases at the top of the columns, the
frame is free to deflect by a mechanism allowing infinite lateral
movement by rotation at the released ends of the columns.  In this
case, Multiframe will report the error.

The solution is either to restrain the tops of the columns laterally or
to use rigid members for the columns.

More subtle rigid body modes of deformation can develop if you
release torsion (Tx') as well as bending moments (My' and Mz') when
you specify the member type.  This means that it is possible to
develop a torsional rigid mode of deformation in a structure.  The
simplest case of this is a member with torsional releases at both ends
and a moment applied in the middle.  In this case, there is no
torsional restraint on the member and so the applied moment will
cause an infinite torsional rotation.

A more complex case can develop where a group of members are
connected to the rest of the structure by pin ended members and so
the whole group is free to rotate to an infinite angle of rotation.  A
common example of this would be the top chord of a truss where the
top chord is considered to be rigid but the rest of the members are
pinned together.

In this case, because the top chord of the truss is pinned at its left
hand end, pinned to the intermediate members along the truss, and
also, pinned at its right hand end, the whole of the top chord is free
to rotate about its longitudinal axis. This results in an infinite
rotation of the top joints of the truss. There are three solutions to this
problem. Either restrain these top joints against rotation by using a
custom restraint to restrain Øx to zero
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Or use a member type that does not release the torsional moment, Tx'
or use the pinned joint type available in Multiframe3D version 1.6
and later. The pinned joint type sets all of the rotations of the joint to
zero.

This will prevent these infinite torsional rotations without affecting
the rest of the analysis.

3. Check for bad restraints

When analysing a structure, it is necessary to ensure that the whole
structure cannot move in a single rigid body motion. For example, if
you try to analyse a two dimensional frame using Multiframe 3D,
you may find the "Solution doesn't make sense" warning occurring.
(This will only be a problem if the structure lies in a plane other than
the Front plane. In Multiframe3D version 1.6 and later, 2D structures
with 2D loading in the Front plane will be automatically recognized
and analysed correctly). This is probably because you have not
restrained the structure sufficiently to stop the whole frame rotating
about the global x axis passing through its supports. For example, a
simple or continuous beam with pinned restraints will not analyse
because it is free to twist about its longitudinal axis.

The solution to these problems is to add a rotational restraint to one
or more of the restraints on the structure.
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The same problem can occur with more complex 2D structures, in
fact, a torsional rigid body mode of rotation will occur on any
structure where the only restraints are pinned and all the restrained
joints are co-linear.

2D portal with two pinned restraints is free to rotate about the global
z axis

4. Check for unrestrained joints

If you have a large number of members in your structure with
member releases you may develop a situation where all of the
members meeting at a joint have a pin at their ends. In this case there
is no rotational restraint for the joint and it will result in an infinite
rotation displacement of the joint.

The solution to this is to use the pinned joint type.

 
Alternatively, you can apply a joint restraint with only the three
rotations restrained.
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This will prevent the joint rotating but because the members are
connected to the joint via a pinned end, they are free to deflect and
rotate as usual.
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Appendix B
Macintosh Memory
This appendix describes how to optimise memory usage on
Macintosh computers.

Macintosh Memory
With version 6 or later of the Macintosh system software, a capability
was introduced to allow you to run more than one application at a
time.  This allows you to allocate a portion of the available memory
to an application, and to keep starting up applications until no more
memory is available.

For example, suppose you have a Macintosh with 16 megabytes of
memory. Approximately 8 megabytes will be used by the System
and Finder, and of the remaining 8 megabytes 4 could be used by
Multiframe.  This means you could be analysing with Multiframe,
and at the same time be using a spreadsheet to do design calcs and a
word processor to collate the data into a report.

If you want to increase the amount of memory available for an
application, click on the application's icon when in the Finder and
choose Get Info from the File menu.  The Finder will display a dialog
with a number at the bottom indicating the amount of memory to
allocate for the application.

Multiframe normally requires 4000 k of space however if you are
using Multiframe with a large structure or a large number of load
cases, you will probably want to allocate 6000k or more of space.

The Multiframe suite tries to ensure that as much calculation as
possible is done when the applications are running in the
background.  When any of the Multiframe applications are running a
time consuming task, one of two cursors will be displayed.  The



Appendix B Macintosh Memory

watch cursor is displayed when a task, which is running, requires all
of the Macintosh's processing power, and in this case you cannot
switch to another application until the task finishes.

For tasks that may take a very long time, the beach ball cursor is
displayed, and you can switch to another application at any time and
have the task continue to calculate in the background.  Tasks of this
type can normally be interrupted by typing Command Period

To switch to another application, click on the desktop or in the
window of another application.  The most useful aspect of this is that
while you are analysing a large structure, you can switch to another
application and continue working with your Macintosh while
Multiframe carries out the analysis in the background.

Virtual Memory
With the introduction of System 7 a new memory feature known as
virtual memory is available to users with a Macintosh with a 68030
or better processor, or a Power Mac.  Virtual memory allows you to
use hard disk space to make more memory available to your
computer.  You turn on virtual memory using the Memory control
panel. After you have allocated more memory to your machine using
VM, you will need to resize the Multiframe partition using the Get
Info option in the Finder as described above.
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Appendix C
Analysing Trusses
This appendix describes how to analyse truss structures using
Multiframe.

Analysing Trusses
When you create a frame for analysis by Multiframe, it initially
assumes that all of the connections between the members in the
structure are fully rigid, that is, there is full moment transfer across
all joints.  To allow you to include joints which do not transmit
moment, Multiframe allows you either to use the Member Type
command to release the moments at one or both ends of a member or
to use the Joint Type command to pin the ends of all of the members
connected at a joint. If you are using Multiframe3D or Multiframe4D,
you should use the Joint Type option.  However, if you are using
Multiframe2D, you will need to follow the procedures listed below.

Although you can release the end moments for as many members in
a frame as you like, a problem arises if you release the moments at
the ends of all of the members connected at a common joint.  In this
case, the joint is unrestrained against rotation, infinite rotations will
be computed and the "Solution doesn't make sense" error message
will appear.  If you are trying to analyse a truss structure it is
necessary to make all of the members in the structure pined at both
ends and consequently this problem arises for all the joints in the
frame.

The solution to this problem is to restrain the joint against all
rotations, this sets the rotations of the joint to zero, but the pins on
the members allow them to deflect freely with no moment restraint.

If you are analysing a truss structure, you will probably find it
easiest to follow these steps.

1. Draw the frame as usual

2. Use the Select All command from the Select menu to select all the
members in the frame

3. Use Member Type to set all the members to Pin-Pin ends
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4. Use the Joint restraint command to restrain the rotations of all of
the joints in the frame to zero.

5. Use pinned restraints as usual on the foundations of the truss.

Multiframe's analysis will accurately compute the deformations of
the structure due to axial forces only and the resulting rotations of all
the joints will be zero.

If you find it inconvenient having so many restraints displayed in the
Frame window, you can always turn them off by using the
Symbols… command from the Display menu.
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Appendix D
Importing And Exporting Data
This appendix describes how to exchange data between Multiframe
and other programs.

Exporting Data
Multiframe allows you to export numbers, drawings or animations
to other programs.  For example you may wish to take a table of
numbers to a spreadsheet for further calculations or you might want
to take graphics to a CAD or visualization package.  The following
paragraphs outline how to use the various options.

1. Clipboard/Pict File  (Macintosh Only)
You can copy the current contents of the Frame, Load or Plot
windows to the clipboard by using the Copy command from the Edit
menu with the window in front.  If you hold down the option key
while choosing the Copy command, a dialog will appear allowing
you to choose to send the graphics to the clipboard or a Pict file.

You can also choose what scale the drawing will be copied at.  This is
particularly useful for matching the output from Multiframe with
other data you might be importing in another application.  The main
disadvantage of this option is that the picture is stored in 72 dot per
inch precision, which may produce slightly jagged lines when output
on higher resolution printers.  If you need higher resolution you may
want to consider using the Postscript option (see below).

2. DXF
Multiframe can export 2D or 3D DXF files, which can be read by
AutoCAD and other CAD systems.  Depending on what is displayed
on screen, the file will contain either lines representing the members
in the frame, or polygons representing the shapes of the sections
which make up the members.  Normally, lines only will be output.
However, if you save a DXF file while rendering is turned on in the
front window, the more complex polygon option will be used.  The
polygon option saves the detailed models of the members as
3DFACE entities.  This is particularly useful for exporting data to
rendering programs, which need a polygonal format to do a good job
of rendering the frame.

3. PostScript
When you need very high resolution output for presentation
purposes, the PostScript option will be most suitable.  Hold down
the Option key while choosing the Copy command from the Edit
menu.  Choose the PostScript option in the Copy dialog, and a scale



Appendix D Importing & Exporting Data

for your drawing and the contents of the front window will saved
into a PostScript file, you can then place this file into a high
resolution drawing program such as Adobe Illustrator or Aldus
Freehand or place it into a page layout program.

4. Renderman
If you wish to create very high quality rendered images of a frame
using a rendering system such as Renderman, you will find the RIB
(Renderman Interface Bytestream) file format useful.  Hold down the
Option key while choosing the Copy command from the Edit menu.
Choose the Renderman option in the Copy dialog, and a scale for
your drawing and the contents of the front window will be saved
into a RIB file.  You can then read this file into a rendering program
such as Renderman, StrataVision, ShowPlace etc.

5. Copying and Pasting Tables of Numbers
If you wish to use the results from Multiframe in another program,
you can copy and paste the tables, which are displayed in the Result
window.  To copy the table, click in the box at the top left corner of
the table to select all the cells and then use the Copy command from
the Edit menu. The table of numbers will be in "tab delimited
format".  You can then switch to your spreadsheet or word processor
and paste in the data.  You can also copy and paste any of the tables
displayed in the Data window in a similar way.

6. Saving Text Files
Multiframe provides a capability for saving all of the data and results
for a structure in a text file, which can be read in by another
program.  This is useful either for having a complete summary of the
structure in one file, or for linking up with a post-processing
program which could be written to receive the results from
Multiframe and do further calculations.  To save a text file, choose
Save As… from the File menu, choose the Fortran Text option from
the pop-up menu of file formats, and click Save.

7. Saving QuickTime Movies  on the Macintosh
Multiframe provides a capability for creating a QuickTime movie
from any animation, which can then be pasted into any QuickTime-
aware program.  This is useful for keeping a record of an analysis or
for linking up with a post-processing program, which could be used
for visualization.  To save a QuickTime movie, hold down the Option
key while choosing Animate from the Display menu. Multiframe will
create and play the animation as usual, but will also place a
QuickTime movie on the clipboard which can then be pasted into the
ScrapBook or any other QuickTime aware application.  You must
have the QuickTime system extension turned on your computer to
use this capability.  If you also have the Wild Magic system extension
installed, you will be able to view and play the movie in any
Macintosh application, which can display a picture.  This includes
the Steel Designer report, which means you can paste an animation
from Multiframe into the Steel Designer report.

Importing Data
1. DXF
Multiframe can read in 2D and 3D DXF files (Multiframe2D can only
read 2D files). This means you can create the geometry for a frame in
a CAD program and then save it in DXF format to be read into
Multiframe.  When reading a DXF file, Multiframe will extract all of
the LINE, LINE3D and POLYLINE entities from the file and treat
each line segment as a Multiframe member.  Lines, which are within
0.2 inches (5mm) of each other, will be connected together.
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2. Tables of numbers
You can paste tables of numbers into Multiframe in the data window
by preparing a table of data in a spreadsheet and then pasting it into
the selected cells in the Data window.  When pasting in numbers,
make sure that the numbers to be pasted have the same number of
rows and columns as the selected area in the Data window.

3. Reading Text Files
Multiframe can read in a structure from a text file in the same format
saved using the Save As command (see 6 above).  This file could be
created using a pre-processor program to create the geometry and
other attributes for the structure.





Appendix E Text File Format

Appendix E
Text File Format
This appendix describes a neutral text file format, which can be used
to send data from Multiframe to a post processor or to prepare data
for Multiframe, either manually or using a pre-processor.

Text File Format
Multiframe has the capability of saving and reading files in a text
format.  This facility is designed to allow pre and post processing
programs to transfer information to and from Multiframe.  The file
may also be used as a convenient summary of the data in a human
readable format.

The format of a Multiframe text file is as follows.

All numbers in the file are in Fortran style format.  Integers are in I5
while real numbers are in F12.4 format.  Data within the file is saved
in groups, each group is proceeded by the name of the group in
upper case letters and followed by a number of lines with the
relevant information.

The text file uses the units currently selected in Multiframe.

Job Title Up to 80 characters describing the file and the date

METRIC or IMPERIAL Units Number of joints

JOINTS Start of data describing joints
15 Number of joints
15,F12.4,F12.4,F12.4 Joint number, x coord, y coord, zcoord

…repeat line for each joint

MEMBERS Start of data describing members
 I5 Number of members
15,15,15,15,15,15,F12.4 Member no, Node 1, Node 2, Section Group, Section Number,

Member Orientation
…repeat line for each member

SECTIONS Start of section data
I5 Number of different sections used in frame
A15,15,15 Section Name, Group Number, Section Number
F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4

Mass, Area, Ixx, Iyy, J, Youngs Modulus, Shear Modulus
…repeat line for each different section used in frame

RESTRAINTS Start of restraints data
15 Number of restraints
I5,I5,I5,I5,I5,I5,I5,I5,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4

Restraint #, Joint #, x flag, y flag, z flag, Øx flag, Øy flag, Øz
flag, x value, y value, z value, Øx value, Øy value, Øz value
…repeat line above for each restraint

SPRINGS Start of data for springs
15 No of springs
15,15,15,15,15,15,15,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4
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Spring #, Joint #, x flag, y flag, z flag, Øx flag, Øy flag, Øz flag,
x value, y value, z value, Øx value, Øy value, Øz value
… repeat line above for each spring

LOADS Start of loads
15 Number of load cases

LOAD CASE Start of load case
A15 Name of load case

JOINT LOAD Start of joint loads for this load case
15 Number of joint loads in this load case
15,15,15,15,15,15,15,15,F12.4,F12.4,F12.4F12.4,F12.4,F12.4

Load #, Joint #, x flag, y flag, z flag, Øx flag, Øy flag, Øz flag, x
value, y value, z value, Øx value, Øy value, Øz value
… repeat line above for each joint load in this case

MEMBER LOAD Start of member loads for this load case
15 Number of member loads in this load case
15,15,15,F12.4,F12.4,F12.4,F12.4

Load #, Member #, Load Type, Left dist, right dist, left
magnitude, right magnitude
… repeat line above for each member load in this case

THERMAL LOAD Start of thermal load for this load case
15 Number of thermal loads in this load case
15,15,F12.4,F12.4,F12.4,F12.4

Load #, Member #, top temp, bottom temp, thermal coeff,
depth
… repeat line above for each thermal load in this case

…repeat for each thermal load in this case

RESULTS Start of results of analysis

LOAD CASE Start of results for load case
A15 Load case name

DISPLACEMENTS &
REACTIONS

Start of displacements and reactions

15,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4
Joint 3, x disp, ydisp, z disp, Øx, Øy, Øz, Pxreact, Pyreact,
Pzreact, Mx, Myreact, Mzreact
…repeat line for each joint

MEMBER ACTIONS Start of local member actions
15,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4,F12.4

Member #, Fx1, Fy1, Fz1, Mx1, My1, Mz1, Fx2, Fy2, Fz2, Mx2,
My2, Mz2
…repeat each line for each member

…repeat for results for each load case

END End of file

Following is a summary of the various flags and codes used in the
text file

RESTRAINTS and SPRINGS xflag, yflag, zflag, Øxflag, Øyflag,
Øzflag
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One of these should be 1 and the others zero to indicate which
degree of freedom is being restrained. Only 1 degree of freedom can
be set at a time for non-zero restraints.

As an example, the following tables indicate the flags appropriate to
the icons in the Front view.

Multiframe load codes

{global load codes}
{Point loads}
Px=3;
Py=13;
Pz=23;
{Distributed loads}
Wx=4;
Wy=14;
Wz=24;
{Moments}
Mx=5;
My=15;
Mz=25;

{local load codes}
{Point loads}
Px'=-3;
Py'=-13;
Pz'=-23;
{Distributed loads}
Wx'=-4;
Wy'=-14;
Wz'=-24;
{Moments}
Tx'=-5;
My'=-15;
Mz'=-25;

Load conventions and coordinate systems
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Multiframe Text
Example File

S12x35

M12x10

M12x10

S12x35

S12x35

M12x10

M12x10

S12x35

W12x19 W12x19

W12x19

1

2
3

4

56

7
8

9

10

1

2

3

45

6

7

8

9
10

11
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TextFileFrame  Load Case 1  

5.000

5.000

TextFileFrame  Load Case 2  

2.500

2.500

2.500

2.500

4.000

4.000

TextFileFrame.text Fri, Apr 24, 1992
IMPERIAL
JOINTS
   10
    1      0.0000      0.0000      0.0000
    2      0.0000      9.0000      0.0000
    3     10.0000     11.1256      0.0000
    4     20.0000      9.0000      0.0000
    5     20.0000      0.0000      0.0000
    6      0.0000      0.0000     25.0000
    7      0.0000      9.0000     25.0000
    8     10.0000     11.1256     25.0000
    9     20.0000      9.0000     25.0000

   10     20.0000      0.0000     25.0000
MEMBERS
   11
    1    1    2    3   16      0.0000
    2    2    3    2    4      0.0000
    3    3    4    2    4      0.0000
    4    5    4    3   16      0.0000
    5    6    7    3   16      0.0000
    6    7    8    2    4      0.0000
    7    8    9    2    4      0.0000
    8   10    9    3   16      0.0000
    9    7    2    1  253      0.0000
   10    8    3    1  253      0.0000
   11    9    4    1  253      0.0000

SECTIONS
    3
S12x35             3   16
    114.8156     10.3007    228.9832      9.8693      1.0799  29000.6935  11150.2663
M12x10             2    4
     32.8044      2.9402     61.5955      0.9939      0.0300  29000.6935  11150.2663
W12x19             1  253
     62.3285      5.5704    129.9905      3.7597      0.1800  29000.6935  11150.2663
RESTRAINTS
    4
    1    1    1    1    1    1    1    1      0.0000      0.0000      0.0000      0.0000      0.0000
0.0000

    2    5    1    1    1    1    1    1      0.0000      0.0000      0.0000      0.0000      0.0000
0.0000
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    3   10    1    1    1    1    1    1      0.0000      0.0000      0.0000      0.0000      0.0000
0.0000
    4    6    0    1    0    0    0    0      0.0000     -1.0000      0.0000      0.0000      0.0000
0.0000
SPRINGS
    2
    1    4    1    0    0    0    0    0      1.0000      0.0000      0.0000      0.0000      0.0000
0.0000

    2    9    1    0    0    0    0    0      1.0000      0.0000      0.0000      0.0000      0.0000
0.0000
LOADS
    2
LOAD CASE
Load Case 1
JOINT LOAD
    2
    1    3    0    1    0    0    0    0      0.0000     -5.0000      0.0000      0.0000      0.0000
0.0000
    2    8    0    1    0    0    0    0      0.0000     -5.0000      0.0000      0.0000      0.0000
0.0000
MEMBER LOAD
    0
THERMAL LOAD
    0
LOAD CASE

Load Case 2
JOINT LOAD
    0
MEMBER LOAD
    6
    1    2  -14      0.0000      0.0000      2.5000      2.5000
    2    3  -14      0.0000      0.0000      2.5000      2.5000
    3    6  -14      0.0000      0.0000      2.5000      2.5000
    4    7  -14      0.0000      0.0000      2.5000      2.5000
    5    4    4      0.0000      0.0000     -4.0000     -4.0000
    6    8    4      0.0000      0.0000     -4.0000     -4.0000
THERMAL LOAD
    0

RESULTS
LOAD CASE
Load Case 1
DISPLACEMENTS AND REACTIONS
    1      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000      2.2274      2.5446
0.0426    -0.4825      0.0035     -9.8863
    2     -0.0338     -0.0009      0.1492      0.1749     -0.0213     -0.0015      0.0000      0.0000
0.0000     0.0000      0.0000      0.0000
    3     -0.0014     -0.1716      0.1358      0.1272     -0.0086     -0.0005     -0.0000     -0.0000
-0.0000    0.0000      0.0000      0.0000

    4      0.0309     -0.0009      0.0089      0.0011     -0.0062      0.0035     -0.0309     -0.0000
-0.0000    0.0000     -0.0000      0.0000
    5      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000     -2.1622      2.4827
-0.0213   -0.1002      0.0010      9.4208
    6     -0.4120     -1.0000     -0.2251      0.1986     -0.0202     -0.0411      0.0000      1.4778
0.0000    -0.0000      0.0000     -0.0000
    7     -0.3345     -1.0005      0.1492      0.1986     -0.0202     -0.0411      0.0000     -0.0000
-0.0000    0.0000      0.0000      0.0000

    8     -0.3696     -0.8375      0.1358      0.1272     -0.0079      0.3159     -0.0000     -0.0000
0.0000     0.0000     -0.0000      0.0000
    9     -0.1930     -0.0013      0.0089      0.0011     -0.0064      0.2085      0.1930      0.0000
0.0000    -0.0000      0.0000      0.0000
   10      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000     -0.2273      3.4949
-0.0213   -0.1002      0.0010    -17.6279
MEMBER ACTIONS
    1      2.5446     -2.2274      0.0426      0.0035      0.4825     -9.8863     -2.5446      2.2274
-0.0426   -0.0035     -0.8659    -10.1601

    2      2.6910      1.9920      0.0210      0.0002     -0.1149     10.1598     -2.6910     -1.9920
-0.0210   -0.0002     -0.0996     10.2054
    3      2.6723     -1.9797      0.0213      0.0005     -0.1010    -10.2023     -2.6723      1.9797
-0.0213   -0.0005     -0.1173    -10.0368
    4      2.4827      2.1622     -0.0213      0.0010      0.1002      9.4208     -2.4827     -2.1622
0.0213    -0.0010      0.0915     10.0388
    5      1.4778     -0.0000      0.0000      0.0000      0.0000     -0.0000     -1.4778      0.0000
-0.0000   -0.0000     -0.0000      0.0000

    6      0.3240      1.4794      0.0216      0.0003     -0.1196      0.0004     -0.3240     -1.4794
-0.0216   -0.0003     -0.1013     15.1241
    7      0.7492     -3.4042      0.0212      0.0005     -0.1001    -15.1272     -0.7492      3.4042
-0.0212   -0.0005     -0.1170    -19.6751
    8      3.4949      0.2273     -0.0213      0.0010      0.1002    -17.6279     -3.4949     -0.2273
0.0213    -0.0010      0.0915     19.6731
    9      0.0216     -0.0366     -0.0093      0.0004      0.1169     -0.0251     -0.0216      0.0366
0.0093    -0.0004      0.1158     -0.8899
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   10     -0.0004     -0.0000     -0.0157     -0.0031      0.1971     -0.0005      0.0004      0.0000
0.0157     0.0031      0.1964     -0.0000
   11      0.0001      0.0093     -0.0092     -0.0020      0.1154      0.1163     -0.0001     -0.0093
0.0092     0.0020      0.1156      0.1163
LOAD CASE
Load Case 2
DISPLACEMENTS AND REACTIONS
    1      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000     -8.1758    -23.9131
-0.0503   -0.9305     -0.0332     13.4469

    2     -0.1168      0.0086      0.1907      0.1827      0.2050      0.2610     -0.0000      0.0000
0.0000    -0.0000      0.0000      0.0000
    3     -0.2978      0.9501     -0.0073     -0.2147      0.0999     -0.0842      0.0000     -0.0000
0.0000    -0.0000     -0.0000      0.0000
    4     -0.4781      0.0094     -0.0106     -0.0015      0.0782      0.0770      0.4781     -0.0000
0.0000     0.0000      0.0000      0.0000
    5      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000     43.6556    -26.0598
0.0251     0.1189     -0.0127   -149.3328

    6      6.0137     -1.0000     -0.1786      0.1959      0.2213      2.5272      0.0000    -20.0706
0.0000     0.0000     -0.0000     -0.0000
    7      1.2501     -0.9927      0.1907      0.1959      0.2213      2.5272      0.0000     -0.0000
-0.0000   -0.0000     -0.0000     -0.0000
    8      0.6043      2.0743     -0.0073     -0.2146      0.0974     -0.1494      0.0000      0.0000
0.0000    -0.0000      0.0000     -0.0000
    9      0.1750      0.0108     -0.0106     -0.0015      0.0789     -0.4912     -0.1750     -0.0000
-0.0000   -0.0000      0.0000     -0.0000

   10      0.0000      0.0000      0.0000      0.0000      0.0000      0.0000     36.2179    -29.9577
0.0251     0.1189     -0.0128    -65.0523
MEMBER ACTIONS
    1    -23.9131      8.1758     -0.0503     -0.0332      0.9305     13.4469     23.9131     -8.1758
0.0503     0.0332     -0.4782     60.1356
    2    -12.9606    -21.7098     -0.0241      0.0016      0.1299    -60.1136     12.9606     -3.8490
0.0241    -0.0016      0.1161    -31.1856
    3    -13.3874     -1.7513     -0.0253     -0.0008      0.1215     31.1849     13.3874    -23.8075
0.0253     0.0008      0.1373     81.5601

    4    -26.0598    -43.6556      0.0251     -0.0127     -0.1189   -149.3328     26.0598      7.6552
-0.0251    0.0127     -0.1072    -81.5656
    5    -20.0706     -0.0000      0.0000     -0.0000      0.0000     -0.0000     20.0706      0.0000
-0.0000    0.0000     -0.0000     -0.0000
    6     -4.1813    -19.6129     -0.0262      0.0017      0.1462     -0.0220      4.1813     -5.9459
0.0262    -0.0017      0.1217    -69.8395
    7     -6.2564      3.7271     -0.0250     -0.0008      0.1186     69.8402      6.2564    -29.2859
0.0250     0.0008      0.1365     98.9126

    8    -29.9577    -36.2179      0.0251     -0.0128     -0.1189    -65.0523     29.9577      0.2175
-0.0251    0.0128     -0.1073    -98.9071
    9     -0.0262     -0.0170      0.0122     -0.0220     -0.1434      0.0287      0.0262      0.0170
-0.0122    0.0220     -0.1606     -0.4528
   10      0.0013      0.0002      0.0187      0.0006     -0.2349      0.0031     -0.0013     -0.0002
-0.0187   -0.0006     -0.2322      0.0013
   11     -0.0002     -0.0109      0.0117      0.0055     -0.1461     -0.1365      0.0002      0.0109
-0.0117   -0.0055     -0.1468     -0.1366

END
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Appendix F
Using Spreadsheets With
Multiframe
This appendix explains how you can effectively use spreadsheets
with Multiframe to simplify the generation of frames and
interpretation of the results of a Multiframe analysis.

Spreadsheets with
Multiframe

You are probably aware that you can choose Copy from the Edit
menu to copy a Multiframe picture into a word processor or drawing
program.  However, you may not be aware that you can also copy
tables of data from Multiframe into a spreadsheet or copy and paste
information from a spreadsheet into Multiframe.

The basics of copying data in Multiframe are to select the area of the
table to be copied (by dragging the mouse or shift-clicking in the
usual way, see the Multiframe manual for more details) and then
copy the data to the clipboard using the Copy command from the
Edit menu.  You can then switch to or start up your spreadsheet,
click at the location where you want to paste the data, and then use
the Paste command to place the data into the spreadsheet.  You can
copy data from any of the tables in the Data and Result windows.

To paste data into Multiframe you reverse the procedure, selecting
the data to be copied in the spreadsheet, choosing the Copy
command in the Edit menu, and then switching to Multiframe,
selecting the area to paste it into, and then using the Paste command.
You can paste data into the Joint, Member, Joint Load and Member
Load tables in the Data window.

Example 1 -  Generating An Arch
As one example of generating data in a spreadsheet and pasting it
into Multiframe, consider the problem of analysing a parabolic arch.
To draw or type in the geometry would be very time-consuming and
difficult to modify if you wanted to consider several options for the
shape of the arch.  You can, however, use a spreadsheet to generate
the geometry of the arch and then paste the coordinates into the Data
table in Multiframe.

First, you would generate a continuous beam in Multiframe with the
appropriate number of spans and then copy and paste the x  column
into the table in the spreadsheet.  Next, write a formula for the y
coordinate (or height) of the arch in the column adjacent to the data
you have pasted in.  You can then produce the y coordinate for each
joint automatically.
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Once you have generated the coordinates you can then copy the
column of y coordinates from the spreadsheet and paste them into
the y column in Multiframe.

This will automatically generate the correct geometry for the arch
which will be displayed in the other Multiframe windows.

If you have applied the section types, restraints and loads to the
structure, these will remain intact when you paste in the new
geometry, and you can immediately re-analyse to determine the
results of the new shape.  You can then investigate different
alternatives by generating different shapes in the spreadsheet and
pasting them into Multiframe.  One important point to note is that
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pasting the coordinates in requires that the joints in Multiframe are
listed in the same order as the joints in the spreadsheet. You will find
the Renumber… command in Multiframe useful for ensuring that
this is the case.  A second point to note is that you can select just a
part of a column or range of columns in Multiframe, you do not
necessarily have to generate coordinates for the whole structure.

Example 2 - Generating Loads
Generating the loads for a structure is often the most time-
consuming part of setting up a structural model.  For example, if you
have a structure subject to wind loads which depend on the height of
the members above the ground, there may be hundreds of
calculations required to determine the magnitudes of these loads.
However, you can use a spreadsheet, in particular a spreadsheet's
ability to look up values from tables, to automate the generation of
loads.

If a load depends on the height of a member, you will first need to
calculate the height of each member.  You can do this by using the
Member table from the Data window to find out which joints are at
the ends of each member and the Joint table to find out the
coordinates of these joints.  Start by pasting these two tables into
different areas of your spreadsheet and defining arrays, which refer
to these two tables.

Next, add a column to the Member array and put a formula in it to
look up the y coordinates of the joints and use them to find out the
height of the mid-point of the member.  Then add another column
and put a formula in it to calculate the load magnitude from the
member midpoints (calculated values are shown in the illustrations
below in italics).
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This last column of the Member Data array now contains the
required load magnitude for each member in the structure.  The next
step is to apply the distributed load to all of the appropriate
members in Multiframe and then copy and paste the Member Load
table from the Data window in Multiframe into a new array in your
spreadsheet.

You can now put a formula for the load magnitude into the last two
columns of the load array by looking up the required load
magnitude that you have calculated for each member.

Once you have done that, you can copy and paste the load
magnitudes from the load array back into the magnitude columns of
the Member Load table in Multiframe.

This will update the member loads you have applied to their
required values. Keep in mind the direction of these loads, you may
need to use a negative sign in your spreadsheet to ensure that the
magnitudes pasted into Multiframe point in the right direction.
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This may sound like a rather long process but once you have set it up
once you can adapt the spreadsheet for use with other structures.
Also, once you get used to using the VLOOKUP command in your
spreadsheet you will find it useful for many other operations (see
quantities example below).

Example 3 -  Calculating Quantities & Costs
When you generate a structure in Multiframe it displays a table of
the sections you have used in the Sections table in the Data window.

You can copy this table to a spreadsheet for calculations of quantities
and/or costs.  If you copy the whole table you can easily calculate
the total weight of the structure by summing the values in the Total
Weight Column.

If you want to calculate the cost of structural painting you might use
the values in the Length, D, B, tf and tw columns to find the total
surface area and use this as a basis for your costing.

Example 4 -  Finding  Maximum Forces
After you have analysed a structure, Multiframe displays a table of
the member actions in the Result window.  You can copy this table to



Appendix F Using Spreadsheets With Multiframe

a spreadsheet and then sort it to find for example the members with
the greatest axial force.

If you wish you could also add additional calculations based on the
results to compute other design parameters and then sort based on
the calculated values.

Summary
Spreadsheets are an invaluable tool for all design engineers.  Used by
themselves they can provide quick answers to difficult design
problems but used in conjunction with Multiframe they can provide
you with a greatly expanded range of design tools.  Next time you
have a design requirement that Multiframe does not provide,
consider using a spreadsheet to help provide the facilities you need
to solve your design problem.
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Appendix G
Quality Assurance
This appendix describes the quality assurance processes used to
ensure Multiframe gives reliable and accurate results.

Quality Assurance
Many Multiframe users ask us how we know that Multiframe
produces the correct results.  This appendix explains how Formation
Design Systems has verified that Multiframe gives accurate results
and what steps we take to make sure that each version of the
software we ship is as reliable as possible.

Quality Principles
While it is impossible to ensure that any software product is
completely free of bugs, we follow a series of engineering and testing
principles and procedures to ensure that Multiframe will produce
results which are consistent with the level of accuracy and
thoroughness a professional engineer applies to design work.  To this
end we follow a development and testing path which includes use of
structured programming techniques, verification of the underlying
algorithms, testing of the computer implementation of those
algorithms, testing of real world problems in-house and beta testing
in the field at Multiframe user sites.

Structured Programming
The best defense against bugs in software is to use structured
programming techniques, which have been proven to improve
software reliability.  Without going into the technical details of our
software development methodology, we summarize by saying that
we utilize structured code, object oriented design, data hiding and
encapsulation and fault tolerant programming practices to enhance
our software's reliability.  Multiframe is a complex software system
of over 200,000 lines of code and we believe our history of reliability
reflects the effort we have put into using reliable coding practices.

Verification of Algorithms
When new design or analysis algorithms are introduced into
Multiframe, we first carry out testing on the algorithms on proven
test cases with known analytical solutions.  These generally come
from engineering texts such as Refs 1 to 3.  These test cases will
include samples which independently examine the various degrees
of freedom (Mx bending, My bending, Axial tension etc. ) followed
by examples which superimpose the effects of multiple degrees of
freedom.  These simple test cases are performed for structures
aligned with the principal axes as well as those rotated to arbitrary
angles.

Testing of Implementation
Once the basic algorithms have been proven correct, testing is then
carried out on more complex sample problems to which a solution
has already been established using a proven analysis program.
These results may either come from structural engineering texts such
as Refs 1 to 3 as well as from other results carried out by Formation
Design Systems or other engineers using other software products
such as SAP, Nastran etc.
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Testing of Upgrades
As each new version of Multiframe is released we perform a series of
tests to ensure it functions correctly.  Among these tests is an analysis
of a frame which exercises every different feature of Multiframe i.e.
every possible member type, section type and orientation,  load type,
combination etc.  At each release the results from this frame are
compared with the results from the previous release to ensure
conformance with answers which have been established as being
correct.

Beta Testing
Immediately prior to the release of each new version of Multiframe,
we conduct a beta test of the software.  This involves sending the
software to practicing engineers and having them use it on design
work in progress to determine its reliability for actual design use.
These beta testers provide us with feedback on the reliability and
accuracy of the program as well as its useability and suitability for
everyday work.  Once the beta test program is completed and all
testers are happy with the program, we begin shipping the
commercial version.

Version Control
Each new version of Multiframe displays a version number
indicating the version and the date the software was first shipped.  If
the version is a development, alpha test or beta test release, the
version number may also include a letter and number suffix
indicating the type and number of the release.  A development
version is usually only for internal use and is a very early
demonstration of a possible new product or feature.  It is highly
experimental and not reliable. An alpha release is a first public
release of a program for initial testing and comment, it is not reliable.
A beta release is a final test version of the program released for field
testing prior to commercial release. It is mostly reliable but may
contain some bugs.  A commercial release is a completed, debugged
program reliable and ready for professional use.

For example
1.0d1 The first development release of version 1.0
1.5a2 The second alpha test release of version 1.5
1.6b2 The second beta test release of version 1.6
1.64 A commercial release of version 1.64

But we're not Perfect
We make every effort to ensure that our software will meet our users'
needs and perform accurately.  However, as with all complex
software systems, it is possible for errors to occur.  If you suspect a
problem with Multiframe, please contact our technical support staff
by email at support@formsys.com and explain what you believe the
problem to be.  In the unlikely event of a problem being found, we
will correct it immediately, and send you a new corrected version of
the program.

To get accurate results from Multiframe, it is necessary for you to
model the problem correctly and to correctly interpret the results
produced.  This requires structural engineering experience combined
with an understanding of matrix structural analysis.  It is the users'
responsibility to correctly model the structure and assume
responsibility for the results.
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